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Use the following sections to find information on solid modelling: 

 Solids (see page 4) 

 Solid features (see page 106) 

 Solid feature tree (see page 254) 

 Make Watertight Wizard (see page 295) 

 Morphing (see page 311) 
 

Introduction to solids 
The following sections provide general information on using solids in 
PowerSHAPE: 

What is a solid? (see page 4) 

Parasolid in PowerSHAPE 2015 R2 (see page 6) 

Creating a solid (see page 12) 

Converting solids (see page 21) 

Editing a solid (see page 23) 

Editing surfaces of solids (see page 36) 

Creating a solid from surfaces (see page 37) 

Creating a solid from untrimmed surfaces (see page 38) 

Creating a single solid from unconnected triangles (see page 40) 
 

What is a solid? 
A PowerSHAPE solid is a single object that represents the outer 
shape of a physical body. It is made up of a number of surfaces that 
join together and match at their edges within a given tolerance. 

Solid modelling 
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The shaded model below shows a PowerSHAPE solid. 

 
The solid is displayed in the solid feature tree (see page 254). 

This solid is made of many surfaces that join together as shown 
below. 

 
You can operate on a solid in the following ways: 

 As a single entity. For example, if you move a solid, all the 
surfaces which define the solid move. 

 On a solid with another solid. For example, you can intersect a 
solid with another solid. The intersecting solid defines a 
feature in the solid feature tree. 

 

Active and inactive solids 
Many solid operations are performed on the currently active solid. 

 The active solid is usually the main component of your model  

 Only one solid can be active at any time 

 By default, the first solid you create automatically becomes the 
active solid and other solids are created as inactive  
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 If you activate an inactive solid, the currently active solid (if any) 
becomes inactive 

 In a wireframe or shaded wireframe view, the wireframe of 
active and inactive solids are coloured differently. The exact 
colour combinations will depend on the colour scheme you are 
using. If there is currently no active solid in your model, then all 
solids are shown in their true colour. 

For further details, see Activating and deactivating a solid (see page 
269) 

 

Parasolid in PowerSHAPE 2015 R2 
The Parasolid kernel is used to implement solid modelling 
commands. Parasolid is becoming an industry-standard, and is used 
as the backbone of many of the leading solid modellers, including 
SolidWorks (Dassault Systèmes SolidWorks Corp), Solid Edge, and 
NX (Siemens). 

In almost every way, the user interface remains the same. You 
should notice that the commands work faster and more reliably. The 
kernel will also make it easier for Delcam to develop new solid 
modelling commands in the future. 

The Parasolid kernel is only used with the following products: 

Delcam Estimator  
Delcam Crispin SoleEngineer 
Delcam PowerSHAPE  
Delcam PowerSHAPE Pro  
Delcam PowerSHAPE-e  
Delcam Draft  
Delcam Toolmaker  
Delcam Electrodemaker  
Delcam Orthotics  
Delcam Designer  
Delcam Designer-e 
Delcam PowerMILL Modelling 
PartMaker Modeling 

Use the information in the following sections to understand more 
about using Parasolid: 

Parasolid - the benefits (see page 7) 

Parasolid - do I need to model differently? (see page 8) 

Parasolid - overview of model conversion (see page 10) 

Parasolid - overview of fixing models (see page 10) 

Exporting to earlier versions of Parasolid (see page 11) 
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Parasolid - the benefits 
The following are examples of the benefits you get from 
PowerSHAPE using the parasolid kernel: 

 Faster and more robust solid modelling operations. Tests have 
shown that using the parasolid kernel is up to four times faster 
than using the PowerSHAPE kernel. 

 Faster and more robust drawings. 

 Faultless data conversion to and from other parasolid-based 
modellers. Higher quality transfer to and from other solid 
modellers because you can ask for parasolid data from 
customers instead of IGES or STEP. 

 The .psmodel file size is much smaller if the part has been 
created wholly using the parasolid kernel. If there has been any 
conversion from version 8 solids or to/from surfaces, this is not 
the case. 

 Import and export of Parasolid file formats will conserve the 
parasolid data with no loss of quality. At present the 
recommended formats are: 

Parasolid (x_t, x_b, xmt_txt, xmt_bin) 
The following formats that support Parasolid are available with 
Delcam Exchange installed. 

SolidWorks (sldprt) 
UG NX (prt) 

 Crisper, tidier graphics. 

 Automatically calculated snapping points for the following 
geometric points: 

 Corners. 

 Centres of planar faces. 

 Centres of arc edges. 

 Mid-points of straight line edges. 

 Tangent to arc edges. 



 

8 • Solid modelling PowerSHAPE 2015 R2 Reference Help  

The snapping points become visible when you enter creation 
mode. 

 
 

Parasolid - do I need to model differently? 
Generally, you do not need to change the way you model in 
PowerSHAPE, but there are a few exceptions: 

 If you want to boolean an open solid (sheet) to an active solid, 
and re-trim the active solid to the edges of the sheet, 

do one of the following: 

 Extend the sheet through the active solid. 
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 Form a closed solid from the sheet. 

 
 If you want to fill a hole in the active solid, use the Sew operation 

rather than a boolean addition. 

 
 A scale transform causes a complete replay of the history tree. If 

the part has a very complex tree, this may take some time. 

 Parasolid is particular about the wireframe you use for creating 
solids: 

 Ensure that there are no zero-magnitude points and that any 
point that is supposed to be tangent continuous really is 
continuous. If not, surfaces may be divided unnecessarily and 
operations (particularly thickening) may fail. 

 When creating extrusions or cuts/bosses from planar 
wireframe, always check that the wireframe really is planar. 
Parasolid uses a much tighter tolerance than PowerSHAPE 
when testing wireframe for planarity (flatness). If the 
wireframe is not planar, extrusions/cuts/bosses will not be 
capped and may fail. 

 Always try to create wireframe from lines and arcs rather 
linear or arc-like Bezier spans. 
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Parasolid - overview of model conversion 
Separate, detailed information is available on converting models to 
and from an earlier version of PowerSHAPE (see page 21). The 
following is a summary: 

 Existing models that were created using the PowerSHAPE kernel 
continue to work in PowerSHAPE 2015 R2 

 New models use parasolid, unless you change the default by 
selecting the Version 8 solids option on the Tools > Options > 
Object > Solids dialog. 

 Parasolid and version 8 solids co-exist in the same model. 

 It is not possible to perform boolean operations between solids of 
different kernels. You must convert one solid before attempting 
the operation. 

 It is possible to convert solids in existing models to parasolid and 
parasolid to version 8 solids. 

 

Parasolid - overview of fixing models 
There is separate and detailed information on fixing parasolid 
models. The following is a summary: 

 Parasolid has stricter rules on 'valid' geometry. Geometry that is 
valid in version 8 models is not necessarily valid in a parasolid. 

 Solid Hints may help you identify the areas of a model that are 
causing problems. If an operation fails when using a Parasolid 
solid, the Operation Fault Report dialog may be displayed.  

 
The dialog indicates any problem areas when performing the 
operation. Use the options on the dialog to identify the area that 
requires attention.  

 Faults in a parasolid body can be viewed and fixed using the 
Solid Doctor. 
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 Generally, you must fix a fault only if you are going to perform a 
modelling operation through the faulty area; for example, 
performing a boolean subtraction. 

 

Use of colour when importing/exporting Parasolid files 
Colours are a useful way to define machining intent, or pass other 
useful information between systems. Colours are used when 
importing and exporting Parasolid files: 
 The wireframe colour of each face is exported to .dgk and 

Parasolid formats. 

 Colours defined in other systems are retained when Parasolid 
files are imported into PowerSHAPE. 

 

Exporting to earlier versions of Parasolid 
You can export the following file formats to lower versions of 
Parasolid than the one currently used by PowerSHAPE. 

 x_t (parasolid text)  

 x_b (parasolid binary) 

The table below indicates the parasolid export versions that are 
available from PowerSHAPE. 
Parasolid 
version 

Comment 

7.0 The oldest version that can be used for export 
from the current version of Parasolid. 

8.0  First version supported by Solid Works. 

9.0  First version to support more than one solid 
per file. 

9.1  

10.0 Latest version which Pro E Wildfire 4 can 
read/write 

11.0  

11.1  

12.0  

13.0  

14.0  Major change to x_t file format. Use a later 
version than this if possible. 

15.0  
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15.1  

16.0  

16.1  

17.1  

18.1  

19.1  

20.0  

21.0 Used by PowerSHAPE 8.2 

22.0 Current version of parasolid used by 
PowerSHAPE. This is displayed as the Current 
version option in the Options dialog. 

 PowerSHAPE exports to all version of parasolid that are 
supported by Solid Works. 

 

Creating a solid 
You can create solids using one of the following methods: 

 Using the solid creation options (see page 13) 

 Using the solid modelling toolbar (see page 13) 

 Using the feature creation options (see page 16) 

 Using the wizard options (see page 18). 
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Using the solid creation options 
1 From the Object menu, select Solid to display the Solid creation 

options. 

 
2 Select the option you require. 

This is the same as clicking the Solid  button on the main 
PowerSHAPE toolbar and selecting an option from the Solid toolbar 
(see page 13). 

 

Using the solid modelling toolbar 
1 Ensure that you have a model displayed. 
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2 Select the Solid  button on the Main toolbar. The Solid 
Modelling toolbar is displayed. 

 
3 Select an option from the toolbar: 

 Creating a solid from surface and meshes (see page 37) 

 Creating a solid by automatically trimming surfaces (see 
page 38) 

 Create solid block (primitive) (see page 42) 

 Create solid cylinder (primitive) (see page 42) 

 Create solid cone (primitive) (see page 42) 

 Create solid sphere (primitive) (see page 42) 

 Create solid torus (primitive) (see page 42) 

 Create a solid spring (primitive) (see page 42) 

 Create solid extrusion (see page 56) 

 Extrude regions (see page 68) 

 Create a solid of revolution (see page 73) 

 Create solid from drive curve and sections (see page 79) 
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 Create solid core (see page 86) 

 Create a solid core from selection (see page 87) 

When you start PowerSHAPE, selecting the Solid  button 
automatically starts primitive block creation. 

 



 

16 • Solid modelling PowerSHAPE 2015 R2 Reference Help  

Using the feature creation options 
1 From the Object menu, select Feature to display the Solid Feature 

options. 

 
2 Select the option you require. 

This is the same as clicking the Feature  button on the main 
PowerSHAPE toolbar and selecting an option from the Solid 
Feature toolbar. Transform options (see page 243) do not appear 
on the Solid Feature toolbar. 
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Using Features in solid modelling 
1 Ensure that you have a model displayed. 

2 Click Feature  (Main toolbar). The Solid Feature toolbar will be 
displayed. 

 
3 Click one of the following buttons to create the required feature: 

 Solid from addition (see page 108) 

 Solid from subtraction (see page 110) 

 Solid from intersection (see page 112) 

 Solid split (see page 117) 

 Solid cut (see page 122) 
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 Radial cut (see page 134) 

 Solid boss (see page 138) 

 Solid boolean boss (see page 148) 

 Solid hole (see page 151) 

 Pocket or protrusion (see page 227) 

 Hollow solid (see page 167) 

 Thicken solid (see page 174) 

 Bulge (see page 176) 

 Morph feature (see page 311) 

 Rib fillet (see page 225) 

 Solid fillet (see page 180) 

 Solid chamfer (see page 206) 

 User defined feature (see page 239) 

 Solid wrap feature (see page 242) 

 When you start PowerSHAPE, clicking Solid Feature  will 
automatically start the hole creation option if there is an 
active solid present. If there is not an active solid, the Solid 
toolbar is displayed, but does not start the hole creation 
option. 

 

Using the wizard options 
1 From the Object menu, select Wizards to display the available 

wizards options. 
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2 Select the option you require. 

This is the same as clicking the Wizard  button on the main 
PowerSHAPE toolbar and selecting an option from the Wizards 
toolbar. 
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 Create an electrode using Delcam Electrode. 

 Start the Mold Die Wizard using  Delcam Toolmaker. 

 Surface Core/Cavity Separation. Use this option to find either the 
visible or hidden surfaces of a model. 

When importing a model (e.g. via IGES), from which a mold tool 
will be designed, it is necessary to split the surfaces into those 
which form the outer face of the component (the cavity side of 
the mold) and those which form the inner face of the component 
(the core side of the mold). Some models (especially IGES) can 
contain thousands of surfaces, some of which will be in close 
proximity, but each describing different parts of the mold. 

Separating them manually would be a difficult and tedious task, 
but this option calculates the split quickly and easily. 

The split is shown either by selecting all the visible surfaces or all 
those which are not visible. The view point is down the Z-axis of 
the active workplane (or if there is not an active workplane, the 
Z-axis of the global workspace). Use the options as follows: 

1 Open the model. 

2 Add a workplane if the split is not going to be down the Z-axis 
of the global workspace and position it accordingly. 

3 Click Wizards  to display the wizards toolbar. 

4 Click Core/Cavity  flyout (Wizards toolbar) 

5 Click the appropriate option on the flyout. 

 - Visible Surfaces. This finds and selects all the visible 
surfaces of a model. 

 - Hidden Surfaces. This finds and selects all the hidden 
surfaces of a model. 

You can now move the selected surfaces to a new level. Any 
surfaces that are entirely parallel to the point of view will not 
be selected. 

 Use the Solid Core/Cavity Separation (see page 302) wizard to 
split a solid into core, cavity, sliders and internal features (such as 
holes) 

 Additional Toolmaker options are available from the Wizards 
toolbar when Toolmaker is selected from the Module menu. 
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Converting solids 
If a model contains post-version 8 solids (Parasolids), the solids 
need to be converted manually before exporting back to an earlier 
version that doesn't support Parasolids.  

Use the following tools to convert solids to and from version 8 solids 

 Use Tools > Convert all solids to convert all solids in a model (see 
page 21). 

 Use the Convert button  on the Solid Edit toolbar to convert a 
single solid (see page 23). 

 Use Edit > Convert > Solids to version 8 solids and Edit > Convert > 
Solids from version 8 solids to convert multiple solids. 

 

Convert all solids 
1 Click the model that contains the solids. 

2 Select Tools > Convert all solids to display the Convert Solids 
dialog. 

 
3 Select the conversion option you require. 

 To check the type of solid in your model, right click on a 
solid. If a solid is version 8, Version 8 is displayed in the 
title of the solid context menu. 

4 Click Convert. 
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5 Click Yes to confirm that you want to convert all the solids in a 
model. A summary of the results of the conversion is displayed in 
the dialog. 

 
6 Click  to display the Convert Solids Report.  

 
For each solid, the report displays: 

 model name. 

 whether the solid is a version 8 solids or a post version 8 
solid. 

 level the solid is on. 

 component the solid belongs to. 

This option helps identify version 8 solids in old library models. 
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7 Click Report to display the Convert Solids Report detailing any 
issues with the conversion. 

8 Right click on the converted solid to display the solid context 
menu.  

This will say:  

Solid for post-version 8 solids. 

 
Version 8 Solid if the solid is version 8. 

 
 

Convert selected solids 
1 Click the solid to be converted to display the Solid Edit toolbar. 

2 Click . 

3 Right-click on the converted solid to display the solid context 
menu.  

This will say:  

Solid for post-version 8 solids. 

 
Version 8 Solid if the solid is version 8. 

 
 

Editing a solid 
Use one of the following techniques to edit a solid: 

 From the main menu: 

1 Select the solid. 

2 Select one of the following: 

Edit > Convert > Solids to surfaces converts a solid into surfaces 
that define it. You can then edit the surfaces. 

Edit > Modify displays the solid feature tree. 

 Click  (Solid Edit toolbar) to display the solid feature tree. 
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 Use the options on the Solid Edit toolbar (see page 24). The Solid 
Edit toolbar is displayed automatically when you  

 start to edit a solid. 

 select one or more solids.  

 selecting View > Toolbars > Solid Edit.  
 If required, create a workplane at the centre of a face of a solid 

(see page 27). 

 Right-click the solid to display the edit options available for 
solids. The name of the solid and the level on which it lies is at 
the top of the context menu. 

 

 When you reverse a solid, it loses its feature tree. 
 

Using the Solid Edit toolbar 
To edit a solid using the Solid Edit toolbar: 

1 Select a solid to edit. The Solid Edit toolbar is displayed: 

 
2 Click one of the following buttons to edit the solid: 
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 Show/Hide Tree — Click this button to control the display of 
the solid tree. The solid tree window is hidden by default. 
Clicking this button is the same as View > Windows > Tree. 

   Activate/Deactivate — Toggle the button to activate or 
deactivate the solid. 

 Fix — Click this button to find and fix faults. One of the 
following is displayed: 

 Solid Doctor if the solid is a Parasolid (post-version 8 solids). 

 Make Watertight if the solid is a PowerSHAPE solid (version 8 
solids). 

 Heal/Loosen Edges — Click this button to heal or loosen 
edges in the solid using the Solid Doctor Healing dialog (see page 
293). 

 Select Features — Select this button and click on the solid to 
select the feature (see page 34). 

 Select Faces — Select this button and select an individual 
face of a solid (see page 34). Use this option with box selection 
to select faces that are completely inside the selection box. 

 Select Continuous Faces — Select this button to highlighted 
faces that are continuous with the selected face. 

 Select Convex Faces — Select this button and click on a face 
in the solid to select all the faces in the convex region of the 
face. 

 Select Concave Faces — Select this button and click on a face 
in the solid to select all the faces in the concave region of the 
face. 

 Continuous Lasso — Select this button to select faces of the 
solid by drawing a lasso around the required faces. After making 
the selection, move the mouse over the selected faces to 
highlight the single faces.  
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 Discrete Lasso — Select this button to select faces of the 
solid by drawing a lasso around the required faces. The cursor 

changes to  to show that you can complete the lasso. After 
making the selection, move the mouse over the selected faces to 
highlight the single faces.  

 Copy — Click this button and select one or more faces to 
create surface copies.  

 Cut — Click this button and select one or more faces to 
create surface copies and remove them from the solid. 

 Sew — (Available only for post-version 8 solids). 

a Click this button to display the Sew dialog. 

 
b Select one or more surfaces or solids and click OK.  

 Remove and Heal — Click this button to remove the selected 
faces and close the gap by modifying the surrounding faces. This 
option is part of Direct Modelling functionality. 

 Merge — Click this button to merge selected faces of a solid 
into one face (see page 27). 

 Divide Faces — Click this button to divide the faces of the 
selected solid using wireframe (see page 28).  

 Draft — Click this button, to display the Draft Faces dialog. 
This option is part of Direct Modelling functionality. 

 Replace — Click this button to use Solid Replace Faces to 
select faces of a solid and replace them with other existing faces 
or surfaces. 

 Divide Solid — Click this button to divide an existing solid 
into separate solids (see page 31). 
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 Convert — Click this button to convert to/from version 8 
solid (see page 21). 

 Solid to Surface — Click this button to convert one or more 
solids to surfaces.  

 Solid to Mesh — Click this button to convert one or more 
solids to meshes.  

 Use normal selection methods:  to add/remove a face 

from the selection;  to add a face to the selection. 
 

Creating a workplane at the centre of a face of a solid 
You can create a workplane at the centre of a face of a selected 
solid.  

Click Create a single workplane aligned to geometry (Workplane 
toolbar) to create a workplane in the centre of the selected face. 

 
 

Merge selected faces 
Use the Merge selected faces functionality to join multiple continuous 
solid faces together, into a single face. 
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1 Select a solid. 

 

2 Select Select individual faces  from the Solid Edit toolbar. 

3 Use  to select two or more continuous faces. 

 

4 Click  on the Solid Edit toolbar to merge the faces together. 

 
 

Divide face 

Use Divide face  (Solid Edit toolbar) to divide the faces of the 
selected solid using wireframe. This option is useful if you need to 
make small, localised changes, or to limit the effect of Direct 
Modelling editing operations.  
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1 Create the wireframe that will be used to divide the face. 

 

2 Click  (Solid Edit toolbar) to display the Divide Faces dialog. 

 
3 Select the face to divide. 
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4 Select the wireframe. 

 
5 Select an appropriate projection option. Project wireframe along 

face normal is the default setting. 

6 Click Apply. If you want to split another face, you can do this 
without closing the dialog. 

7 Click Dismiss.  

8 Move the cursor over the face to show the divided face or click 
one of the faces. 

 
If you have an example where the wireframe does not completely 
divide the face, the Operation Fault report will be displayed. Add 
additional wireframe and repeat the divide face operation using both 
the original and additional wireframe. 
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Divide solid 

Use the Divide solid  button (Solid editing toolbar) to divide an 
existing solid into separate solids.  

 
This is useful for dividing: 

 a disjoint solid into two solids. (see page 31) 

 a solid into inner and outer solids (see page 32). 
 

Example — Dividing a disjoint solid into two solids 
1 Select the disjoint solid 
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2 Click  (Solid edit toolbar). The disjoint solid is divided into 
two separate solids. 

 

 
 

 

Example — Dividing a solid into inner and outer solids 
You can use Divide solid to divide a solid into an inner solid and an 
outer solid. 
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1 Select the two faces that join the inner and the outer portions of 
the solid. 

 

2 Click  (Solid edit toolbar) to extract the faces. 

 
3 Blank the faces you have extracted.  

4 Click  (Solid edit toolbar) to divide the solid. 

 
5 Use Blank Except to display the solids separately: 
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 Outer solid. 

 
 Inner solid. 

 
 

Selecting solid features and faces 
Selection modes on the Solid Edit toolbar highlight the areas under 
the cursor. 

 Selecting solid features and faces of a solid are mutually 
exclusive. 

1 Click one of the following buttons on the Solid Edit toolbar: 

 faces only. 

 features only. 

 continuous regions. 

 convex regions. 

 concave regions. 
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2 Move the cursor over a model to see the faces that will be 
selected. 

 

Feature selection 
 When a solid is selected, the Feature selection mode is 

automatically used.  

 If the solid has no history tree, single-face selection mode is 

used and  is unavailable.  

 Selecting features from the tree browser switches the mode to 
Feature selection mode.  

 Use the mouse to make/amend selection as follows: 

 replaces the current selection. 

 toggles the item into/out of selection. 

 adds the item to the selection.  

 displays a feature edit dialog.  

 As well as using the Solid Edit toolbar buttons to switch 
between feature and face selection modes, there is a click-
again option. Click-again is a slow double-click. It is set to 
four times the MS Windows time for a double-click. So if the 
MS Windows double-click speed is 0.5 seconds, a click-again 
is 2 seconds).  
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Editing surfaces of solids 
You can edit, remove and copy a face of a solid without converting 
it to surfaces. 

1 Select the solid. 

2 Click twice, slowly, to select the face of the solid you wish to 
edit. The selected face will be highlighted.  

If the selected face is part of a feature with a single visible face, 
it will be highlighted in a different colour. The colours that are 
used will depend on the colour scheme you are using. 

 
3 Right-click the highlighted surface and select the required 

operation from the Solid context menu. 
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You can use the options to change the appearance of the faces of 
the solid. (see page 37) 

 

Changing the appearance of the faces of a solid 
To change the appearance of the faces of a solid: 

1 Right-click on a selected solid. 

2 Select the required option from the Solid context menu. 

 
Style from Surfaces - If deselected, the style and material of faces 
in a solid comes from the solid. If selected, the style and material 
of the faces in the solid is stored with each face of the solid. 

Make colours from features - Sets the material of each feature to a 
particular material colour. The colour depends on the type of 
feature. If Style from Surfaces is deselected, selecting Make 
colours from features will also select Style from Surfaces. 

 

Copy All Surfaces 
You can create copies of all the surfaces within a selected solid. The 
solid and the history tree are unchanged. 

1 Select the solid  

2 Select Edit > Convert > Copy surfaces within solids. 
 

Creating a solid from surfaces 
You can create a solid from a single surface or a group of surfaces. 

1 Select the surfaces you want to change into solids. 
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2 Click  (Solid toolbar). The surfaces are created into solids and 
the solids appear in the solid feature tree.  

 Any surface with width less than the creation tolerance is 
excluded from the solid. 

 If trim boundaries exist on a surface, then they define trim 
boundaries on the solid too. 

 If there is no active solid in your model and only one solid is 
created from the selected surfaces, the new solid becomes 
active. 

 If your new solid has either small holes or contains more than 
20 surfaces, you are asked if you want to repair the solid. If 
you click Yes, the Solid Doctor dialog (Parasolids) or Make 
Watertight Wizard (see page 296) dialog (Version 8 solids) is 
displayed to help you repair the solid.  

 

Creating a solid from untrimmed surfaces 
Use the automatic trimming functionality to generate a solid from a 
group of intersecting untrimmed surfaces. 

 This functionality is available only with PowerSHAPE Pro and 
Toolmaker. 

1 Click Quick select all surfaces . 

 

 

2 Click Solid . 
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3 Click Automatically trim surfaces and create a solid  from the 
flyout to display the Automatic Trimming dialog. 

 
4 Use the slider on the Automatic Trimming dialog to control how 

many surfaces are used for trimming and generating a solid. 

 

 PowerSHAPE estimates the  proportion of surfaces to keep 
and delete. This is indicated by the initial position of the 
slider when the dialog is displayed. 

 Additionally, you can manually select surfaces to display the 
Face dialog. Use the following options to include or exclude 
surfaces from trimming: 

Keep — select this to include the surface when trimming. The 
surface is highlighted in green to indicate this option has been 
selected. 

Automatic — select this to let PowerSHAPE calculate the option 
to keep or delete the surface with respect to your slider 
setting. 

Delete — select this to exclude the surface when trimming. 
The surface is hidden unless Show manually deleted surfaces is 
selected. 
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5 Click OK to close the dialog and generate the solid. 

 

 The surfaces used to create the solid are moved to a new 
level when the trimming has finished. Additionally, the 
created solid is made active if no other active solids exist in 
the model at the time of creation. 

 

Creating a single solid from unconnected triangles 
Unconnected triangles can be converted to a single solid. Using the 
example symbols below: 

 
1 Select Tools > Options > Object > Solids to display the solid 

modelling options. 



 

PowerSHAPE 2015 R2 Reference Help Solid modelling • 41  

2 Select Convert unconnected triangles to single solid. 

 
3 Select the symbols. 

 

4 Click  (Solid toolbar). 

The two symbols are converted to a single solid. 

 
 

Primitive solids 
The following sections contain information on modelling with 
primitive solids: 

Creating a primitive solid (see page 42) 

Editing a primitive solid (see page 43) 
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Creating a primitive solid 
You can create solid primitives similar to the surface primitives. 

 
1 Click the required primitive type (Solid toolbar). 

 
block 

 
sphere 

 
cylinder 

 
cone 

 
torus 

 
spring 

2 Enter a position on the screen to create a default primitive solid 
of the required type. The solid appears in the solid feature tree 
as a solid and the instrumentation is visible. 

If there is no active solid in your model, this solid becomes 
active. Otherwise it becomes an inactive solid. 

You can create more solids of the same type by entering more 
positions. 

If, at this stage, you wish to create a different primitive solid, 
select it from the Solid toolbar and the cursor will change to 
indicate the type of solid that will be created. To exit primitive 

creation, click Select  . 

3 If required, edit the solid you have created by using the graphical 
handles that are displayed or by using the appropriate primitive 
dialog that is displayed by selecting Modify from the context 
menu or double-clicking the primitive solid. 
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Creating a solid primitive using the command window 
You can specify the dimensions of a primitive before you input the 
origin point. 

To create a block with origin at 0 0 0, type the following in the 
command window: 

create solid block  
length 45  
width 67.89  
height 43  
0 0 0 

If you don't specify a particular dimension, the default value is 
used. 

You can specify the following dimensions using the command 
window: 

radius 
width 

length 

height 
minor_radius 
major_radius 
base_radius 
top_radius 

 

Editing a primitive solid 
Use one of the following techniques to edit a primitive solid: 

 Use the graphical handles to change the dimensions and 
orientation of the primitive. 

 Use one of the options from the Edit menu.  

Edit > Modify displays the dialog for the solid. 

Edit > Convert > Solids to surfaces converts the solid into surfaces 
for editing. 

 Double-click the primitive solid to display the dialog for the solid. 

 You can simultaneously edit multiple primitive solids (see page 
54). 

 Select one or more faces on a selected primitive solid by clicking 
one of the face selection buttons (Solid Edit toolbar) and 
selecting the required faces. 
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 Double-click the icon of the primitive solid in the tree to display 
its dialog and graphical handles. Double-clicking a block, sphere, 
cylinder, cone and torus displays a solid dialog (see page 45) 
that has two tabs. Double-clicking a spring will display the Spring 
dialog (see page 49) that has three tabs. 

The icon is different if it has features. 

 = primitive without features. This is the icon of the solid 
(block, sphere, cylinder, cone, torus or spring) 

 = primitive with features. This is the icon of the whole solid. 

If the solid has features, the primitive icon appears at the bottom 
of the tree for the solid and will be one of the following icons. 

 = block 

 = sphere 

 = cylinder 

 = cone 

 = torus 

 = spring 

 Right-click the primitive solid to display the edit options available 
for primitive solids. The top of the context menu shows the type 
of the solid, its name and the level on which it lies. 
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Graphically editing primitive solids 
Select the primitive solid to display its graphical handles. 

 
The workplane type handles are used to: 

 move the primitive. 

 change its direction. 

 twist it about its axis. 

The blue handles are used to edit the dimensions of the primitive 
solid. 

The unique graphical handles for each primitive solid are exactly the 
same as for primitive surfaces. The drag handles of primitive solids 
snap to other geometry in the model. 

 

Primitive solid dialog 
The title on the dialog reflects the primitive that you are editing. 

To edit the primitive solid: 
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1 Double-click on the primitive you want to edit. 

 
2 Use the two pages of the dialog to define the changes you want 

to make. 

 Dimensions (see page 46) 

 Workspace (see page 48) 
 

Primitive Solid dialog - Dimensions 
Use the Dimensions page of the dialog to edit a primitive. 

 
Name - This is the name of the selected primitive. You can edit the 
name. 

Specify the following dimensions for the selected primitive: 

 Block - Specify the Length (X), Width (Y), Height (Z). You can also 
apply draft angles to four sides of a block. 
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 Cylinder - Radius or Diameter is selected from the drop-down list. 
You can also specify the Length. 

 Cone - Specified as follows: 

a Enter the Length of the cone. 

b Select one of the options from the drop-down list.  

 
c Your selection determines the other options that are available 

on the dialog. It also affects the dimensions of the cone that 
can be changed using graphical editing.  

d Enter the other parameters. 

e Click OK. 

 Sphere - Radius or Diameter is selected from the drop-down list.  

 Torus - Specify the Major Radius, Minor Radius. 

 Spring - Specify the Height, Pitch, Turns, Top Radius and Base 
Radius 

Draft - Enter draft angles for the following sides, when looking down 
the Z axis: 

 
 - Top 

 - Right 

 - Bottom 

 - Left 

You can also define the draft angles by using the drag handles that 
are displayed in the centre of each top edge of the block. 

OK - Saves the edits carried out on the primitive and removes the 
dialog from the screen. 

Cancel - Removes the dialog from the screen and discards any edits 
carried out on the primitive whilst it was displayed. 
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Primitive Solid dialog - Workspace 
Use the Workspace page of the dialog to specify the primitive. 

 
You can: 

 Define the Workspace in which to edit the primitive. 

 Create a copy of the workplane by clicking  on the dialog. 

 Define a new origin of the primitive by entering new X, Y, Z 

coordinates or click  to display the Position dialog. 

 Change the direction of its Axis. 
 Twist it about its axis. 

Position - Select an option to position the origin of the block. The 
default option is centre of the base of the block. Other available 
options are shown below. All positions are relative to the default. 

 
 Top left corner 

 Middle of top edge 

 Top right corner 

 Middle of right edge 
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 Bottom right corner 

 Middle of bottom edge 

 Bottom left corner 

 Middle of left edge 
 

Spring dialog 
Use this dialog to specify or edit the dimensions for a solid spring or 
a surface spring primitive. 

1 Double-click on an existing spring to display this dialog: 

 
2 Click on the tabs to define the spring: 

 Dimensions (see page 50) 

 Workspace (see page 51) 

 Section (see page 51) 
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Spring dialog - Dimensions 
Use this page of the dialog to specify the dimensions of the spring. 

 
Name - Enter a name for the spring. 

Height - Enter the overall vertical height of the spring. The height 
can also be changed by dynamically dragging the arrow handle at 
the top of the spring. 

 The Height, Pitch and number of Turns are inter-related. If 
one value is changed another value must also change in order 
to keep the definition of the spring consistent. 

Pitch - Enter the vertical distance between consecutive turns. 

Turns - Enter the number of turns in the spring. 

  - Lock or unlock the Height, Pitch and number of Turns for the 
helix. When a dimension is locked it will not change when another 
dimension is changed. For example, if the height is locked and the 
user changes the pitch, the number of turns will change to keep the 
definition consistent. 

Top Radius - Enter the radius for the top of the spring. The top 
radius can also be changed by dynamically dragging the arrow 
handle at the top of the spring. 

Base Radius - Enter radius for the bottom of the spring. The base 
radius can also be changed by dynamically dragging the arrow 
handle at the bottom of the spring. 

Constant Radii - Select this option to keep the base and top radii 
equal. The default setting is ON. 

Flip Direction - Select this option to flip the direction of the spring 
between clockwise and anti-clockwise. 
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Spring dialog - Workspace 
Use this page of the dialog to specify the Workspace details of the 
spring. 

 
Workspace options - These options allow you to: 

 define the workspace in which to edit the primitive. 

 change the primitive's workspace. 

 move the primitive’s origin. 

 change the direction of its axis. 

 twist it about its axis. 
 

Spring dialog - Section 
Use this dialog to specify the Section details for a solid spring or a 
surface spring primitive. 

 
Type - Select one of the options:  
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 Circle - Select this option to create a circle type spring: 

 
 Polygon - Select this option to create a polygon type spring: 

 

 Additional options for polygon type springs are displayed. For 
further details see Polygon Options (see page 53). 

Top scale factor - Enter a factor by which the scale of the section 
radius increases along the height. The example below shows a 
polygon type solid spring with a section radius of 35 and a scale 
factor of 5. 

 
Radius - Enter the radius for the section. 
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Spring dialog - Section - Polygon options 
When you select a Polygon type spring on the Section page of the 
Spring dialog, additional options are displayed. 

 
Number of sides - Specify the number of sides for the polygon type 
spring. 

Rotation angle - Specify the rotation angle for the section. The 
example below shows two, four-sided polygon solid springs. The 
spring on the left was created with a rotation angle of 0. The spring 
on the right was created with a rotation angle of 30. 

 
Fillet radius - Enter a radius to create fillet arcs between each 
straight edge of the polygon type spring. If set to zero, no arcs will 
be created. 
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The example below shows two, four-sided polygon type solid 
springs. The spring on the left was created with a Fillet radius of 0. 
The spring on the right was created with a Fillet radius of 3 and is 
highlighted to show the fillets. 

 
 

Editing multiple primitive solids 
You can edit multiple primitive solids of the same type at the same 
time. 

This function is available for solid: 

 blocks 

 cylinders 

 cones 

 spheres 

 tori 

 springs 

To edit multiple primitive solids 

 This example shows how to edit multiple solid blocks, 
however the same concepts apply for all solid primitives. 

1 Select a number of primitive solids that you want to edit (for 
example blocks) with one of the following methods: 

 Press and hold the Shift key and click the blocks. 

 Press and hold the Ctrl key and click the blocks. 

 Click and drag the cursor over the blocks. 
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2 Right-click one of the selected primitives, and select Modify. 

 
The dialog to edit the appropriate selected primitives is displayed 
(for example, the Block dialog). The dialog is similar to that of 
editing a single primitive of the same type, with the following 
differences: 

 — The properties that differ between the selected primitives 
are highlighted in pink. 

 
 — The range of values is displayed when you hover the cursor 

over a property. 
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 You can also double-click one of the selected primitives to 
display the dialog. 

3 Edit the properties. 

4 Click OK to apply the changes to the selected primitives and 
close the dialog. 

 
 

Other solids 
The following sections contain information on other PowerSHAPE 
solids: 

Creating an extruded solid (see page 56) 

Editing an extruded solid (see page 59) 

Creating a solid of revolution (see page 73) 

Editing a solid of revolution (see page 74) 

Creating a solid drive-curve from wireframe (see page 79) 

Creating a solid core (see page 86) 
 

Creating an extruded solid 
Solids can be created by extruding single or multiple wireframe 
objects. 

If you intend to cut extruded solids into another solid, we 
recommend you use the Cut command instead of extruded solid. 

Similarly, if you intend to create a boss by adding an extruded solid 
to an existing solid, we recommend you use the Boss command. 

1 Select the wireframe object you want to extrude. 

The example below shows a composite curve: 

 

2 Click  (Solid toolbar). 
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If a single wireframe objected is selected, it is extruded to form a 
solid. 

In our example, the solid shown below is created. 

 
A solid is created by extruding the wireframe object. This is 
similar to creating an extruded surface except caps are added to 
the solid if the wireframe object is planar and closed. 

The solid is displayed in the solid feature tree. 

If there is no active solid in your model, this solid becomes 
active. Otherwise it becomes an inactive solid. 

3 If multiple wireframe objects are selected, the Extrusion 
Dimension dialog (see page 58) is displayed where you set the 
dimensions of the extruded solids. 

Enter the length and draft angle values for the extruded solids. 

4 Click Preview to see the extruded solids. 
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You can change the length and draft angle values and click 
Preview again to update the solids. 

 
5 Click OK to accept the preview and close the dialog. 

 

Extrusion Dimensions dialog 
Use this dialog to set the dimensions of extruded solids from 
multiple wireframe objects. 

 
Direction1 - Length - This is the length of the extrusion. The Length 
of the extrusion can be zero if the Direction 2 Length has a value 
other than zero. 

Draft Angle - This is the draft angle between the base curve of the 
extruded solids and the curve at the other end. The angle is 
measured from the axis normal to the principal plane or the plane of 
best fit of the curve. 

Direction 2 - Length - The length of the extrusion below the active 
plane. 
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OK - Click to accept the preview and close the dialog. 
 

Editing an extruded solid 
Edit a selected extruded solid in the following ways: 

 Use its graphical handles to change the orientation of the 
extruded solid. 

 Use the options on the Solid Edit toolbar (see page 24). 

 Use one of the options on the Edit menu.  

Edit > Modify displays the Extrusion dialog. 
Edit > Convert > Solids to surfaces converts the solid into surfaces. 
You can then edit the surfaces. 

 Double-click the extruded solid to display the Extrusion dialog. 

 Double-click the icon of the extruded solid  in the tree to 
display its dialog and graphical handles. 

The icon is different if it has features. 

 = solid with features. This is the icon of the solid. 

 = solid without features. This icon appears as a feature at the 
bottom of the tree for the solid. 
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 Right-click on the extruded solid to display edit options available 
for extruded solids. At the top of the context menu, you can see 
the type of the solid, its name and the level on which it lies. 

 
 

Graphically editing an extruded solid 
1 Select the extruded solid to display its graphical handles. 

 
Use these workplane type handles to: 

 move the extrusion. 

 change its direction. 

 twist it about its axis. 
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Two other handles are displayed for editing the height of the 
extruded solid. These are the Length  and Negative Length  
parameters. Negative length is set to zero by default, so is not 
visible in the following models. 

 
2 To edit the height, select the handle and drag upwards or 

downwards until you reach the required height. 

As you drag the handle, the new dimension is displayed on the 
screen. 

Dragging the handle upwards increases the height of the 
extruded solid. How the dimension value increases and decreases 
depends upon the zoom factor. Zoom in to work with small 
increments and zoom out to work with large increments. 
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You can also drag the handle in the negative Z direction. 

 
 

Extrusion dialog 
Use the three tabs to edit the extrusion. 

Extrusion dialog - Dimensions (see page 62) 

Extrusion dialog - Workspace (see page 65) 

Extrusion dialog - Sketch (see page 66) 
 

Extrusion dialog - Dimensions 
Use this dialog to edit the dimensions of an extruded solid. 

 



 

PowerSHAPE 2015 R2 Reference Help Solid modelling • 63  

1 Enter a Name for the extrusion (if required). Alternatively, use 
the default Name allocated by PowerSHAPE. 

2 Enter the Length (Direction 1)of the extrusion. The length of the 
extrusion can be zero if the length specified in Direction 2 is non-
zero. 

3 Enter the Draft Angle (Direction 1). This is the draft angle 
between the base curve of the extruded surface and the curve at 
the other end. The angle is measured from the axis normal to 
the principal plane. 

 
4 Enter the Length of the extrusion (Direction 2).  

5 Enter the Draft Angle (Direction 2).  

The model below uses the following dimensions: 

 Direction 1: Length = 47, Draft Angle = 0. 

 Direction 2: Length = 20, Draft Angle = 15 
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After you have entered a value, the model updates dynamically 
to reflect the change. 

 
6 If required, click  to check that the draft angle is constant. 

7 Select Equal lengths to set the same Length for Direction 1 and 
Direction 2. 

8 Click  to Reverse direction. This reverses the solid so that the 
outside of the solid becomes the inside, and the inside becomes 
the outside. 

9 Select one of the following: 

 OK to save the edits carried out on the extruded surface and 
removes the dialog from the screen. 

 Cancel to remove the dialog from the screen and discards any 
edits carried out on the extruded surface whilst it was 
displayed. 
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Extrusion dialog - Workspace 
Use this dialog to edit the workspace of an extrusion. 

 
Workspace options - Use these options to: 

 define the workspace in which to edit the extrusion. 

 change the extrusion's workspace. 

 move the extrusion's origin. 

 change the direction of the extrusion's axis. 

 twist the extrusion about its axis. 

 create a copy of the workplane by clicking  on the dialog. 

Enter the X Y Z coordinates or click the Position  button to open 
the Position dialog where you can use position entry tools. 

Skew - If selected, any changes to the workplane will change the 
direction of the extrusion without affecting the base curve. If 
deselected, then changes to the workplane will change the 
orientation and position of the whole extrusion. 

 - This makes the Z axis of the workplane perpendicular to the 
plane in which the base curve lies. If the base curve is non-planar 
then the plane of best fit is calculated. 
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Extrusion dialog - Sketch 
Use this page of the dialog to edit the wireframe for the extrusion. 

 

Create a copy of the sketch 
Click this button to add a copy of the composite curve to the model. 
The Information dialog is displayed to confirm the copy. 

 

Replace sketch 
Click this button to replace the sketch curve (see page 67). Use the 
dialog to select the curve to replace. 

 

Edit sketch 
Click this button to edit the wireframe. The example below is used 
to show you how to edit the wireframe. 

1 Click Edit sketch. The following is displayed: 

 wireframe. 

 Curve Edit toolbar.  
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  is displayed on the dialog. 

 
2 Delete two of the points, by using the graphical handles or the 

options on the Curve edit toolbar. 

 

3 Once you have finished editing the wireframe, click  to accept 
the edit or  to cancel the edit. 

 
 

Replace Sketch dialog 
Use this dialog to replace wireframe in an extruded solid.   

 



 

68 • Solid modelling PowerSHAPE 2015 R2 Reference Help  

Replacement selected - Select the replacement wireframe. The  will 
be replaced with a . 

Move primitive's workplane - Select this to move the primitive's 
workplane to the centre of the replacement wireframe. 

OK - The original composite curve is replaced with the selected 
wireframe. 

Cancel - The Replace Sketch dialog is closed without replacing the 
curve. 

 

Extrude regions 
Use the new Extrude Regions button to extrude multiple nested 
regions in a single operation using the Extrude Regions dialog. 

1 Click  (Solid creation toolbar). 
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The Extrude Regions dialog is displayed. 

 
2 Select the type of extrusion from the Type drop-down list.  

 
Default creates extrusions from the wireframe items (see page 
71). 

Tiered uses the height of the wireframe items to define the height 
of the extrusions. A modified dialog box is displayed. 

 
The Innermost tier can be: 

 positive, to define a boss-like tier. 

 negative, to define a cut-like tier. 

 zero, if you want a neutral tier. 
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3 Enter the Length (Direction 1)of the extrusion. The length of the 
extrusion can be zero if the length specified in Direction 2 is non-
zero. 

4 Enter the Draft Angle (Direction 1). This is the draft angle 
between the base curve of the extruded surface and the curve at 
the other end. The angle is measured from the axis normal to 
the principal plane. 

 
5 Enter the Length of the extrusion (Direction 2).  

6 Enter the Draft Angle (Direction 2).  

7 Click  or  to specify if the draft angle is to go in or out. If 
selected, in/out draft is added to each region alternately.  

8 Select Equal lengths to set the same Length for Direction 1 and 
Direction 2. If this option is selcted, updating either length will 
also cause the other length to update. 

9 Define the extrusion plane: 

 If  Same base plane is selected, the inner and outer wireframe 
are extruded from the same plane. This option is selected by 
default. 

 If Same top plane is selected, each region of the solid is 
extruded up to the height of the outer wireframe. 

10 Click Apply to extrude the regions 
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Example — Extruding regions 
Extruding regions is useful when you need to extrude a hollowed 
out shape. 

 
1 Select the wireframe. 

 

2 Click  (Solid creation toolbar) to display the Extude Regions 
dialog and a preview of the extrusion. 

 
3 Edit the extruded regions by: 



 

72 • Solid modelling PowerSHAPE 2015 R2 Reference Help  

 using the handles on the model to adjust the extrusion. Any 
changes you make will update the values in the Extrude 
Regions dialog. 

 
 entering a new value in the Extrude Regions dialog and clicking 

Apply. 
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How do I create a solid of revolution ? 
A solid of revolution is created from a wireframe object which is 
rotated around one of the axes of the current workspace. Create a 
workplane to ensure that the solid of revolution is created around 
the correct axis. 

The solid of revolution can be either open or closed: 

 In an open solid of revolution, the wireframe object is rotated 
around the axis by an angle of 270  . 

 In a closed solid of revolution, the wireframe object is rotated 
around the axis by an angle of 360  . 

 
Once the solid is created, you can edit the angle of the open solid of 
revolution. 

1 Select a wireframe object, for example : 
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2 Select the Principal plane button (Status bar) of the axis you 
want to rotate around. In this case, select the Principal plane 
button with Y on it.  to rotate our curve around the Y axis, 

3 Click  (Solid toolbar) to display the solid. The solid appears in 
the solid feature tree as a solid. 

4 Create an open solid by: 

 dragging the handles. 

 double-clicking the solid to display the Revolution dialog (see 
page 76). Enter a new Angle.  

 
For an open solid of revolution, caps are only added to the ends 
if the wireframe object is planar and closed. 

 

Editing a solid of revolution 
Use one of the following techniques to edit a solid of revolution: 

 Select the solid of revolution and use its graphical handles to 
change the orientation of the solid of revolution. 

 Select the solid of revolution and use one of the operations from 
the Edit menu.  

Edit > Modify displays the Revolution dialog (see page 76). 

Edit > Convert > Solids to surfaces converts the solid into surfaces 
for editing. 

 Double-click the solid of revolution to display the Revolution 
dialog (see page 76). 

 Use the options on the Solid Edit toolbar (see page 24). 

 Double-click the icon of the solid of revolution in the tree to 
display its dialog and graphical handles. 
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The icon is different if it has features. 

 = solid with features. This is the icon of the solid. 

 = solid without features. This icon appears as a feature at the 
bottom of the tree for the solid. 

 Right-click the solid of revolution to display the edit options 
available for solids of revolution. At the top of the context menu, 
you can see the type of the solid, its name and the level on 
which it lies. 
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Graphically editing a solid of revolution 
Select the solid of revolution to display its graphical handles. 

 
These workplane handles are used to: 

 move the revolution 

 change its direction 

 twist it about its axis. 
 

Revolution dialog 
Use the three tabs on this dialog to edit the solid revolution 

Revolution dialog - Workspace (see page 77) 

Revolution dialog - Sketch (see page 78) 

Revolution dialog - Dimensions (see page 76) 
 

Revolution dialog - Dimensions 
Use this dialog to edit a solid of revolution. 

 
Name - This is the name of the selected solid of revolution. You can 
edit the name. 
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Angle - This is the angle that the wireframe object is rotated around 
the axis. You can change this angle to make a closed solid of 
revolution into an open one. 

 

 - Flips the orientation of the solid, such that the outside of the 
solid becomes the inside and the inside becomes the outside. 

OK - Saves the edits carried out on the solid of revolution and 
closes the dialog. 

Cancel - Closes the dialog and discards any changes made. 
 

Revolution dialog - Workspace 
Use this dialog to edit the workspace of a solid of revolution.  

It is the same as Primitive Solid dialog - Workspace (see page 48). 
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Revolution dialog - Sketch 
Use this page of the dialog to edit the wireframe for the revolution. 

 

Create a copy of the sketch 
Click this button to add a copy of the composite curve to the model. 
The Information dialog is displayed to confirm the copy. 

 

Replace sketch 
Click this button to replace the sketch curve (see page 67). Use the 
dialog to select the curve to replace. 

 

Edit sketch 
Click this button to edit the wireframe. The example below is used 
to show you how to edit the wireframe. 

1 Click Edit sketch. The following is displayed: 

 wireframe. 

 Curve Edit toolbar.  
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  is displayed on the dialog. 

 
2 Delete two of the points, by using the graphical handles or the 

options on the Curve edit toolbar. 

 

3 Once you have finished editing the wireframe, click  to accept 
the edit or  to cancel the edit. 

 
 

Creating a Solid Drive Curve from wireframe 
You can create a drive-curve solid from wireframe. This means that 
you can create elaborate solids from a very basic starting point. You 
can also create standard tubes and rods using this functionality. 



 

80 • Solid modelling PowerSHAPE 2015 R2 Reference Help  

  

  

  

1 Click  (Solid toolbar) 

2 Complete the options on the Drive-Curve dialog. 
 

Drive-Curve dialog 
Use this dialog to create a solid from a drive-curve and sections. 

 
Selection Mode 
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Sections - Select the section(s) to use to create the solid. The  
changes to . The section does not have to be planar. 

Drive-Curve - Select the Drive-Curve option and then select the 
drive curve to use to create the solid. The  changes to . 

Offset Properties 

Wall Thickness - A thickness of zero will result in solids like the 
ones below: 

 

 

Offset Inwards - Non-zero wall thickness can be inwards  or 
outwards  from the section. 

 
Preview - Displays the solid created using the current selection of 
objects and the default options. You may change your selection until 
you are satisfied with the previewed solid. You can change the 
default options by clicking the Options button. 

Options - This displays the Drive-Curve options dialog, for changing 
the default options. The options on this dialog are the same as on 
the Drive-curve surface options dialog.  

Apply - Saves the solid. The dialog remains on the screen for you to 
select more objects and continue creating solids. 

OK - Saves the solid created and closes the dialog. 

Cancel - Closes the dialog and discards any changes made. 
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Solid Drive-Curve options 
Use this dialog to change the default options used to create the 
solid. 

 
Selection mode - Select objects to define your solid. Since objects 
can be used for different reasons, different options are provided to 
reflect this. You can specify whether the objects selected are to be 
wireframe or a drive-curve. 

Sections - Select the section. The  changes to . You can also 
change the selection. 

Drive-Curve - Select this option and select a drive curve. You can 
select a line, arc, curve or composite curve from your model to 
define the drive-curve. The  changes to . 

Guide-Curves... - Sometimes the wrong shape is created because 
the wrong points on successive curves are joined. You can define 
the points that should be linked by defining a wireframe object 
between them. In the new solid, these points will be joined by a 
smooth curve, that does not necessarily follow the shape of the 
wireframe object. 

 The wireframe object which links points on laterals must 
cross all laterals. Also, the wireframe must already exist in 
your model before using this solid creation command. 

To use an existing curve as a guide-curve, select this option and 
select the curve. 

Driving Options 
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Automatic Point and/or guide-curve insertion - Attempt to insert 
guide-curves automatically. This option is available for use with 
separate closed curve surfaces and drive-curve surfaces with 
closed sections. This option is selected by default. 

If selected, any previously selected guide-curve will be 
deselected. The option will be deselected if you manually select a 
guide-curve. 

 This option and the manual Guide-Curve creation option are 
mutually exclusive. 

Parallel to drive curve - When a drive-curve is selected, this option 
is available. When on, longitudinals leave and enter laterals with 
the same tangent direction as the drive-curve. For example, 
consider the following wireframe: 

 
The following show the effect of deselecting  and selecting  
Parallel to drive curve. 
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Keep width constant - If ON, the thickness of the solid is kept 
throughout, by adding in extra points for the complex region of 
the drive-curve. 

Drive Curve Discontinuity Smoothing Angle – If the angle of 
discontinuity is less than the value given here, all tangent 
discontinuities are smoothed when generating the drive-curve 
solid. The model below shows the result if the discontinuity of the 
drive-curve is greater than the Drive Curve Discontinuity 
Smoothing Angle. 

 
If you increase the Drive-Curve Discontinuity Smoothing Angle, the 
tangent discontinuities are smoothed. 

 
Drive-Curve interpolation - This controls how laterals are 
orientated relative to the drive-curve. 

 Reference Direction - Laterals are orientated relative to a 
reference direction, which is set to be approximately at right 
angles to the whole drive-curve. Portions of each lateral, 
which are at right angles to the drive-curve, are made to 
correspond, by linking them with longitudinals. New laterals 
are aligned to match the orientation. This option is best for a 
planar or only slightly 3D drive-curve. 

 Curvature - Successive laterals are orientated so that they 
twist as little as possible as we move along the drive-curve. 
This option is best for a drive-curve that is straight or lies 
entirely in one plane. 

 Manual Reference Direction - The reference direction is aligned 
with the Z axis of the active workplane without reference to 
the drive-curve. This option is recommended for advanced 
users only. 
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 Helical - Use this option to create helical sweep solids. The 
solid below is created with Helical Interpolation. 

 
 Manual Alignment Direction - Aligns to, and rotates around Z-

axis of active workplane. 

 
 Minimal Lateral Variation - Minimises the changes of alignment 

from one lateral to the next. 

 
Edge Matching - Select an appropriate option from the drop-down 
list. 

Preview - Displays the solid created using the current settings in the 
dialog. You may continue to change the settings in the dialog until 
you are satisfied with the previewed solid. 

Apply - Saves the solid. The dialog remains open for you to select 
more wireframe objects and continue creating solids. 

OK - Saves the solid and closes the dialog. 

Cancel - Closes the dialog and discards any changes made. 
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Creating a solid core 
Use this option to produce a male form to match a female cavity. 
This can be useful when modelling electrodes or when generating 
cores for casting. 

You can use solid core functionality to create of the following: 

 solid core using wireframe (see page 86). 

 solid core from a selected face (see page 87). 
 

Creating a solid core using wireframe 
To create the solid core using wireframe, define the cross-section of 
the new solid and an offset. The core is automatically generated and 
fitted into the relevant feature on the model. 

 
The cross-section of the new solid is defined by a closed and planar 
wireframe object. 

1 Make sure that the solid is either active or selected. 

2 Select a closed and planar wireframe object.  

The direction of extraction is shown by the instrumentation . 

 

3 Click  (Solid toolbar). 

4 Use the Solid Core dialog (see page 87) to create a solid core. 
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Solid Core dialog 
This dialog is used to define a solid core (for example, for an 
electrode). 

 
Spark gap — This is the distance between the core and the cavity. 
Usually, this is zero because any offsetting can be done more easily 
by using a negative thickness when machining. 

 
If you specify an offset, make sure that the original solid is faultless 
because solids with faults will not offset correctly. Click  Solid Doctor 

 (Solid Edit toolbar) to fix faults in the solid. 

Keep wireframe — When selected, the original wireframe object is 
kept in the model. 

 — Click this button to reverse the extrusion direction. This is the 
same as clicking on the wireframe instrumentation on the model. 

OK — Creates the core and closes the dialog. 

Cancel — Closes the dialog without creating the core. 
 

Creating a solid core using a selection 
To create a solid core from a selection: 

1 Select the faces. 
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2 Click  to display the Solid Core From Selection dialog. 

 
3 Use the options on the Main tab to specify the main settings for 

the core. 

4 Use the options on the Advanced tab to specify additional 
settings. 

 When the Solid Core from Selection dialog is displayed, you can 
change the face selection using the Solid Edit toolbar selection 
buttons and Restore selection (Views toolbar). 

Main tab 
Use the settings on this tab to specify the main settings for the 
core. 

1 Click the Shape button to select one of the following shapes: 

  If you select this option, you can define the length, width 
and height of the core. 

  If you select this option you can define the diameter and 
the height of the core. 

2 Use the options in the Dimensions section to specify the 
dimensions of the core. 

 Choose User Defined (default setting) to use set the 
dimensions of the core to the tightest values enclosing the 
selected items. 
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Alternatively, to use previously defined shapes, select an 
option from the drop-down list. The options on this list are 
defined in blanks.csv.  

 Information on blanks.csv is included in the Electrode 
section of the PowerSHAPE on-line help. 

 Enter an Oversize value to increase the dimensions by the 

amount you enter. Use  to toggle between specifying 
Oversize as a measurement or a percentage. 

Entering an oversize value of 0 reverts the dimensions back to 
the tightest values enclosing the selected items. This is the 
same as choosing User Defined in the drop-down list 

 Select Round values to round the dimension values. 

For example, if the length of the core is 10.367 and Round 
values is selected and a rounding value of 0.5 is entered, the 
length will be rounded to 10.5. 

 Use the drag handles to change the size of the core. You can 
enter an exact value in the box that is displayed when you 
have dragged instrumentation when creating a Solid core from 
selection. 

 
You can define how use of the graphical drag handles is 

applied. If  is displayed, the opposite side of the core will 
also be updated when the handle is dragged. 

If  is displayed, the opposite side of the core is not 
updated. 

3 Use the Boolean option to control whether or not the core should 
be Boolean subtracted or Boolean intersected with the selected 
faces. 

 If deselected, the operation will create a solid core as a 
primitive solid. 

 If selected, the operation will create a solid with a Boolean 
feature. 
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 The Boolean section does not appear if the selected items 
are not faces of a solid. 

Advanced tab 
Use the options on the Advanced tab to specify additional settings. 

 
1 Select Best Fit or Workplane from the Alignment drop-down list. 

If you select Best Fit, the Z-axis of the core is aligned with the Z-
axis of the currently active workplane, but it is rotated to 
produce the tightest bounding box around the selected items. 

2 Use the Origin options to specify the origin position of the 
primitive solid: 

 
 Round values — Select this option to round the values and 

enter the rounding factor. 

 Use the grid to position the origin of block. 

 Use the drop-down list to specify the location of the origin: 

Bottom — The origin will be at the minimum Z coordinate of 
the solid. 
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Top — The origin will be at the maximum Z coordinate of the 
solid. 

3 Use the Transparency slider to specify the transparency of the 
faces of the graphical preview of the core. 

 To avoid the need to re-enter the value, the rounding value 
that you enter is remembered for your PowerSHAPE session. 

 

Using solids 
The following sections contain information on finding open 
boundaries and using scaling constraints: 

Finding open boundaries on solids (see page 91) 

Using Scaling Constraints (see page 92) (version 8 solids only) 
 

Finding open boundaries on solids 
You can highlight any segments of selected solids' boundaries which 
are open (that is, not properly linked) within tolerance. 

1 Select the solids you want to check. 

 

2 Click Model Fixing  on the General edits  flyout. 

3 Click Show open edges in solid  (Model fixing toolbar) to 
display the Open Edges Information dialog. 
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Any open segments of the solids' boundaries are highlighted. 

 
The dialog tells you whether the solids are fully linked. 

 
4 Click OK. Any open segments of solids' boundaries are no longer 

highlighted. 

If there are small holes in the solid, fix these using one of the 
following methods: 

 Convert the solid it back to surfaces, increasing the tolerance 
and re-make the solid.  

 Select Tools > Model Fixing > Repair Solid. 
 

Using Scaling Constraints 
 Scaling constraints can only be applied to version 8 solids. If 

your model contains post-version 8 solids, they will need to 
be converted manually (see page 21) before constraints can 
be applied. 

You can apply constraints to solids that you wish to scale. It is 
advisable to use small scaling factors (for example, 1.2, 1.3) when 
you are using scaling to ensure that the stitch margin is able to 
produce a smooth and acceptable solution. 
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Scaling constraints let you keep certain entities locked whilst scaling 
the rest. You can apply scaling constraints to the following: 

 solids (see page 93) 

 groups of adjoining surfaces in a solid that have been defined as 
a User Defined feature (see page 94) 

 symbols. 

Scaling constraints are used where graded copies of some geometry 
are required but portions of the geometry are to be kept constant 
irrespective of the scale factor that is being applied. 

Examples 
You could use scaling constraints in the following situations: 

 Bottles; scale the whole bottle but keep the neck of the bottle 
the same size. 

 Shoes; scale the shoe sole but keep the airbag or logos the same 
size. 

 Applying scaling constraints will not make any immediate 
change to the model that is displayed, but will be used when 
you scale the model. 

 

Setting constraints for solids 
1 Select the solid to be constrained. 

2 Select Scaling Constraints... from the solid context menu in the 
solid tree. 

 

 The Scaling Constraints option is also displayed on the 
Symbol context menu to allow scaling constraints to be set 
for symbols. 
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The Set Constraints for solid dialog will be displayed. 

 
 

Setting constraints for solid features 
The Scaling Constraints option is only available on the solid tree for 
a User-defined feature. It does not appear on the context menu for 
other solid features. 

 
 

Set Constraints for solid dialog 
You can define the scaling constraints in one of the following ways: 

 Fixed Size (see page 95) - Use this method to select the 
directions that are to remain unaltered by scaling. 
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 Fixed Distance (see page 97) - Use this method to maintain the 
relative position of  two solids or two user-defined features. 

 

Set Constraints dialog - Fixed Size 
This page lets you modify the Constraint Plane and select the 
directions to remain unaltered by scaling. 

 
Use the check boxes to select the directions to remain unaltered by 
scaling. 

Fixed in X direction - Constrain the item so that it is of fixed size 
in the X direction with respect to the constraint workplane. 

Fixed in Y direction - Constrain the item so that it is of fixed size 
in the Y direction with respect to the constraint workplane. 

Fixed in Z direction - Constrain the item so that it is of fixed size 
in the Z direction with respect to the constraint workplane. 

Use the Link Axis and Link options to create linked scaling 
constraints. For example, link the X and Y dimensions as follows:  

1 Deselect Fixed in X direction.  

2 Select Link X. 

3 Select Y axis from the Link Axis drop-down list. This links X and Y 
dimensions so any change that you make to the Y dimension will 
also be applied to the X dimension. 
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4 Use Scale (General edits toolbar) to scale the solid. The scaling 
constraints that you set are applied and a confirmation message 
is displayed. 

Constraint Plane 
When you scale the constrained object, it is the constraint plane 
origin that is scaled. The constraint plane origin moves with the 
scaled origin and the constrained entity repositions itself around the 
updated constraint plane origin. 

The default origin of the constraining entity is displayed on the 
model. Change the Origin, Axis and Twist options to modify the 
constraint plane 

Origin - The X, Y, Z coordinates of the centre point of the 
constraining entity. If you need to alter the origin, enter the new 
coordinates in the relevant box. 

 - Display the Position dialog so that you can define the 
constraint plane. 

Axis - To change the direction of the constraint plane's axes, 
click the button of the axis you wish to change. This displays the 
Direction dialog. Use this dialog to input the axis information and 
click Accept. 
Twist - To twist the constraint plane about its axis, click the 
button of the axis you wish to twist. This displays the Calculator 
dialog. Use this dialog to input the twist value and click Accept. 

Decide the best Stitching Margin automatically - If you want to keep 
the user defined feature the same size, scaling will result in a gap 
around the feature. A stitch margin stretches the portions of the 
solid around the user defined feature to blend the gap generated 
around the feature and maintain the closure of the solid. 

If ON, PowerSHAPE will decide the size of the stitching margin, 
depending upon the size of the gap created. 

If OFF, the Stitching Margin option is active. 

Stitching Margin - Enter the distance around the periphery of the 
item being constrained, where stretching would occur when you 
scale the item. This option is only available if Decide the best 
Stitching Margin automatically is OFF. 
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The following shows the effects of using the automatically calculated 
stitch margin and using different sizes of user defined stitch 
margins. 

 

 - Original. 

 - Stitching margin decided automatically. 

 - Userdefined stitching margin of 5. 

 - User defined stitching margin of 10. 

Unconstrain - Remove all the constraints on the selected item and 
close the dialog. 

OK - Accept the constraints settings and close the dialog. 
 

Set Constraints dialog - Fixed Distance 
This dialog is used to maintain the relative position of  two solids or 
two user-defined features. 

You can constrain a solid to be a fixed distance from: 

 another solid. 

 a user defined feature on another solid. 

You can constrain a user defined feature to be at a fixed distance 
from: 

 Another user defined feature that is in the solid tree. 

 A solid that is not the parent of the user defined feature being 
constrained. 

 A user defined feature on a solid that is not the parent of the 
user defined feature being constrained. 

 You cannot define circular constraints. The following 
constraints would not be valid: 
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(feature 1 should be a fixed distance from feature 2) AND 
(feature 2 should be a fixed distance from feature 1) 

 
Use the Solid and Feature drop-down lists to define the reference for 
the object to be constrained. The reference can be another solid or 
a user defined feature on another solid. When scaling, the 
constrained object will be scaled such that it will maintain its 
distance from its reference object. 

Solid - Select one of the available solids from the drop-down list. 

Feature - Select one of the available features from the drop-down 
list. 

Projection Axis 
Use a projection axis to maintain distance - Click to use an axis of the 
workplane to maintain the distance. When this option is selected, 
modify the projection axis by changing the Origin, Axis and Twist 
options. 

Select the projection plane - Select the axis from the drop-down list. 
The distance is maintained along the selected axis. 

Axis - Click the button of the axis to be changed. Enter the axis 
information using the Direction dialog. 

Twist - Click the button of the axis you wish to twist. Enter the twist 
value using the Calculator dialog. 
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Decide the best Stitching Margin automatically - If you want to keep 
the user defined feature the same size, scaling will result in a gap 
around the feature. A stitch margin stretches the portions of the 
solid around the user defined feature to blend the gap generated 
around the feature and maintain the closure of the solid. 

If selected, PowerSHAPE will decide the size of the stitching margin, 
depending upon the size of the gap created. 

If deselected, the Stitching Margin option is active. 

Stitching Margin - Enter the distance around the periphery of the 
item being constrained, where stretching would occur when you 
scale the item. This option is only available if Decide the best 
Stitching Margin automatically is selected. 

Unconstrain - Remove all the constraints on the selected item and 
close the dialog. 

OK - Accept the constraints settings and close the dialog. 
 

How do I know if scaling constraints are set? 
When you set up a scaling constraint,  will appear against Scaling 
Constraints in the context menu. 
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 The warning message shown below is displayed when you use 
the Scale option (General edits toolbar) to scale multiple 
objects if any of the selected items has scaling constraints 
already set. 

 
 

Editing and Removing constraints 
You can edit the constraints on a version 8 solid or symbol as 
follows: 

1 From the solid tree context menu, select Scaling Constraints. 

2 Use the Set constraints for solids dialog (see page 94) to choose 
different options. 

You can remove the constraints on a version 8 solid or symbol as 
follows: 

1 From the solid tree context menu, select Scaling Constraints. 

2 Select Unconstrain on the Set Constraints for solids dialog (see 
page 94). 

 Scaling constraints are not available for post-version 8 solids 
(Parasolids) 
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Scaling using Fixed Size scaling constraints 
The following example shows you how to create a scaled version of 
a wine glass, whilst keeping the stem of the glass the same length. 

 
1 Define the stem surfaces as a user-defined feature. 

2 Using the Set Constraints for feature dialog, add a Fixed Size 
constraint on the user-defined feature in X, Y and Z direction, 
moving the Z coordinate of the origin of the Constraint Plane to -
33.72899 
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3 Scale the wine glass uniformly by a factor of 1.2 

 
You will see that geometry of the body of the wine glass has 
been scaled, but the stem of the scaled version of the wine glass 
is the same size as that of the original. 

 

Scaling using Fixed Distance scaling constraints 
The following example shows you how to create a scaled version of 
a bottle, whilst maintaining the thickness of the bottle. 

 
1 The model above has two user defined features: 
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User_Defined_Feature_1 - the bottle inner. 

 
User_Defined_Feature_2 - the bottle outer. 
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2 Using the Set Constraints for feature dialog, add a Fixed Distance 
constraint on the user-defined feature, such that 
User_defined_Feature_2 will remain a fixed distance from 
User_Defined_Feature_1. 

 
3 Scale the bottle uniformly with a factor of 1.2 

The bottle will be scaled in size but the thickness of the bottle 
will remain the same because of the fixed distance constraint. 

You can compare the thickness of the two bottles by using 
dynamic sectioning. 

 

 Scaling with constraints applied completely changes the shape 
of the model. The stretching process may well affect any 
features you have used. It is therefore advisable to have only 
user defined features in your model when using constrained 
scaling. 
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Solid features 
A solid feature is an operation that has been applied to a solid. By 
remembering the details of the operation, a feature can be 
redefined, reordered, deleted and suppressed. The history of solid 
operations performed on a solid is stored in the solid feature tree 
(see page 254). Each solid operation is defined as a feature on the 
solid. 

Creating solid features 

1 On the Main toolbar, select the Feature  button to display the 
Feature toolbar 

2 Use the following buttons to create solid features. 

 Smart Feature Recognition 

 Smart Feature Selection 

 Adding onto a solid (see page 108) 

 Subtracting from a solid (see page 110) 

 Intersecting using a solid (see page 112) 

 Split a solid (see page 117) 

 Solid cut (see page 122) 

 Radial cut (see page 134) 

 Solid boss (see page 138) 

 Boolean boss (see page 148) 

 Solid hole (see page 151) 

 Hollow solid (see page 167) 

 Thickened solid (see page 174) 

 Solid bulge (see page 176) 
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 Morph (see page 312)  

 Solid fillet (see page 180) 

 Solid chamfer (see page 206) 

 Rib fillet (see page 225) 

 Pocket or protrusion feature (see page 227) 

 User-defined feature (see page 239) 

 Wrap feature (see page 242)  
 

Editing a feature 
You can edit a feature in one of the following ways: 

 Using the feature tree. (see page 257) 

 Using the options on the General Edit toolbar or the 
corresponding General Edits options on the Edit menu. 

Editing a feature using the General Edit toolbar 
You can use the Move, Rotate, Scale, Mirror and Create pattern 
options from the General Edit toolbar on most features. You can also 
use the corresponding General Edit options on the Edit menu. 

 You cannot apply these commands to some features, such as 
the fillet feature. PowerSHAPE automatically deselects such 
features when you begin the edit command. 

To edit a feature using the General Edit toolbar: 
1 Select a feature in the tree. 

2 Click General Edits . 

3 The following options are available on the toolbar: 

  Edit selected item (solid) 

  Edit selected sub-item (solid feature) 

  Move  

  Rotate  
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  Scale (Uniform scaling only) 

  Mirror  

  Pattern of items 
 

Exporting solid features 
The following solid features can be exploited to PowerMILL, using 
the Delcam Geometry + Features (.dgk) option on the drop-down list 
(Export dialog): 

 holes 

 pockets/protrusions 

 cuts/bosses 

Fillet and chamfer information at the bottom and top of a feature is 
also exported, but is not currently used by PowerMILL. 

 

Adding onto a solid 
You can add the following onto a solid: 

 Inactive solids — after the operation, the inactive solid no longer 
exists. 

 Surfaces —  PowerSHAPE automatically makes the surface into a 
solid before adding it to the solid. 

 Symbols— all solids and surfaces within the symbol are copied 
and added onto the solid.T 

 The symbol itself does not change or get deleted. If you use 
a symbol, the add feature of the symbol is non-scalable in 
the solid. 

You can use Boolean addition on: 

 The active solid. 

 A pre-selected inactive solid, when the active solid is hidden. 

To add objects to a solid: 
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1 Click  (Solid feature toolbar) to display the Boolean Addition 
dialog. 

 
If there is a visible active solid, this is automatically be used as 
the Primary selection. If you pre-select an inactive solid while the 
active solid is hidden, the inactive solid is used as the Primary 
selection. 

2 Select a secondary object. The  changes to . 

If necessary, click Swap Objects to reverse the Primary and 
Secondary selection objects. 

3 Click OK to confirm your selection and close the dialog. 

An Add feature icon  representing the operation appears in the 
solid feature tree. 

If the added solid has features, they are added as a sub-tree 
next to the Add feature icon . 

Below is an example of two intersecting solids, displayed as 
shaded  and as wireframe . 
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In this example, the following solid is created: 

 

The shaded view  looks identical to the original, but in the 
wireframe view  you can see the two separate solids have 
been merged into one solid. 

 

Subtracting from a solid 
You can subtract the following from a solid: 

 Inactive solids — after the operation, the inactive solid no longer 
exists. 

 Surfaces — PowerSHAPE automatically makes the surface into a 
solid before subtracting it from the active solid. 

 Symbols —all solids and surfaces within the symbol are copied 
and subtracted from the active solid. 

 Note the symbol itself does not change or get deleted. If 
you use a symbol, the subtract feature of the symbol is 
non-scalable in the solid. 

You can use Boolean subtraction on: 

 The active solid. 

 A pre-selected inactive solid, when the active solid is hidden. 

To subtract from a solid: 
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1 Click  (Solid feature toolbar) to display the Boolean 
Subtraction dialog. 

 
If there is a visible active solid, this is automatically be used as 
the Primary selection. If you pre-select an inactive solid while the 
active solid is hidden, the inactive solid is used as the Primary 
selection. 

2 Select a secondary object. The  changes to . 

If necessary, click Swap Objects to reverse the Primary and 
Secondary selection objects. 

3 Click OK to confirm your selection and close the dialog. 

A Subtract feature icon  representing the operation appears in 
the solid feature tree. 

If the subtracted solid has features, they are added as a sub-tree 
next to the Subtract feature icon  

Below is an example an active solid  intersected by an inactive 
solid : 
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In this example, the new active solid is given below: 

 
 

Intersecting using a solid 
You can intersect the following with a solid: 

 Inactive solids — after the operation, the inactive solid no longer 
exists. 

 Surfaces — PowerSHAPE automatically makes the surface into a 
solid before intersecting it with the solid. 

 Symbols — all solids and surfaces within the symbol are copied 
and intersected with the solid.  

 The symbol itself does not change or get deleted. If you use 
a symbol, the intersect feature of the symbol is non-
scalable in the solid. 

You can use Boolean intersection on: 

 The active solid. 

 A pre-selected inactive solid, when the active solid is hidden. 
To intersect with the active solid: 

1 Click  (Solid feature toolbar) to display the Boolean 
Intersection dialog. 
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If there is a visible active solid, this is automatically be used as 
the Primary selection. If you pre-select an inactive solid while the 
active solid is hidden, the inactive solid is used as the Primary 
selection. 

2 Select a secondary object. The  changes to . 

If necessary, click Swap Objects to reverse the Primary and 
Secondary selection objects. 

3 Click OK to confirm your selection and close the dialog. 

An Intersect feature icon  representing the operation appears in 
the solid feature tree. 

If the intersected solid has features, they are added as a sub-
tree next to the Intersect feature icon . 

Below is an example of two intersecting solids: 

 
In this example, the following solid is created: 

 
 

Editing an add, subtract or intersect feature 
You can replace or edit the solid used in the add, subtract and 
intersect features. 
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1 Double-click the Add feature , Subtract feature  or Intersect 
feature  icon in the tree to display the Boolean Feature dialog. 

 
2 Use the dialog to edit the feature. 

 - Use the drop down list to change the type of Boolean 
operation. 

 - Creates a copy of the selected solid used in the feature. 
When you select OK, the entire sub-branch (the solid and its 
history) will be copied. If the sub-branch only contains one 
primitive feature, the new solid will be a primitive solid. 

Display primary and secondary solids - If ON, the original solids 
are displayed. If OFF, the original solids are not displayed. The 
default setting is OFF. 

 If this option is OFF and you click  to display the Solid 
Feature Relationship dialog (see page 251), the key points 
on the solids (corners and centres of planar faces) will not 
be available. 

Replace Solid - Select this if you want to replace the solid with 
another one. The Replace Solid (see page 115) dialog will be 
displayed. 

 - Displays the Solid Feature Relationship dialog (see page 
251). This allows the relative position of the feature to be defined 
with respect to the solid. The current status of the relationship is 
indicated by one of the following 

 - No relationship is currently defined. 

 - A valid relationship is defined. 

 - a relationship is defined, but there is a problem  
with the definition. 

3 Click OK to accept the changes. 
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Replace Solid dialog 
This replaces the solid used in an add, subtract and intersect 
feature. 

 
Object selected - This indicates whether a replacement object is 
selected for the feature. The replacement object can be a solid, 
surface or a symbol. 

OK - Accepts the changes and closes the dialog. 

Cancel - Closes the dialog without saving any changes. 

In the following example, the subtracted solid  will be replaced by 
the block . 

 
1 Double-click the Subtract feature icon  in the solid feature tree 

to open the Boolean Feature dialog. 

If you want to keep a copy of any subtracted solids, click Copy 
secondary solid  before clicking Replace Solid. 
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If you want to display any subtracted solids, select Display 
primary and secondary solids  before clicking Replace Solid. 

 
2 Click Replace Solid to open the Replace Solid dialog. 
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3 Select the object that you want to use to replace the original 
solid. The  changes to . 

 
4 Click OK to accept the changes. The cylindrical solid is removed 

and the block is subtracted from the active solid. 

 
 

Spliting a solid 
You can split a solid using one of the following methods: 

 Using a pre-selected cutter (see page 118). If you have an active 
solid and a pre-selected cutter, the Solid Split dialog will not be 
displayed and the solid will be split according to default settings. 

The following can be pre-selected as the cutter: 

 an inactive solid. After the operation, the inactive solid no 
longer exists. 

 a solid face. 
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 a surface. PowerSHAPE automatically makes the surface into a 
solid before using it to split the active solid. After the 
operation, the surface no longer exists. 

 a symbol. All solids and surfaces within the symbol are copied 
and used to split the active solid. The symbol itself does not 
change or get deleted. 

 a workplane. 

 Without a pre-selected active solid or cutter (see page 119). 

 Using multiple faces (see page 119). 

 The default Split operation produces unconnected solids with 
copied history trees (see page 121). 

 

Splitting a solid using a pre-selected cutter 
You can split a solid using multiple selected faces as the cutter. 
When multiple faces are selected, the single solid is split and no 
extra solids are created 

 
1 Ctrl + click the faces to select them to be used as cutters. 
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2 Click  (Solid Feature toolbar) to split the solid. 

 
 

Splitting a solid without a pre-selected cutter 
If you select Solid split without having a suitable cutter item 
selected or without having an active solid to work on, the Solid Split 
dialog is displayed. 

 

1 Select the solid to be split . 

2 Select the cutter type from the drop-down list . 

 
3 Click  and select the cutter. 

4 Select Keep all solids to retain all the new solids created by the 
split operation . 

5 Select Create Boolean features to create Boolean features . 

6 Click Apply to split the solid. 
 

Splitting a solid using multiple faces 
You can split a solid using multiple selected faces.  
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 This example does not use a pre-selected cutter. 

1 Select the solid to be split. 

 
2 Select Solid Faces from the Cutter drop-down list. 

3 to select the faces to be used as cutters. 
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4 Click Apply to split the solid. 

 
 

Split history 
The Split operation produces unconnected solids with copied history 
trees (with the addition of the top boolean feature). The example 
below shows two solids: 
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 Use Split  to split a solid and produce unconnected solids with 
copied history trees. 

 
 

Creating a solid cut 
You can cut shapes into a solid using wireframe objects. Behind the 
scenes, PowerSHAPE creates extruded solids from the wireframe 
objects and either subtracts or intersects them with the solid. 

You can partially cut the solid or cut straight through. 
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You can keep either the outside or inside material of the cut. 

 
To create a solid cut use one of the following methods: 

 Make sure you have an active solid and then select the wireframe 
objects. 

 Drag your cursor to select an inactive solid and the wireframe 
objects together. 

 The wireframe objects must be closed and planar. 

 

 Your selection can contain other objects. PowerSHAPE 
filters the valid wireframe from the selection. 
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1 Click  (Solid feature toolbar). 

 
2 Use the Solid Cut dialog (see page 124) to cut the wireframe 

objects into the solid. 
 

Solid Cut dialog 
Use this dialog to cut wireframe into a solid. 

 
You can add a solid cut to: 

 The active solid. 

 An inactive solid that has been preselected with the wireframe. 

Each wireframe object is extruded along the axis normal to the 
plane in which it lies to create the extruded solid. 
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The extruded solid has a handle , which can be used to edit the 
length. 

 
1 Select Type from the drop-down list: 

 Select Blind to set the depth to cut into the solid. 

 Select Through to cut all the way through the solid. 

2 Click  to create a copy of the original wireframe used in the 
construction of the cut. 

3 Enter the Depth. This is the length of the extruded solid, 
measured from the plane of the wireframe . 
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The depth can also be adjusted using the handle. If you are 
creating a solid cut using more than one wireframe, dragging the 
handle of an extruded solid will change the lengths of all the 
extruded solids. The value of Depth in the dialog updates to 
reflect the change. 

 
To cut all the way through the solid, select the Through option 
from the Type option menu. 

4 Enter the Angle to define a draft angle the extruded solid. 

 
5 Click  to extend the extrusion in both directions from the 

sketch. The button changes to  to show that the extrusion will 
be extended in both directions. 

6 Click  to reverse the direction of the cut. 

7 Click  to display the Solid Feature Relationship dialog. This 
allows the relative position of the feature to be defined with 
respect to the solid. The current status of the Relationship is 
indicated by one of the following: 

 no relationship is currently defined. 

 a valid relationship is defined. 

 a relationship is defined, but there is a problem with the 
definition 
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8 Click  to add the selected sketch (arc, curve or composite 
curve) to the feature. 

9 Click  to group nested sketches (see page 147). 

If this option is selected, any sketches that lie on the same plane 
are nested and are used to produce an island-type extrusion.  

 Using two concentric circular sketches would produce a tube 
with a thickness. 

 Using three concentric circular sketches, the tube would have 
a cylinder inside it.  

 
If this option is deselected, only the selected wireframe will be 
used to produce the solid boss. 

10 Click  or  to specify if the draft angle is to go in or out. 

11 Use  and   to remove material as required. The default 
setting will remove material outside the sketches. 

 Click  to remove material inside sketches. 

 Click  to remove material outside sketches. 

12 Click Apply to create the cut, leaving the dialog displayed. This 
lets you 

 create another cut. 

 edit the existing cut. 

Alternatively, click OK to create the cut and close the dialog. 

A Cut feature icon  appears in the solid feature tree. 

13 Make changes to the cut as required: 

a Click  to switch to Edit mode. The button changes to .  

b Click the cut. 
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c Use the options on the dialog to edit the cut. 

d Click Apply to save the changes you have made. 

14 When the cut creation is complete, click Cancel to close the 
dialog. 

Name - The drop down list contains the names of the sketches. If 
the feature has more than one sketch, the Delete button is active. 
You can remove a sketch from the feature by selecting a profile 
from the Name drop down list and clicking Delete. 

Remove inside material - When on, the extruded solids are 
subtracted from the solid . When off, the extruded solids are 
intersected with the solid . 

 
 

Solid Cut dialog (Edit options) 
Additional options are available when you edit a cut feature. You 
can simultaneously edit multiple cuts (see page 247). 

1 Enter editing mode in one of the following ways: 

 Double-click the Cut feature  icon in the tree to display the 
Solid Cut dialog (see page 124) with the edit options available. 

 Double-click the cut feature on the model to display the Solid 
Cut dialog (see page 124) with the edit options available. 

 Click  (Solid feature toolbar) to display the Solid Cut dialog 

(see page 124). Click  and select the cut to make the edit 
options available. 
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 If the Solid Cut dialog is already displayed, click  and 
select the cut. The edit options will become available on the 
Solid Cut dialog. 

 
2 Select the wireframe of the existing cut by clicking on it or 

selecting it from the Name drop-down list. The extruded solid of 
the selected wireframe is highlighted. 

 
3 Edit the wireframe as required: 



 

130 • Solid modelling PowerSHAPE 2015 R2 Reference Help  

a Click the Edit button to make the Edit curve toolbar available. 
The label on the Edit button changes to Finish. The extruded 
solid for the selected wireframe is no longer visible. 

 
b Edit the wireframe either graphically or using the commands 

on the Edit curve toolbar. 
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c Once you have finished editing the wireframe, click the Finish 
button. 

 
d Click Apply to recreate the cut on the solid using the edited 

wireframe. 

 
4 If required, Replace the selected wireframe of a cut with another 

piece of wireframe: 
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a Select the wireframe of the cut to be replaced. 

 
b Select the replacement wireframe . The Replace button 

becomes available . 
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c Click the Replace button. An extruded solid is created from the 
replacement wireframe and the extruded solid of the replaced 
wireframe is deleted. The wireframe of the replaced extruded 
solid is now visible. 

 
d Click Apply to recreate the cut using the replacement 

wireframe. The wireframe of the replaced extruded solid is left 
in the model. 

 

 You can edit the wireframe using the mirror, move, rotate, 
offset and scale commands on the Edit toolbar. 

 

Example: Creating a solid cut using nested sketches 
1 Create a block and ensure that it is active 
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2 Create a full arc and two polygons in the same plane as the block 
(the Create Composite curve option on the Polygon dialog should 
be ON). Your model should similar to the one below. 

 
3 Select the block, arc and polygons 

4 Click  (Main toolbar). 

5 Click  (Solid feature toolbar) button to display the Solid Cut 
dialog (see page 124). 

6 Click  to Group sketches into regions. 

7 Click OK. 

 
 

Radial Cut 
Use the Radial Cut feature to create a pocket in a solid, that can be 
milled on a turn-mill machine. 

 This functionality is available only with PowerSHAPE Pro, 
PartMaker Modeling, and Toolmaker. 
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Creating a radial cut feature 
1 Create a workplane on the solid, that is centred along the axis of 

revolution. 

2 Select the solid and click  to display the Feature toolbar. 

3 Select Create radial solid cut feature  from the Solid cut feature 

flyout . 

 
4 The Radial Cut Wizard is displayed. 

 
5 Select the cylindrical faces to cut, and the workplane created 

previously, then click Next. 

 
6 Use the Add or Remove Guidelines page of the wizard to insert 

extra angle guidelines. 
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 Enter an angle into the Angle field , and press  to 
insert a guideline. 

 Select an angle from the Angle field , and click Delete to 
remove a guideline. 

 Guidelines are useful as markers when sketching the 
wireframe used to cut the solid. 

 
7 Click Next to display the Cutter Item Selection page of the wizard. 

Use this page to define the shape of the cutting object. 

 
8 Click Sketch to hide the wizard and enter a sketching mode. Use 

the sketching mode to: 

a create new wireframe, where appropriate. 
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b select new or existing wireframe. 

 

9 Use  to select any wireframe to use as a cutting object. 

10 Click  to re-open the wizard and display a projection of the 

wireframe onto the model. Alternatively click  to discard the 
wireframe and return to the wizard. 

 
11 Click Next to display the Perform Cut and Wrap page of the wizard 

with the following options: 

 Select Cut  to use the wireframe as a cutting object. Specify 
the cutting distance using: 

Depth — enter a numerical value to define the cutting depth. 

Through — cut through to the cylinder centre-line. 

 Select Wrap  to draw the wireframe onto the model, without 
cutting into the solid.  
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Enter a value into the Offset field to move the wrapped 
wireframe away from the solid. 

 Click Apply to perform the cut or wrap. 

 Click Remove to undo a cut or wrap. 

 
12 Click Apply to perform the cut or wrap. 

 
13 Click Finish. 

 

Creating a solid boss 
You can add material onto a solid using wireframe objects. Behind 
the scenes, PowerSHAPE creates extruded solids from the wireframe 
objects and adds them onto the active solid. 
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To create a solid boss use one of the following methods: 

 Make sure you have an active solid and then select the wireframe 
objects. 

 Drag your cursor to select an inactive solid and the wireframe 
objects together. 

 The wireframe objects must be closed and planar. 

 

 Your selection can contain other objects. PowerSHAPE 
filters the valid wireframe from the selection. 

1 Click  (Solid feature toolbar). 

 
2 Use the dialog to create bosses onto the active solid using the 

wireframe objects. 
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Solid Boss dialog 
Use this dialog to add solid bosses a solid, using selected wireframe. 

 
You can add a solid boss to: 

 The active solid. 

 An inactive solid that has been preselected with the wireframe. 

Each wireframe object is extruded to create the extruded solids. The 
direction of extrusion is defined by the position of the composite 
curve. 

The extruded solid has a handle, which edits the length of all the 
extruded solids. 

 
1 Select Type from the drop-down list.  

 If you select Automatic, the wireframe will be extruded just far 
enough to join to the solid. You can specify the angle of the 
extrusion using the Angle option.  

 Selecting Fixed lets you specify the Height of the extrusion as 
well. The extruded wireframe is added to the solid. The 
Extrude both directions option also becomes active if Fixed is 
selected. 

2 Click  to create a copy of the original wireframe used in the 
construction of the boss. 
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3 Enter the Height. This is the length of each extruded solid, 
measured from the plane of the wireframe. 

 
If you drag the handle of an extruded solid, the lengths of all the 
extruded solids change. The value of Height in the dialog updates 
to reflect the change. 

To create bosses all the way through the solid, make sure the 
height extends beyond the base of the solid. 

Enter the Angle to define a draft angle on the extruded solids. 

 
To reverse the direction, drag the handle on the extruded solids 
to the opposite side of the wireframe. 

4 Click  to extend the extrusion in both directions from the 
sketch.The button changes to  to show that the extrusion will 
be extended in both directions. 

5 Click  to reverse the direction of the boss. 

6 Click  to display the Solid Feature Relationship dialog (see page 
251). This allows the relative position of the feature to be defined 
with respect to the solid. The current status of the Relationship is 
indicated by one of the following: 

 no relationship is currently defined. 

 a valid relationship is defined. 

 relationship is defined, but there is a problem with the 
definition 
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7 Click  to add the selected sketch (arc, curve or composite 
curve) to the feature. 

8 Click  to group nested sketches (see page 147). 

If this option is selected, any sketches that lie on the same plane 
are nested and are used to produce an island-type extrusion.  

 Using two concentric circular sketches would produce a tube 
with a thickness. 

 
 Using three concentric circular sketches, the tube would have 

a cylinder inside it.  

 
If this option is deselected, only the selected wireframe will be 
used to produce the solid boss. 

9 Click  or  to specify if the draft angle is to go in or out.  

10 Click Apply to create the boss, leaving the dialog displayed. This 
lets you: 

 create another boss. 

 edit the existing boss. 

Alternatively, click OK to create the boss and close the dialog.  

A Boss feature icon  representing the operation appears in the 
solid feature tree. 

11 Make changes to the boss  as required: 

a Click  to switch to Edit mode. The button changes to .  

b Click the boss. 
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c Use the options on the dialog to edit the boss (see page 143). 

d Click Apply to save the changes you have made. 

12 When boss creation is complete, click Cancel to close the dialog. 
 

Solid Boss dialog (Edit options) 
You can edit an existing solid boss or simultaneously edit multiple 
bosses (see page 247). 

To edit a single solid boss: 

1 Enter editing mode in one of the following ways: 

 Double-click the Boss feature  icon in the tree to display the 
Solid Boss dialog (see page 143) with the edit options 
available. 

 Double-click the boss feature on the model to display the 
Solid Boss dialog with the edit options available. 

 Click  (Solid feature toolbar) to display the Solid Boss 

dialog (see page 143). Click  and select the boss to make 
the edit options available. 

 If the Solid Boss dialog is already displayed, click  and 
select the boss. The edit options will become available on the 
Solid Boss dialog. 

 
2 Select the wireframe of the existing boss by clicking on it or 

selecting it from the Name drop-down list. The extruded solid of 
the selected wireframe is highlighted and all the others are 
greyed. 

3 Edit the wireframe as required: 
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a Click Edit button to make the Edit curve toolbar available. The 
label on the Edit button changes to Finish. The extruded solid 
for the selected wireframe is no longer visible. 

 
b Edit the wireframe either graphically or using the commands 

on the Edit curve toolbar. 
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c Once you have finished editing the wireframe, click the Finish 
button. 

 
d Click Apply to recreate the boss on the solid using the edited 

wireframe. 

4 If required, Replace the selected wireframe of a boss with 
another piece of wireframe: 

a Select the wireframe of the boss to be replaced. 
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b Select the replacement wireframe . The Replace button 
becomes available . 

 
c Click the Replace button. An extruded solid is created from the 

replacement wireframe and the extruded solid of the replaced 
wireframe is deleted. The wireframe of the replaced extruded 
solid is now visible. 

 
d Click Apply to recreate the boss using the replacement 

wireframe. The wireframe of the replaced extruded solid is left 
in the model. 

 You can edit the wireframe using the mirror, move, rotate, 
offset and scale commands on the Edit toolbar. 
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Example: Creating a solid boss using nested sketches 
1 Create a block and ensure that it is active 

2 Create a full arc and two polygons in the same plane as the block 
(the Create Composite curve option on the Polygon dialog should 
be selected).  

 
3 Select the block, arc and polygons 

4 Click  (Main toolbar) to display the Solid Feature toolbar. 

5 Click  (Solid feature toolbar) button to display the Solid Boss 
dialog. 

6 Click  to Group sketches into regions. 

7 Click OK. 
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Boolean boss 
Use Boolean boss functionality to create a Boolean addition between 
the active solid and another solid; the other solid will not pass all 
the way through the active solid. The feature tree will be updated to 
include a sub-branch to the boss feature showing the history of the 
secondary solid. 

1 Select the solid to be added to the active solid. 

 

2 Click  (Solid feature toolbar) to display the Boolean Boss 
dialog. (see page 148) 

 
3 Use the options on the dialog to create the Boolean boss feature. 

4 Select OK. 

5 Edit the Boolean boss (see page 150) as required. 
 

Creating a Boolean boss 
Create a Boolean addition between the active solid and another 
solid; the other solid will not pass all the way through the active 
solid. The feature tree will be updated to include a sub-branch to 
the boss feature showing the history of the secondary solid. 
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In the example, the cylinder will be added to the active solid. 

 
1 Select the solid to be added to the active solid. 

 

2 Click  (Solid feature toolbar). 

A Boolean addition will add the selected solid to the active solid 
without making it pass all the way through the active solid. 

If more than one solution is available, all possible solutions are 
displayed on the model. The faces of the current solution are 
highlighted and the number of the current solution is displayed 
prominently. Additional solutions are also numbered. 
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3 Scroll through the possible solutions using the Boolean Boss 
dialog, or click on one of the numbers to highlight that solution 
and update the Boolean Boss dialog. 

 
4 Define the relationship of the feature during creation using the 

Solid Feature Relationship  button. For further details, see 
Creating a relationship between a solid feature and a solid (see 
page 249). 

5 Select OK. 
 

Editing a Boolean boss 
1 Enter editing mode in one of the following ways: 

 Double-click the Boss feature  icon in the tree window to 
display the Boolean Boss dialog with the edit options available. 

 Double-click the boss feature on the model to display the 
Boolean Boss dialog with the edit options available. 

 
2 Use the following options to make changes to the boolean boss: 

 Use the up and down arrows to choose the Solution to edit. 

 Click  to create a copy of the selected solid used in the 
feature. When you select OK, the entire sub-branch (the solid 
and its history) will be copied. If the sub-branch only contains 
one primitive feature, the new solid will be a primitive solid. 

 Select Replace Solid to replace the solid with another one. The 
Replace Solid dialog will be displayed. 
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Creating a solid hole 
You can add the following types of holes to a solid by specifying the 
use of the hole. 

 
You can create holes in or through a solid: 

 
1 Create a solid or open a model with a solid: 
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2 Click  (Solid feature toolbar) to display the Plain Hole dialog 
(see page 154). 

 
3 Use the options on the Plain Hole dialog to create a hole (see 

page 154). 

4 Click a position on the solid where you want to create the hole. 

A shape representing the hole is drawn on the solid. 

 
5 To finish creating the hole, click one of the following: 

 Apply to create the hole and continue to display the dialog. 
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When you use Apply, you are still in hole creation mode. You 
can click the solid again to add another hole. The new hole 
will automatically use the same definition as the last one 
created and the Hole Feature dialog is displayed for you to 
modify the hole. 

 The next hole will be created using the default settings, 
unless you turn on the Reuse Last Hole Definition option 
on the Holes page of the Options dialog. 

 Cancel to remove the dialog from the screen without 
operating on the solid. 

 OK to create the hole as defined and remove the dialog from 
the screen.  

A Hole feature icon  representing the operation appears in the 
solid feature tree. After 20 holes are created in the solid, you are 
asked by default whether you want to optimise the tree (see 
page 278). 

6 Make changes to the hole as required: 

a Click  to switch to Edit mode. The button changes to .  

b Click the hole. 

c Use the options on the dialog to edit the hole. 

d Click Apply to save the changes you have made. 

 Set the Hole Export options on the Manufacturing page of the 
Options dialog to export the holes as PowerMILL hole features 
and automatically generate their toolpaths . 
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Plain Hole dialog 
Use this dialog to define the hole that is cut into the solid. 

 
1 Select the Hole Category from the drop-down list: 
 General Machining (ISO) 

Precision Machining (ISO) 
Molding 
Untoleranced 

2 Select the specific Use of the hole for the category you have 
chosen.  

With the exception of untoleranced holes, machining tolerances 
based on the intended use are also stored when the hole is 
created. 

 You can add your own hole categories and uses on the 
Holes page of the Options dialog. 

The options that are displayed on the dialog reflect the Hole 
Category and Use that you have chosen. 

3 Use  to swap between creation mode and editing mode 
without closing/reopening the dialog.  

 When in creation mode, click  to swap to editing mode 
and recognition mode. 
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 When in editing mode, click  to swap to creation mode. 

4 If available, click  to display information about the selected 
hole use. This is a general description on usage and an example 
of the application.  

 

If available, click  to display the Plane Details dialog (see page 
162). This option is only available once you have positioned the 
hole. 

5 When  is displayed, the hole is considered for machining in 
PowerMILL. Clicking  changes the button to . 

When  is displayed, the hole is ignored when exporting to 
PowerMILL. 

6 Use the following sections to set type-specific options for: 

 Counterbored holes 

 Tapped holes (see page 160) 

 Countersunk holes (see page 161) 

7 Use the Dimensions (see page 156) options to define the size 
and trim attributes. 

8 To finish creating the hole, click one of the following: 

 Apply — Create the hole and keep the dialop open. 

When you use Apply, you are still in hole creation mode. You 
can click the solid again to add another hole. The new hole 
will automatically use the same definition as the last one 
created and the Hole Feature dialog is displayed for you to 
modify the hole. 

 The next hole will be created using the default settings, 
unless you turn on the Reuse Last Hole Definition option 
on the Holes page of the Options dialog. 

 Cancel — Close the dialog without operating on the solid. 
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 OK — Create the hole as defined and close the dialog.  

 If changing a value on the Hole dialog causes the definition 
of the hole to be invalid, the status bar help for the greyed 
out Accept and Apply buttons now indicates that the values 
are incorrect. 

 

Dimensions 
For each type of hole, an image of a hole is displayed in the dialog. 

 
1 Change the dimension in one of the following ways: 

 Drag the edit handles on the hole. It is only possible to use 
this method if you have already positioned the hole on the 
solid. 

 Enter values in the dimension boxes. 

2 Use the following buttons to specify the way the hole is extended 
or limited: 

 - If selected, the hole cuts all the way through the solid. On 
the screen, the length of the hole extends beyond the solid. 
Safety margins are drawn at both ends of the hole. 

 

 - If selected, the length of a hole that is longer than the 
thickness of the solid is limited to that thickness. If deselected, 
the length of a hole is not limited. 
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 limits the length of the through hole to the final forward 
intersection. If you want to limit the length of the through hole to 
the first intersection, click  to display . 

 limits the backward length of the hole to the final intersection. 
If you want to limit the length of the backward hole to the first 
intersection, click  to display  . 

3 Use the following buttons to specify how the depth is measured 
and the end of the hole: 

 - If selected, the depth of the hole is measured to the 
shoulder of the hole. If deselected, the depth of the hole will be 
measured to the tip of the cone. If this button is selected, the 
Display the end of the hole  button becomes inactive. 

 - If selected, a cone will be displayed at the end of the hole.  

 
If  is displayed, chamfers are added to the hole sections as 
defined in the Chamfer Hole dialog (see page 165). Click  
to display the Chamfer Hole dialog (see page 165). 

If no chamfers are required, click . This removes  and no 
chamfer  is displayed.  

4 Use the following option to specify the safety margin: 

 - If selected, safety margins are set to an automatically 
generated value that is large enough to ensure that the hole 
completely passes through any surface intersections. The offset 
safety distance text box is inactive. If deselected, set the offset 
safety distance manually. 
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The safety margin is the length above the hole which ensures 
that the hole cuts into the solid . If you can see that the safety 
margin lies inside the solid, increase it. 

 
In the figure below, the safety margin lies inside the solid . 

 
The safety margin value is increased so that it lies outside the 
solid . 

 
5 Use to lock and unlock the depth and the diameter.  

 indicates that the dimension is locked. Click to unlock. 

 indicates that the dimension is unlocked. Click to lock. 
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 If the depth is locked, the depth of the hole does not change 
when the whole solid is uniformly scaled from the Edit toolbar. 
If the depth is unlocked, the depth is scaled too. 

 

 Unscaled solid shows the original depth. 

 Scaled solid with locked depth shows the original depth. 

 Scaled solid with unlocked depth shows the scaled depth. 

If you non-uniformly scale the solid or define the depth of the 
hole using parameters, the depth will not be scaled regardless 
of whether it is locked or unlocked. 

 If the diameter is locked, the diameter of the hole does not 
change when the whole solid is uniformly scaled from the Edit 
toolbar. If the diameter is unlocked, the diameter is scaled 
too. 

 

 Unscaled solid shows the original diameter 

 Scaled solid with locked diameter has original diameter 

 Scaled solid with unlocked diameter has scaled diameter 

If you non-uniformly scale the solid or define the diameter of 
the hole using parameters, the diameter will not be scaled 
regardless of whether it is locked or unlocked. 
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Tapped holes 
If the hole is tapped, the Tapping options are displayed. 

 
1 Select the Standard from the drop-down list. 

2 Specify the Size in one of the following ways: 

 Select the size from the drop-down list. The size of the pre-
defined tapped holes correspond to a drill size in the 
appropriate units. 

 Select User Defined from the Standard menu and enter your 
own values in the dimension boxes. 

 Use a parameter to define the diameter of a tapped hole. The 
hole is set to the tapping size that is closest to the value of 
the parameter. 

 

Counterbored holes 
Use the Standard Dimensions section for Counterbored holes to set 
the dimensions to match standards that fit screw sizes easily.  
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Countersunk holes 
If you are using countersunk hole, there are additional options to 
define the countersink angle and diameter.  

 

 - This option toggles between  and . 

If  is displayed, the hole has a user-defined countersink angle. 
You can change the angle of the countersink by entering a 
different value for the angle of the countersink cone. 

 
The diagrams below show the effect of entering different angles 
for the countersink, whilst keeping the other values constant. 

  
You can also change the maximum diameter of the countersink 
by entering a different value as shown below. 

 

If  is displayed, the hole has a fixed 45 degree countersink 
angle and the option to define the maximum diameter of the 
countersink is not available. You set the size of the countersink 
by entering countersink size in the adjoining box. 
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 - This option toggles between  and . 

If  is displayed, the safety margin is projected out of the hole 
at  the countersink angle. 

 

If  is displayed, the safety margin is projected straight out of 
the hole. 

 
 

Plane Details dialog 
This sets the plane details on the hole. 

 

1 Click  displays the Solid Feature Relationship dialog. This lets 
you define the relative position of the hole with respect to the 

solid. A cross  is displayed by default. A tick  is displayed if a 
valid relationship is defined. 
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2 Select Display Plane to display the workplane handles on the 
hole. 

 
3 Select Align hole with ...to rotate the hole to match the selected 

alignment option: 

 aligns hole to the solid face.  

 aligns hole to the active workplane.  

4 Click  to reverse the hole direction and origin to the 
opposite side of the solid. 

5 Use the Plane options to: 

 Move the origin of the hole. Enter the X Y Z coordinates or 
click the Position  button to open the Position dialog where 
you can use position entry tools. 

 Change the direction of its axis (Axis settings) 

 Twist it about its axis (Twist settings) 

6 Click one of the following: 

 OK to set the plane details for the hole and close the dialog. 

 Cancel to ignore any changes made to the plane and close the 
dialog. 

 



 

164 • Solid modelling PowerSHAPE 2015 R2 Reference Help  

Hole Use dialog 
This dialog is used to create and edit hole uses. It is displayed by 
clicking Create on the Holes page of the Options dialog. 

 
1 Enter a Name for the hole use. The name must not already exist 

within the selected category. 

2 Enter the name of a Category. You can select an existing 
category or enter in a new name. 

3 Define the Template using the Category and Use drop-down lists 
to select an existing hole use. This hole use is used to set the 
values (mainly the tolerances) for the rest of the dialog. 

4 Change the settings on the remaining options to define the new 
hole use. 
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Chamfer Hole dialog 
Use this dialog to define the chamfer angle and size for a hole. 

 
 and  - Enter size of the chamfers on the hole. If Use same size 

for all chamfers is ON, every chamfer added to the hole will be set to 
the same size. 

 and  - Enter the angle of chamfers on the hole. If Use same 
angle for all chamfers is ON, every chamfer added to the hole will be 
set at the same angle to the hole. 

 - Click on to indicate that there is no base chamfer on the hole. 
 changes to  and the base chamfer options are hidden. 

 - Click on to indicate that there is no through chamfer on the 
hole.  changes to  and the through chamfer options are hidden. 
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Use same size for all chamfers - If ON, every chamfer added to the 
hole will be set to the same size. If OFF, you can define different 
chamfer sizes for the hole base and the through hole, by entering 
different values in  and . The example below shows a chamfer 
size of 3 for the hole base and 0.5 for the through hole 

 
Use same angle for all chamfers - If ON, every chamfer added to the 
hole will be set at the same angle to the hole. If OFF, you can define 
different chamfer angles for the hole base and the through hole by 
entering different values in  and . The example below shows a 
chamfer angle 20 for the hole base and 45 for the through hole. 

 
 

Editing a solid hole 
You can edit the dimensions of the hole or change to another hole 
type using the Plain Hole dialog (see page 154). 

1 Open the dialog in one of the following ways: 
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 Double-click the Hole feature icon  in the tree. 

 Double-click the hole on the model. 

2 Use the Plain Hole dialog to edit the hole. 

You can also simultaneously edit multiple holes (see page 247). 
 

Creating a hollow solid 
When creating a hollow solid (often called a 'shell' solid because the 
thin wall is like a shell), faces of a solid are removed and copies of 
the other faces are thickened to create a solid wall. 

 
To create a hollow solid: 

1 Click  (Solid feature toolbar). 

 
2 Use the dialog to create the hollow solid. 
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Hollow Solid dialog 
This dialog removes a face of a solid and offsets it to create a hollow 
solid. 

 
Removal face selected — This indicates if you have selected any 
faces to remove. To select a removal face: 

1 Move the cursor over a solid. 

Valid faces are highlighted. 

 
2 Click the face of the solid you want to remove. The cross 

changes to a tick and the face is highlighted. 
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You can select multiple removal faces. You can use either 
Ctrl+click or Shift+click to add and remove faces from the 
selection. 

 
Wall Thickness — This enables you to set the thickness of the faces 
in the hollow solid. 

All faces — If on, all the faces in the solid offset uniformly using 
the value in data box. 
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Individual faces — This allows you to have a different wall 
thickness value for each face. 

 
Select this option, then click Set to display the Individual Wall 
Thickness dialog. 

Offset Inwards — If ON, faces are offset inwards , otherwise they 
are offset outwards . 
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Fillet Edges — You can make corners rounded by switching this 
option on, if faces are offset outwards each face has the same offset 
value 

 
OK — Creates the hollow solid as defined and removes the dialog 
from the screen. A Hollow feature icon  representing the operation 
is displayed in the solid feature tree. 

Cancel — Closes the dialog without operating on the solid. 
 

Individual Wall Thickness dialog 
This is used to change the wall thickness of an individual face. 

 
1 Select a face from the Select face drop-down list. 

You can also select a face by clicking on its surface rather than 
its edge. The face nearest to you is selected and highlighted. Its 
name is displayed in this data box. 

 All faces, which are tangent continuous to each other, are 
highlighted when one of them is selected. They all have the 
same wall thickness. 

2 Enter a Wall thickness for the selected face. 
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The offset value of each face is listed in the scrolling list . 

3 Click one of the following buttons: 

 OK to set the wall thickness values of the faces and removes 
the dialog from the screen. You are returned to the Hollow 
Solid dialog. 

 Cancel to close the dialog without changing the wall thickness 
values of the faces. 

 

Editing a hollow 
You can edit the wall thickness of the hollow feature. 

1 Double-click the Hollow feature icon  in the tree to display the 
Hollow Solid dialog. 

2 Use the dialog to edit the hollow. 

 
This is a modified version of the Hollow Solid dialog used to 
create the hollow. 

 

Thickness of a hollow solid 
You can find the wall thickness of a hollow solid by selecting Solid 
Wall thickness from Tools > Model Analysis. This displays the Wall 
thickness dialog (see page 173) so that you can define a series of 
sections relative to the active workplane. 
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Wall thickness dialog 
Use this dialog to define a series of sections relative to the active 
workplane. 

 
1 Enter the Distance of the section along the current axis 

2 Use the following options to define Multiple Sections: 
Number of sections — Number of sections to create. 

Section gap — Gap between sections. 

Display minimum section only — The input box displays the 
minimum thickness. If the option is selected, only the section 
with the minimum thickness will be displayed. 

Display maximum section only — The input box displays the 
maximum thickness. If the option is selected, only the section 
with the maximum thickness will be displayed. 

3 Select Create wireframe to keep the sections with the 
minimum/maximum thickness as wireframe dimension after 
selecting Apply or OK. 

4 Select Keep label to keep the labels on the sections with the 
minimum/maximum thickness as a dimension after selecting 
Apply or OK. 

5 Click one of the following: 

 Apply to apply the wall thickness parameters; the smallest 
thickness is marked with arrows and a text label and the 
dialog continues to be displayed. 

 OK to accept the smallest thickness is marked with arrows 
and a text label and close the dialog. 
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Creating a thickened solid 
You can apply thickness to an open , flattish solid to create a 
closed solid . 

 
The opposite face of the closed solid is created by offsetting the 
open face. 

To create a thickened solid: 

1 Select an open solid. 

2 Click  (Solid feature toolbar). 

 
3 Use the Thicken Solid (see page 174) dialog to control how the 

solid is thickened. 

4 Click OK to close the dialog and thicken the solid. 
 

Thicken Solid dialog 
The Thicken Solid dialog is used to thicken an open solid and create 
a closed solid. 
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Thickness of solid — This is measured from the inside of the solid, 
along the negative axis of the surface normal. 

 
Reverse — The thickness is measured from the outside of the solid. 

 
Round corners — This makes the corners round in the new face of 
the thicken solid. 

 
OK — Creates a thickness on the solid. A Thicken feature icon  
representing the operation appears in the solid feature tree. 

 

 When you thicken a solid, any unused large holes are filled. 
 

Editing a thickened solid 
You can edit the thickness of the thicken feature. 
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1 Double-click the Thicken feature icon  in the tree to display the 
Thicken Solid dialog. 

The solid is displayed on the screen without its thickness. 

 
2 Use the Thicken Solid dialog (see page 174) to edit the 

thickness. 

 
 

Creating a solid bulge 
You can create a bulge using wireframe to wrap a solid. 

 
The wireframe is projected onto the solid, along the surface normal 
of the solid. The solid is then bulged in the area enclosed by the 
wireframe. 

Create a solid bulge using one of the following methods: 
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Using an active solid 

1 Make sure you have an active solid . 

 
2 Select one closed wireframe object . 

 

3 Click  (Solid feature toolbar). 

 
4 Use the Bulge dialog (see page 178) to add a bulge onto the 

solid using the wireframe object. 

  

Using an inactive solid 
1 Drag your cursor to select an inactive solid and the closed 

wireframe. 
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2 Click  (Solid feature toolbar). 

 
3 Use the Bulge dialog (see page 178) to add a bulge onto the 

solid using the wireframe object. 
 

Bulge dialog 
Creates a bulge on an active, or pre-selected inactive, solid using 
wireframe. 

 
1 Enter an Angle . This angle defines the amount the bulge lifts 

from the solid. 

2 Select Invert to invert the bulge into the solid. 

 
3 Wireframe selected — The wireframe defines the outline of the 

bulge on the solid. When a wireframe object is selected, a tick is 
shown. 

4 Click one of the following: 

 Preview to display the bulge on the solid using the selected 
wireframe. You can change the settings on the dialog or the 
selected wireframe until you are satisfied with the previewed 
solid. 
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 Apply to create a bulge in the solid. The dialog remains on the 
screen for you to select more wireframe and continue creating 
bulges. A Bulge feature icon  representing the operation 
appears in the solid feature tree. 

 
 Dismiss to close the dialog. 

 

Editing a bulge feature 
Edit the bulge feature as follows: 

1 Double-click the Bulge feature icon  in the tree to display the 
Edit Solid Bulge dialog. 

2 Use the dialog to edit the bulge. 

 
This is a modified version of the Bulge dialog (see page 178) 
used to create the bulge. 
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Creating a solid fillet 
You can create fillets on the edges of a solid. 

 
To create a solid fillet: 

1 Click  (Solid feature toolbar). 

 
If your solid contains more than 20 surfaces and is not 
watertight, you are asked if you want to make it watertight. If 
you say yes, the Solid Doctor is displayed to help you make the 
solid watertight (within tolerance). 

2 Use the Fillet dialog (see page 184) to create fillets on the solid. 
 

Selecting the solid fillet route 
Solid filleting uses the dominant face (the one under the cursor) to 
allow more intelligent picking when filleting the face of a solid. 
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If you are working in wireframe view, you can hover the cursor over 
the edges of the solid to find out the ones that can be used to 
create a fillet. If an edge or a path of edges highlights, it can be 
used. Otherwise, it cannot. 

If one of the options Follow Continuous Edges, Fillet a Face or Fillet 
Away From a Face are on and you hover over a valid edge, a path 
may highlight. Otherwise, only the single edge highlights. Full 
details on these three options are given below. 

You can select, append or de-select edges to an existing path as 
follows: 

  selects an edge or a path. If a path is already selected, it is 
de-selected and a new one is started. 

The selected edge is highlighted. This is the first edge in the 
path. 

 
 You can select any number of independent tracks. 

is used to add a track to the current selection. 

is a toggle to add/remove tracks from the current selection. 

 may also be used to join separate tracks into a single track 
and to split a single track into two separate tracks. 

If the Follow Continuous Edges option is on and you  or  
the selected path, the whole path is de-selected. 
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In the example below, deselect the Follow Continuous Edges 

option and select an edge at the end of the path using . 

 
The edge is now highlighted as part of the path. 

 

Now  this edge. 
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This removes the edge from the path and we are left with the 
following. 

 
Mixed single path filleting - You can fillet a path that involves both 

concave and convex fillets. Use  to select the edges to be 
filleted and click Apply. 

 
 Branch path filleting - You can fillet a path that has branches. The 

branches can be any combination of concave and convex. Use 

 to select the edges on longest path first followed by the 
edges on the branches.  
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 Creation of several separate fillets at once - You can create several 
separate fillets at the same time. The fillets can be a combination 
of concave and convex. 

 Parameterised filleting - You can use a parameter instead of a 
value to fillet a group of independent tracks. All the 
parameterised tracks will appear as separate, editable features in 
the tree. 

As with all current multiple fillet track functionality, using a 
parameter will parameterise all of the tracks, and all fillets 
appear as separate editable features in the tree. 

 

Fillet dialog 
This dialog is used to fillet edges on a solid. 

 
Radius — Enter the radius of the fillet. 

Selecting filleting routes 
Follow Continuous Edges — If this option is selected and you hover 
over a valid edge before a path is selected, a path is highlighted 
which contains that edge and all edges which are tangent 
continuous with that edge. 

When you select an edge, a new fillet path is selected containing 
that edge and all edges that are tangent continuous with that edge. 
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If you select Follow Continuous Edges and the edge , the fillet 
path  is selected. 

 
Fillet A Face —- If this option is selected and you hover over a valid 
edge (before a path is selected), a path is highlighted containing all 
edges of a face of the solid which contains that edge. 

When you select an edge, a new fillet path is selected containing all 
edges of a face of the solid that contains that edge. 

If you select Fillet a Face and the edge , the fillet path  is 
selected. 
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Fillet Away From A Face — With this option selected, selecting a face 
on the model  all the edges that will be filleted are highlighted. The 
highlighted path will be filleted when you click Apply. 

 
If required, this option can be used in combination with Follow 
Continuous Edges. 

Always extend faces — If this option is deselected, a fillet may 
partially overlap additional non-tangential geometry, giving an 
imperfect fillet. Select Always extend faces to maintain the fillet 
radius. An example of using this option is shown in Example 7 (see 
page 205). 

Creating a variable fillet 
Use the Variable option to edit the radius along the last fillet 
created. This option is only available once you have clicked Apply to 
create a fillet.  

 If you have only selected the fillet path, but not created the 
fillet yet, you can select the Advanced button to create a 
variable radius fillet using the Variable Radius Fillet dialog (see 
page 196).  

1 Create a fillet and click Apply. 
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2 Select Variable. The route of the fillet is displayed. 

 

 If you have a closed fillet, this option will remain deselected 
until you insert an arc. 

3 Click a position on the fillet to insert an arc that is used to define 
the radius of the fillet at that point on the fillet path. The inital 
radius of the arc is Radius value. 

 
4 Change the radius of the selected arc by: 

 dragging the arc 
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 entering a new Radius value. 

 
To select an arc on the fillet, click the arc. 

To delete the selected arc, select Delete.  

 End arcs cannot be deleted. 

5 Click Apply to update the fillet. 

 
6 Continue to edit the fillet or select another fillet path.  

Adding neighbouring surfaces 
 If a fillet cannot be created because it spreads onto neighbouring 

surfaces, select Add Adjacent Continuous Faces. 
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 The fillet will not spread beyond the neighbouring surfaces, so 
you cannot create a fillet at position .  

 
To spread the fillet beyond onto all surfaces, use the Add All 
Continuous Faces option.This option will allow you to create the 
fillet onto the continuous surfaces . 

 
 Select Add All Continuous Faces when you need the fillet to 

spread onto all surfaces that are tangent plane continuous. 

This option may be much slower when creating fillets. We 
recommend you use the Add Adjacent Continuous Faces if you 
recognise that a fillet will not spread beyond its neighbouring 
surfaces. When you have finished using this option, we advise 
you to turn it off. 

Corners and Sections 
 Click Mitre all corners to create a fillet with mitred corners or to 

redefine the fillet to have mitred corners.  
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With Mitre all corners deselected: 

 
With Mitre all corners selected: 
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 Click Constant width to create a fillet that has a constant width. 
When this option is selected, the distance between the edges of 
the fillet is always the same. 

 

Cross-sectional shape 
Select a Cross-sectional shape from the drop-down list to change the 
shape of the cross-section of the fillet. 

 
The option that you use depends on your model; choose the option 
that gives the smoothest fillet for your model. 
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 Circular — This is the default cross-sectional shape. It can give a 
slight change of curvature where the fillet meets another curved 
edge. 
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 Parabolic — Select this option to create a fillet with parabolic 
sections. 
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 Curvature continuous - This option creates a fillet without the 
sharp change in curvature that is created using the Circular 
option. Sections of the fillet are not circular; the curvature varies 
continously as the blend is created between the adjoining faces. 

 

 — Undo / Redo a fillet. The normal undo behaviour has been 
retained once the dialog is removed from the screen. That is, 

selecting  Undo from the main toolbar immediately after 
creating a fillet or group of fillets will remove all the fillets that were 
created. 

Apply — Creates a fillet along the selected path and the dialog 
remains open. This also applies any changes you make to the last 
fillet created. A Fillet feature icon  representing the operation 
appears in the solid feature tree. 

 lets you swap between creation mode and editing mode without 
closing/reopening the dialog.  

 When in creation mode, click  to swap to editing mode. 
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 When in editing mode, click  to swap to creation mode. 

Using the creation/edit mode button in association with Apply lets 
you create and edit any number of fillets without closing the 
dialog. It is therefore possible to:complete the following 
sequence: 

1 Create several fillets 

2 Select edit mode  

3 Select any editable fillet 

4 Modify the fillet by changing its properties 

5 Apply the changes 

6 Select and edit another fillet 

7 Apply the changes 

8 Enter creation mode 

9 Create another fillet 

Advanced — While a path is selected, click Advanced to create a 
variable radius fillet using the Variable Radius Fillet dialog (see page 
196). Use this dialog to insert arcs along the path to define the 
different radius values. 

OK — Closes the dialog. 
 

Editing a solid fillet during creation 
Use the Fillet dialog to edit a fillet.  

 Remember that you can keep editing the fillet after you click 
the Apply button. 

To edit the radius of a fillet with constant radius: 
1 Enter a new value in the Radius box. 

2 Click Apply. 

To make a fillet with constant radius into one with a variable radius: 
1 Click the Variable button. 

2 See the Variable option for details on how to insert new radius 
values along the fillet. 

3 Click Apply. 

To make a fillet with variable radius into one with a constant radius: 
1 Turn off the Variable option. 
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2 Enter the new radius value in the Radius box. 

3 Click Apply. 

To change the radius of a fillet with variable radius: 
1 Keep editing the radius by inserting arcs along the fillet. 

2 Click Apply. 
 

Variable Radius Fillet dialog 
Use the options on this dialog to insert arcs along the fillet and 
allows you to edit their radius values. It also sets how the radius 
varies from one arc to another.  

 Display the dialog by clicking the Advanced button on the 
Fillet dialog. 

 

Specifying the Current Arc  
Use the drop-down lists and a text box to specify the Current Arc as 
follows: 

1 The first drop-down list box displays the selected fillet arc. You 
can use this drop-down list box to select existing fillet arcs. To 
find the number of an existing arc, simply select the arc in 
graphics window. Its number is displayed in this drop-down list 
box. 

2 Use the second drop-down list box and text box to enter new 
fillet arcs as follows: 

a Select one of the following options from the second drop-
down list box to determine where to input the new fillet arc: 

ABS - A new arc is inserted along the fillet at a distance from 
the first fillet arc. 

REL - A fillet arc is inserted along the fillet at a distance from 
the selected fillet arc in the first drop-down list box. 

PAR - A new arc is input at a parametric distance between 
two existing arcs. For example, a parametric distance of 3.5 
inserts an arc half way between arcs 3 and 4. 
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3 Enter a distance in the text box and press Enter to enter a new 
fillet arc. The fillet arcs are also relabelled. You can also click a 
position on the fillet route to enter a new arc. 

If you hover the intelligent cursor over the fillet route, a distance is 
displayed. The option selected in the second drop-down list box will 
determine what the value means. For example if ABS is selected, 
the value is the absolute distance along the fillet route. 

Delete - This deletes the selected arc.  

 End arcs cannot be deleted. 

Specifying the Arc Radius  
The Arc Radius option displays the radius of the selected arc. You 
can change its value by 

 entering a new value. 

 dragging the arc on the screen to the required value. 

Specifying the Law  
The Law option displays the variation of the radius at the current 
arc position. Use the Law option to indicate how you want to vary 
the fillet radius at the selected arc. 

There are three ways of varying the arc: 

 Free 

 Horizontal 

 Sharp. 

Free — the radius varies freely from the arc and then takes on the 
conditions of the neighbouring arc. 
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Horizontal — the radius remains constant for a short distance away 
from the arc and then takes on the conditions dictated by the 
neighbouring arc. 

 
Sharp — the radius changes size quickly as soon as it leaves the arc 
and then takes on the conditions dictated by the neighbouring arc. 

 
The Law option has nine selections, where the first word dictates 
how the radius varies as it enters an arc and the second how it 
leaves an arc. 

 - Free-Free 

 - Free-Horizontal 

 - Free-Sharp 

 - Horizontal-Horizontal 

 - Horizontal-Free 

 - Horizontal-Sharp 

 - Sharp-Sharp 

 - Sharp-Free 

 - Sharp Horizontal 

OK — This creates the variable radius fillet and takes you back to 
the Fillet dialog (see page 184). 
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Cancel — The fillet is not created and you return to the Fillet dialog. 
The path is still selected. 

 

Editing a solid fillet 
You can edit an existing fillet or edit multiple fillets (see page 247). 

To edit a fillet: 

1 Double-click the Fillet feature icon  in the tree to display the 
Edit Solid Fillet dialog. 

 
2 Use the dialog to edit the fillet, you can: 

 Change a variable radius fillet to a constant one. Deselect the 
Variable option and enter a new value in the Radius box . 

 Change a constant radius fillet to a variable one. Select 
Advanced to display the Variable Radius Fillet dialog or select 
the Variable option and insert new radius values along the 
fillet. 

 Edit the path of the fillet. Select Fillet Path Editing to highlight 
the original path of the fillet. Adjust the existing path or 
create a totally new one. 

 Edit the fillet to have a constant width by toggling the 
Constant Width option. 

 Select a new Cross-sectional shape. 

 Select a new path for the fillet as if creating a new fillet. 
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Some filleting examples 
'Rolling-ball' filleting is used when generating fillets would otherwise 
be inaccurate. The examples shown here illustrate different cases 
where this methodology has been automatically incorporated into 
the generation of fillets. In every case, the fillet on the updated 
model has been created using the Fillet option on the solid menu. 

Example 1 - Filleting side walls with cut-outs (see page 200) 

Example 2 - Filleting a face with a hole (see page 201) 

Example 3 - 'Rolling ball' technique (see page 202) 

Example 4 - Filleting two blocks (see page 203) 

Example 5 - Maintaining the fillet curvature (see page 203) 

Example 6 - Flexibility of the 'Rolling ball' technique (see page 
204) 

Example 7 - Using Always Extend Faces (see page 205) 
 

Example 1 - Filleting side walls with cut-outs 
In this model, a fillet of 20 is added. The cut-outs intersect with the 
fillet, maintaining the fillet curvature throughout. 

 

 
Looking at the wireframe view below, you can see that the fillet is 
carried right up the side walls of the block. 
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Example 2 - Filleting a face with a hole 
The model below shows two blocks with a hole in the middle of one 
block face. If you add fillet of 25 as shown, the hole is extended to 
maintain the curvature of the fillet, as shown in the wireframe 
version . 
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Example 3 - 'Rolling ball' technique 
Use 'rolling-ball' filleting to produce fillets like the one shown on the 
model below. 

 
A fillet of 15 has been added at the intersection of the block and the 
cylinder. The important things to note about this fillet are: 

1 The smooth end caps, where the surface of the fillet is curved to 
match the radius of the cylindrical part of the solid. 

 
The bottom of the fillet is tangential to the cylindrical part of the 
solid and the top of the fillet touches the edge of the block at an 
angle. 

 
 



 

PowerSHAPE 2015 R2 Reference Help Solid modelling • 203  

Example 4 - Filleting two blocks 
In this model, a fillet of 18 has been created all the way round the 
top block. The bottom of the fillet that is created is tangential to the 
bottom block and the top of the fillet touches the edge of the top 
block at an angle. 

 
 

Example 5 - Maintaining the fillet curvature 
On the original model, the edge of the fillet of 4.8 touches the sides 
of the block. You can increase the existing fillet radius to 15. Again, 
the fillet curvature has been maintained by extending and re-
intersecting surfaces. 
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Example 6 - Flexibility of the 'Rolling ball' technique 
This example illustrates the flexibility that the 'rolling ball' technique 
provides. 

 
Each of the models below shows the effect of a different radius. The 
numbers in red are the radius of the fillet that was used to produce 
the model. Note how the edge of the block is modified so that the 
filleting is smooth at the intersection between the block and the 
fillet. 
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Example 7 - Using Always Extend Faces 
This example illustrates the use of Always Extend Faces to maintain 
the fillet radius. 

In this example, a fillet partially overlaps additional non-tangential 
geometry, giving an imperfect fillet.  
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Select Always Extend Faces to maintain the fillet radius. 

 
 

Creating a solid chamfer 
You can create chamfers on the edges of a solid. 

 
To create a solid chamfer: 
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1 Click  (Solid feature toolbar). 

 
If your version 8 solid contains more than 20 surfaces and is not 
watertight, you are asked if you want to make it watertight. If 
you say Yes, the Make Watertight Wizard (see page 295) appears 
to help you make the solid watertight (within tolerance). 

2 Use the Chamfer dialog (see page 207) to create chamfers on the 
solid. 

 

Chamfer dialog 
This dialog is used to chamfer edges on a solid. 
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Enter the Distance to be used to create the chamfer as shown 
below. 

 
 Chamfer. 

 Distance. 

 Arc with radius equal to distance. 

Selecting the chamfering route 
Follow continuous edges - If this option selected and you hover over 
a valid edge, before a path is selected, a path is highlighted which 
contains that edge and all edges which are tangent continuous with 
that edge. 

If you select an edge, a new path is selected containing that edge 
and all edges which are tangent continuous with that edge. 

The edge shown below is selected. 
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The following path is selected. 

 
Chamfer a face — If this option is selected and you hover over a 
valid edge, before a path is selected, a path is highlighted 
containing all edges of a face of the solid which contains that edge. 

If you select an edge, a new path is selected containing all edges of 
a face of the solid which contains that edge. 

The edge shown below is selected. 

 
The following path of face edges is selected. 
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Chamfer Away From A Face — With this option selected, selecting a 
face on the model will cause all the edges that will be chamfered to 
be highlighted. The highlighted tracks will be chamfered when you 
click Apply. 

 
Variable — This option is only available once you have clicked Apply 
to create a chamfer (see page 217). If you have only selected the 
path, but not created the chamfer, you can select the Advanced 
button to create a variable distance chamfer (see page 215).  

Add adjacent continuous faces — If a chamfer cannot be created 
because it spreads onto neighbouring surfaces, turn this option on. 

The chamfer will not spread beyond the neighbouring surfaces. To 
spread the chamfer beyond onto all surfaces, use the Add all 
continuous faces option. 
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This option will allow you to create the chamfer onto the continuous 
surfaces. 

 
Add all continuous faces — This is the same as the Add adjacent 
continuous faces, except the chamfer can spread onto all surfaces 
that are tangent plane continuous. 

This option may be much slower when creating chamfers. We 
recommend you use the Add adjacent continuous faces if you 
recognise that a chamfer will not spread beyond its neighbouring 
surfaces. 

If you have finished using this option and it is no longer needed, we 
advise you to turn it off. 

Constant width — When you create a chamfer, the width of the 
chamfer varies to reflect the angle between the surrounding faces. 
Select Constant width to create a constant width for a chamfer. 

 — Undo / Redo a chamfer. The normal undo behaviour has 
been retained once the dialog is removed from the screen. That is, 

selecting  Undo from the main toolbar immediately after 
creating a chamfer or group of chamfers will remove all the 
chamfers that were created. 

Apply — Creates a chamfer along the selected path. The dialog 
remains on the screen for you to select more edges and continue 
creating chamfers. 

A Chamfer feature icon  representing the operation appears in the 
solid feature tree. 

You can now either edit the distance of the chamfer just created or 
select more edges to create another chamfer. 
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Advanced —- While a path is selected, you can create a variable 
distance chamfer. Click this button to display the Variable Distance 
Chamfer dialog. Use this dialog to insert lines along the path to 
define the different distance values. 

OK — Removes the dialog from the screen. 
 

Selecting the solid chamfer route 
If you are working in wireframe view, you can hover the intelligent 
cursor over the edges to discover which ones can be used to create 
a chamfer. If an edge or a path is highlighted, you can use it. 

 
If one of the options Follow Continuous Edges, Chamfer a Face or 
Chamfer Away From A Face are selected and you hover over a valid 
edge, a path may highlight. Otherwise, only the single edge 
highlights. Full details on these options are given below. 

You can select, append, or de-select edges to an existing path as 
follows: 

 A single click selects an edge or a path. If a path is already 
selected, it is de-selected and a new one is started. 

The selected edge is highlighted. This is the first edge in the 
path. 
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 You can select any number of independent tracks. 

Press and hold the Shift key and click to add a track to the 
current selection. 

Press and hold the Ctrl key and click to add/remove tracks from 
the current selection. You can also use Ctrl+click to join separate 
tracks into a single track and to split a single track into two 
separate tracks. 

If the Follow Continuous Edges option is selected and you use 
Shift+click or Ctrl+click on the selected path, the whole path is 
de-selected. 

In the example, deselect the Follow Continuous Edges option and 
select an edge at the end of the path using Shift+click. 

 
The edge is now highlighted as part of the path. 
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Now Ctrl+click the edge again. 

 
This removes the edge from the path and we are left with the 
following. 

 
 Creation of several separate chamfers at once — You can now 

create several separate chamfers at the same time. The tracks to 
be chamfered must be independent, but they can be a 
combination of concave and convex. 

 Parameterised chamfering — You can use a parameter instead of a 
value to chamfer a group of independent tracks. All the 
parameterised tracks are displayed as separate, editable features 
in the tree. 

As with all current multiple chamfer track functionality, using a 
parameter will parameterise all of the tracks and all chamfers 
appear as separate editable features in the tree. 
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Variable Distance Chamfer dialog 
Use this dialog to inserts lines along the chamfer and edit the length 
values. This also determines how the width of the chamfer varies 
from one line to another. 

 
Current Line - This has two drop-down lists and a text box. 

The first drop-down list displays the selected line. You can use this 
to select existing lines. To find the number of an existing line, select 
the line in graphics window. Its number is displayed in this drop-
down list box. 

Use the second drop-down list and text box to enter new lines as 
follows: 

1 Select one of the following options from the second drop-down 
list to determine where to input the new line: 

ABS — A new line is inserted along the chamfer at a distance 
from the first line. 

REL — A line is inserted along the chamfer at a distance from the 
selected line in the first drop-down list box. 

PAR — A new line is input at a parametric distance between two 
existing lines. For example, a parametric distance of 3.5 inserts a 
line half way between lines 3 and 4. 

2 Enter a distance in the text box and press Enter to specify a new 
line. Alternatively, click a position on the chamfer route to enter 
a new line.The lines are relabelled. 

If you hover the intelligent cursor over the chamfer route, a 
distance is displayed. The option selected in the second drop-down 
list box will determine what the value means. For example if ABS is 
selected, the value is the absolute distance along the chamfer route. 

Delete — This deletes the selected line. Note that end lines cannot 
be deleted. 

Line distance — This displays the distance of the selected line. You 
can change its value by 

 entering a new value 

 dragging the line on the screen to the required value 
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Law — This displays the variation of the distance at the current line 
position. The Law options use one of the following variation 
methods for the distance at the selected line. 

 Free — The distance varies freely from the line and then takes on 
the conditions of the neighbouring line. 

 
 Horizontal — The distance remains constant for a short distance 

from the line and then takes on the conditions of the 
neighbouring line. 

 
 Sharp — The distance changes size as soon as it leaves the line 

and then takes on the conditions of the neighbouring line. 

 
The Law option uses a combination of the distance methods to 
define nine options. The first word specifies how the distance varies 
as it enters a line; the second word specifies how the distance 
varies as it leaves a line: 
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 — Free Free 

 — Free Horizontal 

 — Free Sharp 

 — Horizontal Horizontal 

 — Horizontal Free 

 — Horizontal Sharp 

 — Sharp Sharp 

 — Sharp Free 

 - Sharp Horizontal 

OK — This creates the variable distance chamfer and takes you 
back to the Chamfer dialog. 

Cancel — The chamfer is not created and you return to the Chamfer 
dialog. The path is still selected. 

 

Creating a variable chamfer 
The Variable option is only available once you have clicked Apply to 
create a chamfer. If you have only selected the path, but not 
created the chamfer yet, you can select the Advanced button to 
create a variable distance chamfer. If you select this option, you can 
now edit the distance along the last chamfer created. 

1 Create a chamfer and click Apply. 

2 Select Variable. The route of the chamfer is now displayed. 
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 If you have a closed chamfer, then this option will remain 
deselected until you insert a line. 

3 Insert new distance values along the chamfer by clicking a 
position on the chamfer to insert a line. This line uses the 
Distance value that is specified in the Chamfer dialog. 

 
To change the distance of the selected line, drag the line or enter 
a Distance value. 

 
To delete the selected line, press Delete. End lines cannot be 
deleted. 

To select a line on the chamfer, simply click it. 
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4 Click Apply to update the chamfer. 

 
You can continue to edit the chamfer if you want or select 
another chamfer path. 

Add Adjacent Continuous Faces — If a chamfer cannot be created 
because it spreads onto neighbouring surfaces, turn this option on. 

The chamfer will not spread beyond the neighbouring surfaces. To 
spread the chamfer beyond onto all surfaces, use the Add All 
Continuous Faces option. 
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This option will allow you to create the chamfer onto the continuous 
surfaces. 

 
Add All Continuous Faces - This is the same as the Add Adjacent 
Continuous Faces, except the chamfer can spread onto all surfaces 
that are tangent plane continuous. 

This option may be much slower when creating chamfers. We 
recommend you use the Add Adjacent Continuous Faces if you 
recognise that a chamfer will not spread beyond its neighbouring 
surfaces. 

If you have finished using this option and it is no longer needed, we 
advise you to turn it off. 

 — Undo / Redo a chamfer. The normal undo behaviour has 
been retained once the dialog is removed from the screen. So, 

selecting  Undo from the main toolbar immediately after 
creating a chamfer or group of chamfers will remove all the 
chamfers that were created. 

Apply — Creates a chamfer along the selected path. The dialog 
remains on the screen for you to select more edges and continue 
creating chamfers. 

A Chamfer feature icon  is added to the solid feature tree to 
represent the chamfer opertaion. 

You can now either edit the distance of the chamfer just created or 
select more edges to create another chamfer. 

Advanced — While a path is selected, you can create a variable 
distance chamfer. Click this button to display the Variable Distance 
Chamfer dialog. Use this dialog to insert lines along the path to 
define the different distance values. 



 

PowerSHAPE 2015 R2 Reference Help Solid modelling • 221  

OK — Removes the dialog from the screen. 
 

Creating a chamfer using a single distance 
1 Click . 

2 Enter the Distance to be used to create the chamfer as shown 
below. 

 
 Chamfer. 

 Distance. 

 Arc with radius equal to distance. 

3 Select an edge of a solid. 

4 Click Apply to create a chamfer with a single distance and a 
radius of 45 . The chamfer on the following model was created 
by entering a Distance of 15. 

 
 

 

Creating a chamfer using two distances 
1 Click   

2 Enter a value for Distance. 
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3 Enter a value for Distance 2. 

4 Select an edge of a solid. 

5 Click Apply to create a chamfer with two distances. The chamfer 
on the following model was created by entering a Distance of 15 
and Distance 2 of 5. 

 

 Click Swap  to swap the effect of unequal distances. 
 

Creating a chamfer using a distance and an angle 
1 Click   

2 Enter a value for Distance. 

3 Enter an Angle 

4 Select an edge of a solid. 

5 Click Apply to create a chamfer with a distance and an angle. The 
chamfer on the following model was created by entering a 
Distance of 15 and Angle of 10. 

 

 Click Swap  to swap the effect of unequal distances. 
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Editing a solid chamfer during creation 
You can edit a chamfer using the Chamfer dialog. Remember that 
you can keep editing the chamfer after you click the Apply button. 

To edit the distance of a chamfer with constant distance: 
1 Enter a new value in the Distance box. 

2 Click Apply. 

To make a chamfer with constant distance into one with a variable 
distance: 
1 Click the Variable button. 

2 See the Variable option above for details on how to insert new 
distance values along the chamfer. 

3 Click Apply. 

To make a chamfer with variable distance into one with a constant 
distance: 
1 Turn off the Variable option. 

2 Enter the new distance value in the Distance box. 

3 Click Apply. 

To change the distance of a chamfer with variable distance: 
1 Keep editing the distance by inserting lines along the chamfer. 

2 Click Apply. 
 

Editing a solid chamfer 
You can edit an existing chamfer or edit multiple  (see page 
247)chamfers. 

To edit a fillet: 
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1 Double-click the Chamfer feature icon  in the tree to display the 
Edit Solid Chamfer dialog. 

 
2 Use the dialog to edit the chamfer, you can: 

 Change a variable distance chamfer to a constant one, simply 
turn off the Variable option and enter a new value in the 
Distance box. 

 Change a constant distance chamfer to a variable one, select 
Advanced to display the Variable Distance Chamfer dialog (see 
page 215) or select the Variable option and insert new radius 
values along the fillet. 

 Select one of the following options to recreate the chamfer 
using: 

 — a single distance 

 — two distances 

 — a distance and an angle 

 Edit the path of the chamfer, click the Chamfer Path Editing. 
The original path of the chamfer is highlighted; adjust the 
existing path or create a totally new one. 

 Edit the chamfer to have a constant width by toggling the 
Constant width option. 

 Select a new path for the chamfer as if creating a new 
chamfer. 
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Creating a rib fillet 
If you have a face of a solid surrounded by walls, you can replace 
the face by a rib fillet. 

 
The new fillet is tangent to the walls and its base touches where the 
face used to lie. 

To create a rib fillet: 

1 Click  (Solid feature toolbar). 

 
2 Select the faces you want to fillet: 

 
3 Click Apply to close the dialog and create a rib fillet on the solid. 
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Rib Fillet dialog 
This creates a rib fillet on a solid. 

 
Selection Mode - Select a face on the solid as a guide surface. The 
fillet is created along this surface. 

Individual faces - Only selects the face clicked. 

Adjacent continuous faces - Selects the face clicked and all faces 
which are adjacent and tangent plane continuous to the clicked 
face. 

All continuous faces - Selects the face clicked and all faces which 
form a tangent plane continuous surface with the clicked face. 

 Hold down the Ctrl key and click faces to add and remove 
them from the current selection. 

Select the following face on the solid. The  changes to . This is 
the guide surface. 
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Apply - Saves the rib fillet feature along the selected face. 

 

A Rib fillet feature icon representing the operation appears in the 
solid feature tree. 

 

Creating a Pocket or Protrusion Feature 

1 Click Solid Pocket or Protrusion  (Solid feature toolbar). 

2 Use the cursor to position the origin of the feature, or enter 
coordinates into the status bar. 

3 Complete the options on all pages of the Pocket dialog. Whilst 
the dialog is displayed, 3D instrumentation is displayed on the 
feature. 

As an alternative to entering the information into the dialog, you 
can use the handles to define the length, width and height of the 
feature. You can also define the corner fillets using the handles in 
each corner of the feature. The value boxes on the dialog are 
updated to reflect the settings defined by the instrumentation. 

4 Click OK to create the pocket or protrusion. The 
pocket/protrusion feature  icon is added to the solid tree. 

 When creating a pocket or protrusion, the values you enter in 
the Pocket/Protrusion dialog are remembered when you click 
Apply or OK. This means that the next time you create a 
protrusion or pocket, these values will be the default values. 

 

Pocket dialog 
The four pages of the Pocket dialog let you define the 
pocket/protrusion feature. Each page is described separately. 

 Dimension page (see page 229) 

 Corners page (see page 232) 

 Fillets page (see page 234) 
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 Plane Details page (see page 237) 

 If the definition of the feature is invalid (for example if the 
fillet radius is too large), the Apply button is greyed out and 
the graphic will show a dotted outline of the feature. 

 
If you are creating or editing a protrusion, the dialog will be 
renamed Protrusion. 

You can also simultaneously edit multiple pockets or protrusions 
(see page 247). 

 



 

PowerSHAPE 2015 R2 Reference Help Solid modelling • 229  

Pocket dialog - Dimensions page 
This page lets you define the dimensions of the pocket or 
protrusion. 

 
Type - Select the option to define the type of feature you want to 
create. 

Pocket - Select this option to create a pocket feature. 

Protrusion - Select this option to create a protrusion feature. 
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Extend pocket upwards through main solid - If ON, the pocket solid 
will be extended upwards, so that it cuts through all surfaces in 
the main solid as shown below. 

 
If OFF, the pocket is not extended upwards and the same model 
would look like this: 

 

 If you are creating a protrusion, the option is called Extend 
protrusion onto main solid. 

Extend protrusion onto main solid - If ON, the protrusion solid is 
extended downwards so that it meets all surfaces below it in the 
main solid. 
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If OFF, the protrusion is not extended onto the main solid and 
the same model would look like this: 

 

 If you deliberately place a protrusion over a hole in a solid, 
set the Extend protrusion onto main solid to OFF so that the 
protrusion does not attempt to fill in the hole. 

 lets you swap between creation mode and editing mode without 
closing/reopening the dialog.  

 When in creation mode, click  to swap to editing mode. 

 When in editing mode, click  to swap to creation mode. 

Overall Dimensions - The Length, Width and Height of the feature can 
be entered in the boxes. 

Draft - Each side face of the feature can have a draft angle. 

Apply to all sides - If ON, enter one draft angle to be applied to 
each side wall. If OFF, enter separate draft angles for each side 
wall. 
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Pocket dialog - Corners page 
Use this page to define the type of corner finishing on the pocket. 

 
Apply to all corners - If ON, the corner details you have specified are 
applied to all corners. If OFF, each corner is defined separately. 

Select the type of corner finishing from the drop down list. 

 - Do not apply any corner finishing. 

 - Fillet the corner edge. Enter the fillet radius for the corner in 
the text box. 

 - Create a corner hole. When you select this option, the Hole 
Details section of the dialog becomes active so that you can 
define the size, type and position of the hole. 
You can only create a corner hole if you are defining a pocket. 
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Hole Details - If you have created one or more corners of a pocket 
as a hole, you can define the size and position using this section of 
the Corners page. 

 

Edit definition - Click on  to make changes to the size and type 
of hole using the Hole dialog. 

Origin Positions - Move the slider to position the origin point of 
the hole in relation to the corner of the pocket. The position is 
expressed as a percentage of the hole's largest radius. 

If the slider is positioned at 0, the origin of the hole is centred on 
the corner of the pocket as follows: 
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If the slider is positioned at 100, the origin of the hole is 
positioned at the length of the radius away from the corner of 
the pocket as follows: 

 
Default Hole Definition - Creates a default plain hole, based on the 
current height of the pocket. 

 

Pocket dialog - Fillets page 
This page lets you define the fillet running along the base of the 
pocket or top of the protrusion. 

 
Base / Top - The option is called Base if you are creating a pocket 
and Top if you are creating a protrusion. 
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Offset - This option is only active if you are creating a protrusion. 
You can use it to create an offset fillet around the top of the 
protrusion. The fillet is offset from the top of the protrusion by 
the value entered in the text box. The models below show the 
results when Offset is 0  and Offset is 5 . 

  
Radius - Enter the radius of the fillet around the base of the 
pocket or the top of the protrusion. 
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Fillet edges between square corners - If ON, fillets will be created 
around the whole of the base of the pocket, or top of the 
protrusion. 

 
If OFF, edges with square corners will not be filleted. 

 
Joining Fillet 
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Radius - Enter a fillet radius to define the radius where the 
pocket/protrusion joins the solid. 

 
 

Pocket dialog - Plane Details page 
This page lets you define the workplane for the feature. 

 
Position - The location of the workplane on the feature is defined 
using this panel. 
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The default setting will position the workplane in the centre of the 
feature. 

  

 
Selecting an alternative setting will define the workplane 
accordingly. The example below defines the workplane at the middle 
of the left edge of the pocket/protrusion. 

  

 
Details - The workplane for the feature is defined using these 
options. The usual workplane instrumentation is displayed whilst 
this page of the form is selected. 
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Relationship - Define the relative position of the pocket or protrusion 
with respect to the solid by selecting the Solid Feature Relationship 

 button. 
 

Creating a User Defined Feature 
User Defined Feature can be used to create a solid feature from faces 
of a solid. This feature is included in the solid feature tree and can 
be suppressed/unsuppressed and renamed. 
To create a User Defined Feature, 
1 Create a solid. 

2 Select User Defined Feature  (Solid feature toolbar). The 
Create User Defined Feature dialog is displayed. 

3 Select the area of the solid that you want to turn into a user 
defined feature. 

4 Select your options on the dialog. 

5 Click OK. 
 

Create User Defined dialog 
Use this dialog to specify the surfaces to be used to create the user-
defined feature. 

 
Selection method - Select from the following options: 

Adjoining Faces 
Concave Faces 
Convex Faces 
Tangent Continuous Regions 
Single Face 

Surfaces Selected - When you select the area of the solid to turn into 
the user-defined feature, the  changes to a . 

Name for selected surfaces - Enter the name of the feature. 
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Apply - Create a user-defined feature from selected surfaces. 
 

Scaling constraints for user defined features 

 Scaling constraints can only be applied to version 8 solids. If 
your model contains post-version 8 solids, they will need to 
be converted manually (see page 21) before constraints can 
be applied. 

You can apply constraints to user-defined features that you wish to 
scale. It is advisable to use small scaling factors (for example, 1.2, 
1.3) when you are using scaling to ensure that the stitch margin is 
able to produce a smooth and acceptable solution. 

Scaling constraints let you keep certain entities locked whilst scaling 
the rest. They are used where graded copies of some geometry are 
required but portions of the geometry are to be kept constant 
irrespective of the scale factor that is being applied. 
Examples 

You could use scaling constraints in the following situations: 

 Bottles; scale the whole bottle but keep the neck of the bottle 
the same size. 

 Shoes; scale the shoe sole but keep the airbag or logos the same 
size. 

 Applying scaling constraints will not make any immediate 
change to the model that is displayed, but will be used when 
you scale the model 

 

Defining scaling constraints for a user defined feature 
1 Right-click on a User Defined feature in the tree window. 

2 Select Scaling constraints from the feature context menu. 

 
The Set constraints for feature dialog (see page 241) is 
displayed.  
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Set constraints for feature dialog 

 
The options on this dialog are the same as those on the Set 
Constraints for solid dialog (see page 94). 

You can define the scaling constraints in one of the following ways: 

 Fixed Size (see page 95) - Use this method to select the 
directions that are to remain unaltered by scaling. 

 Fixed Distance (see page 97) - Use this method to maintain the 
relative position of  two solids or two user-defined features. 
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Creating a wrap feature 
You can wrap surfaces and solids by wrapping a triangle mesh onto 
them using the Wrap Wizard. 

 

The wrapping method is the same as Wrap Triangles  from the 
Surfaces toolbar, except the wrap is created as a solid feature 
displayed in the feature tree. This enables the wrap feature to be 
edited. 

Wrap features are: 

 always placed at the top of the feature tree. 

 preserved when you offset a solid. 
To wrap objects, 
1 Use the Mesh Creator in ArtCAM Pro to create a dmt file of the 

relief you want to wrap onto objects. 

ArtCAM Pro is a Delcam software program which allows you to 
easily create impressive, high quality 3D products starting from 
2D bitmap or vector based artwork. 

2 In PowerSHAPE, create the surfaces or solids on to which you 
want to wrap the feature. 

3 If necessary, edit the image to be wrapped so that it fits on the 
surfaces and solids. 

4 Click Create a Solid Wrap Feature  (Solid feature toolbar).The 
Wrap Wizard starts and displays the Wrapper Selection page. 

The wrappers must be all symbols or all wireframe. 

For further details, see What is wrapping? in the Surface modelling 
manual. 
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How do I edit a wrap feature? 
To edit a wrap feature: 

1 Double-click the wrap feature  icon in the solid tree. This starts 
the Wrap Wizard. 

2 Use the Wrap Wizard to edit the wrap feature. 

For further details, see What is wrapping? in the Surface 
modelling manual. 

 

Solid transform feature 
Create solid transform features on solids so that values can be 
changed, or the transform suppressed, unsuppressed or deleted. 
Information about changes of position, rotation, scaling or mirroring 
are stored with the solid. 

Creating transform features 
Transform features can be created by: 

 Selecting one or more solids and selecting Move, Rotate or Mirror 
from the General Edits toolbar when the option Tools > Options > 
General Edits > Create solid transform features is selected. 

 Scale transform feature will not be created if you select 
Scale from the General Edits toolbar, even if the Tools > 
Options >General Edits > Create solid transform features is 
selected. 
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 Selecting one of the options on the Object > Feature > Transform 
menu. These options will create a transform feature on the active 
solid and let you enter the parameters and show a preview of the 
transformed solid. 

 
The following specific dialogs are displayed when using this 
method to create the transform feature: 

Move feature (see page 245) 

Rotate feature (see page 245) 

Mirror feature (see page 246) 

Scale feature (see page 246) 

Editing a transform feature 
1 Use one of the following methods to display the relevant 

transform feature dialog. 

 Double-click the transform feature in the solid tree. 

 Select Modify from the feature's context menu. 

The transform feature dialogs will be displayed irrespective of 
how the transform feature was created. 

2 Use the dialog to modify the feature. 

3 Click OK to make the changes. 

Tips when using transform features 
 When using the General Edits toolbar, transform features will not 

be created on solids that do not have history trees, whatever the 
setting on Tools > Options > General Edits. 
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 If you use Copy original, the original won't have a feature 
associated with it, but the copies will. 

 Features below a transform feature in the solid tree are not 
transformed. When modifying an earlier feature it will appear in 
its original state. 

 Transform features can be suppressed, deleted and reordered. If 
the transform is suppressed or deleted, the solid will revert to its 
original state (before transformation). 

 

Move feature 

 
1 Movement Vector defines the distance to be moved along each 

axis. These axes refer to the feature's workplane. 

2 To define the translation by clicking on the model, use  to 
display the Position dialog to Reposition start point and Reposition 
end point. 

3 Click  to edit the feature's workplane using the Workplane 
dialog. The feature's workplane acts as a reference point for the 
transform. 

4 Click OK to create the transform feature. The move feature  is 
added to the feature tree. 

 

Rotate feature 

 
1 Enter an angle of rotation as measured around the Z axis of the 

feature's workplane. A preview of the rotated solid is displayed 
with the existing position. 
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2 Click  to edit the feature's workplane using the Workplane 
dialog. The feature's workplane acts as a reference point for the 
transform. 

3 Click OK to create the transform feature. The rotate feature  is 
added to the feature tree. 

 

Mirror feature 

 

1 Use  to change the plane in which the mirror transform 
takes place. 

2 Click  to edit the feature's workplane using the Workplane 
dialog. The feature's workplane acts as a reference point for the 
transform. 

3 Click OK to create the transform feature. The mirror feature  is 
added to the feature tree. 

 

Scale feature 
A scale feature can only be created if you select Object > Feature > 
Transform > Scale to display the Scale Feature dialog. It will not be 

created if you select  from the General Edits toolbar, even if the 
Tools > Options >General Edits > Create solid transform features is 
selected. 

Use this dialog to specify the scale feature: 
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1 Use the drop-down list to select the Type of scale to be used 
(Uniform, Non-uniform or Projected volume). 

2 Enter a single Scale factor for Uniform scaling. For Non-uniform 
scaling enter scale factors for X, Y and Z. For scaling Projected 
volume, enter values for Original volume and Desired volume. 

3 Use  to lock the scale factor to 1 for a particular axis. 
The X, Y and Z scale factors refer to the axes of the feature's 
workplane. 

4 Click  to edit the feature's workplane using the Workplane 
dialog. The feature's workplane acts as a reference point for the 
transform. 

5 Click OK to create the transform feature. The scale feature  is 
added to the feature tree. 

 The results that are achieved using transform features may 
not necessarily be as expected. This is because functionality 
such as Scaling Constraints is not applied. Therefore, if it is 
essential that the original behaviour is ensured, deselect the 
Create solid transform feature option on the Tools > Options > 
General edits dialog. 

 

Editing multiple features 
You can make identical changes to multiple features of the same 
type in a solid. This is useful if you want to quickly edit a large 
project that contains many features. 

This function is available for : 

 cuts (see page 128) and bosses (see page 143) 

 fillets (see page 199) and chamfers (see page 223) 

 pockets (see page 227) and protrusions (see page 227) 

 holes (see page 154) 

 Editing of multiple variable radius fillets is not supported. 

Editing multiple features - example 
This example shows how to edit multiple fillets, however the same 
concepts apply for all families of solid features. 

1 Select multiple features you want to edit (for example fillets) 
using one of the following methods: 

 The Smart Feature Selector (Solid Feature toolbar) 
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 Hold the control key and select the features in the solid feature 
tree 

 
2 Right click one of the highlighted features in the tree and select 

Modify. 

 
The dialog to edit the appropriate selected features is displayed 
(for example, the Edit Solid Fillet dialog). The dialog is similar to 
that of editing a single feature of the same type, with the 
following differences: 

 — The properties that differ between the selected features 
are highlighted in pink. 
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 — The properties that cannot be edited for all the selected 
features are unavailable. 

 

 — The range of values is displayed when you hover the 
cursor over a property. 

 
3 Edit the properties. 

4 Click OK to apply the change to the selected features and close 
the dialog. 

 

Creating a relationship between a solid feature and a 
solid 

The relationship between a solid feature and a solid is defined using 
the Solid Feature Relationship dialog. The dialog is displayed by 
selecting  on the appropriate solid feature dialog. 

To create a relationship between a solid feature and a solid, you 
need to define the following: 

1 A keypoint on the solid. 

2 A keypoint on the feature. 

3 The distance between the two keypoints. 
Defining a keypoint on the solid 
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1 Click  to attach a workplane to the cursor and display the 
keypoints on the solid as blue circles. 

 
2 Select the keypoint. The unselected points will be removed, 

leaving only the selected keypoint. 

The  changes to a  to indicate that the relationship workplane 
has been correctly defined. 

Defining a keypoint on the feature 

1 Click  to display the keypoints on the feature as blue circles. 

 
The keypoints that are displayed will depend on the feature. 

 Solid cut and solid boss - the keypoints are points on the 
sketch and the average centre point of the sketch. 

 Boolean features - the keypoints are keypoints on the 
secondary solid. 

 Hole features - the keypoint is always the origin point of the 
hole. The point button is greyed-out because it cannot be 
changed. 

 Pocket/Protrusion features - the keypoint is always the origin 
point of the pocket/protrusion. The point button is greyed-out 
because it cannot be changed. 

2 Select the keypoint. The unselected points will be removed, 
leaving only the selected keypoint. 

The  changes to a  to indicate that the keypoint on the 
feature has been correctly defined. 
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Defining the distance between the two keypoints 

The X, Y and Z values that define the distance between the keypoint 
on the solid and the keypoint on the feature are shown: 

 graphically as dimensions on the model. 

 as values on the dialog. The values can be numbers or 
parameters. If you alter these values, the feature will move. 

 

Solid Feature Relationships 
You can specify the position of a some types of feature with respect 
to the active solid by using the Solid Feature Relationship dialog box 
(see page 251). You can create a relationship for the following solid 
features: 

 Solid cut 

 Solid boss 

 Boolean 

 Boolean-boss 

 Hole 

 Pocket/Protrusion 
 

Solid Feature Relationship dialog 
This dialog can be used to define the relative position of the feature 
with respect to the solid for 

 Solid cut 

 Solid boss 

 Boolean 

 Boolean-boss 

 Hole 

 Pocket/Protrusion 
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1 Select  on the appropriate solid feature dialog. 

 
2 Use the following options on the dialog to define the relative 

positions with respect to the solid. 

 Position the relationship workplane. 

 Specify the point on the feature to use. 

 - X, Y and Z values to define the 
distance between the two keypoints. 

 Delete the relationship. 

The current status of the relationship is indicated on the feature 
dialog by one of the following: 

 no relationship is currently defined. 

 a valid relationship is defined. 

3 Once you have selected the Relationship workplane  button , 
the following options can be used to help define the keypoint on 
the solid: 

All types - If ON, all key points are displayed. If OFF, other 
options are used to define the keypoints that are displayed. 
Turning off any of the other keypoint options will automatically 
set All Types to OFF 

Corners - If ON, corner points on the solid are displayed. 
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Special surfaces - If ON, keypoints on special shaped surfaces 
(plane, cylinder, cone, torus and sphere) are displayed. 

Hole Features - If ON, keypoints of hole features are displayed. 

Primitive features - If ON, keypoints of primitive features are 
displayed. 

Relative to the relationship's workplane - If ON, the feature will be 
aligned so that it's axes are parallel to the relationship 
workplane. If OFF, the orientation of the feature is not defined by 
the relationship workplane. 

X, Y, Z boxes - Enter the X, Y and Z angles that the feature is 
twisted around each axis. The twists are applied in the order that 
they are entered. The order that the twists will be applied is 
indicated by the twist transformation order that is displayed at 
the bottom of the dialog when you enter values in the boxes. 

4 Click OK toaccept all changes and return to the appropriate 
feature dialog, or Cancel to discard all changes and return to the 
appropriate feature dialog. 
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Solid feature tree 
The solid feature tree contains the history of solid operations 
performed on a solid. Each solid operation is defined as a feature on 
the solid. 

Use the following sections for more details on using the solid feature 
tree: 

 Creating a solid feature tree (see page 254) 

 Displaying the solid feature tree (see page 257) 

 Editing a solid using the feature tree (see page 257) 

 Editing a feature using context menus (see page 262) 

 Selecting a feature (see page 265) 

 Activating and deactivating a solid (see page 269) 

 Reordering the features in the tree (see page 270) 

 Setting a Rewind Position (see page 271) 

 Supressing a feature (see page 275) 

 Unsupressing a feature (see page 276) 

 Deleting a feature (see page 276) 

 Speeding up operations on solids (see page 276) 

 Removing the history of features for a solid (see page 276) 

 Deferring updating the solid (see page 277) 

 Optimising the tree (see page 278) 

 Changing the name in the feature tree (see page 282) 

 Hiding and viewing features in the tree (see page 282) 

 Editing the base solid (see page 283) 
 

Creating a solid feature tree 
The solid tree is created automatically when you add a solid feature 
to a solid. 

1 Create a solid block it is automatically added to the solid feature 
tree. The tree is hidden by default. 
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2 Display the solid tree (see page 257). 

 
3 Add a cut feature to the solid. The cut feature is displayed in the 

tree; the block at the bottom of the tree to show that the solid 
was created from a primitive block. 

 
The features are shown in chronological order in the tree. The 
most recent one applied is shown at the top and the earliest at 
the bottom. 

4 Add a boss to our example. The boss feature appears above the 
cut feature. 

 
The following icons can be displayed in the solid tree: 
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 - Solid with a history 

 - General solid without a history 

 - Active solid 

 - Inactive solid 

 - Extrusion or Extruded solid feature 

 - Solid of revolution or Solid of revolution feature 

 - Block primitive or Block primitive feature 

 - Sphere primitive or Sphere primitive feature 

 - Cylinder primitive or Cylinder primitive feature 

 - Cone primitive or Cone primitive feature 

 - Torus primitive or Torus primitive feature 

 - Add feature 

 - Subtract feature 

 - Intersect feature 

 - Cut feature 

 - Boss feature 

 - Hole feature 

 - Pocket/Protrusion feature 

 - Hollow feature 

 - Thicken feature 

 - Bulge feature 

 - Fillet feature 

 - Chamfer feature 

 - Rib fillet feature 

 - Wrap feature 

 - Sculpt feature 

 - Suppressed feature 

 - Unsuppressed feature 

 - Error suppressed feature 

 - Defer update 
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 - Group feature 

 - Pattern feature 

 - Edited face 

 - Unrecognised. This is used to indicate that the feature is not 
recognised by the version of PowerSHAPE. It is displayed in the 
feature tree when you create a model in a future version of 
PowerSHAPE that contains a new type of feature and then open 
that model in an earlier version of the software that cannot 
recognise the new feature type. When the feature tree is 
replayed, an Unrecognised feature is error-suppressed. 

 - Associated features hidden in tree 

 - Associated features visible in tree 
 

Displaying the solid feature tree 
Use one of the following techniques to display the solid feature tree: 

 Click the solid to display the Solid Edit toolbar and click the 

Show/Hide tree window button . 

 Select View > Windows> Tree Window. 
 

Editing a solid using the tree 
When you select a single solid in the graphics window or solid tree, 
it is highlighted as selected and a black box is drawn around its 
name in the solid tree. 
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1 In the feature tree, right-click the Feature  icon to display the 
solid popup  

 
2 Use the options on the context menu to edit the selected solid. 

Rename — Edit the name of the solid. 

Suppress All — Suppress all the features on the solid. All features 
are no longer displayed on the solid. 

Unsuppress All — Unsuppress all the features on the solid. All 
features are displayed on the solid. 

Replay All — Redefine all the features in the history tree of the 
solid. No changes are made to the definition of any features (for 
example, suppressed features will remain suppressed). 

 This option may help you fix a problem that was present in 
a model created in an earlier version of PowerSHAPE, for 
example if the solid contains badly trimmed surfaces.  

Group All — Select this option to group sequential features 
throughout the whole tree. 

Remove History — Select this option to remove all the history for 
a solid. 
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Remove History (keep rewound features) — Select this option to 
remove the history below the rewind bar and combine the 
features into a single general base feature. The greyed out 
rewound features are left intact. 

 This option is only available when the solid has a history 
tree that has a rewind bar. 

Remove rewind position — Removes the rewind position. All the 
greyed-out rewound features are applied to the solid. 

Update Selected Features — Replays the selected features in a 
solid using the latest version of Parasolid. 

 Try using this option on error-supressed features to see if 
the latest version of Parasolid fixes them. 

Select Features... — Use this option to use the Select Features 
dialog (see page 268) to select features in the solid tree that 
comply with the filter. 

Defer Update — Defers updating the solid while editing it. 

Show complete solid during editing — Use this option to display 
the complete solid whilst editing a feature. This means that you 
can see the features that are further up the solid tree whilst you 
are editing a feature. This option is selected by default. The 
example below shows the effect of using this option when editing 
the chamfer 45. 
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Delete Error Suppressed Features — Delete all error-suppressed 
features in the history tree for the solid. 

Suppress by parameter... — Select this option to display the 
Suppress by Parameter dialog. 

 
Parameter — Use the drop-down list to select the parameter to 
control suppression of the feature. The parameter can also be 
used to control multiple, selected features. 

If the parameter value is non-zero, the feature will be 
suppressed. 

If the parameter value is zero, the feature will be 
unsuppressed. 

Remove — Select this option to remove the use of a 
parameter to control suppression. If this option is selected, 
suppression/unsuppression will no longer be controlled by the 
parameter. 

Transform Features — Use Dissolve and Merge to rationalise the 
solid tree: 

Dissolve — Select Dissolve to remove the transform features 
from the solid tree. An Information dialog is displayed to tell 
you how many transforms have been removed.  
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Merge — Use this option to merge adjacent transform features 
of the same type. For example, if you move a solid three 
times, selecting Merge will merge the three transform features 
into one. 

 

 If the Automatically merge solid transform features option 
is set on the Tools > Options > General > General Edits 
dialog, the transform features will be automatically merged 
as they are created.  

Main Solid — If this is deslected, click this option to make the 
selected solid the Main Solid. This option is only active when you 
are using an assembly. 

Power Feature Solid — If this option is deselected, click this 
optionto make the selected option a Power Feature Solid. This 
option is only active when you are using an assembly. 

Advanced Power Features — Select this option to use the Set 
advanced property for Power Features dialog. This option is only 
active when you are using an assembly. 

Scaling Constraints — Use this option to Apply constraints (see 
page 92) to solids that you wish to scale. 

Solid Origin... — Select this option to display the Edit Solid Origin 
dialog.  

 
Use this dialog to define a reference point for a solid, to be 
used as a reference point during in grading. 
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Editing a feature using the context menu in the feature 
tree 

In the feature tree, right-click a feature to display the feature pop 
up menu. 

 
Delete - Select this option to delete the feature from the tree. 

Modify opens the feature-specific dialog. 

Rename lets you edit the name of the feature. 

Suppress the feature on the solid. The feature is no longer displayed 
on the solid. 

Unsuppress the feature on the solid. The feature is displayed on the 
solid. 

If a feature is no longer valid, it is suppressed from the solid and 
the Error suppressed feature icon  appears next to its icon in 
the tree. For example, if you edit a cut feature and define a 
depth that doesn't cut the solid, an Error suppressed feature icon 

 appears. 

 

You can click the Error suppressed feature icon  to find out why 
a feature is invalid.  

 You cannot edit a suppressed feature, but you can edit an 
error suppressed one. 
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Suppress by parameter displays the Suppress by Parameter dialog. 

 
Parameter lets you select the parameter to control suppression of 
the feature. The parameter can also be used to control multiple 
selected features. 

If the parameter value is non-zero, the feature will be 
suppressed. 

If the parameter value is zero, the feature will be 
unsuppressed. 

Remove the use of a parameter to control suppression. If this 
option is selected, suppression/unsupression will no longer be 
controlled by the parameter. 

Convert to general base feature converts the selected primitive 
features to base features. This option is hidden if you have not 
clicked on a primitive feature. 

 In addition: 

 If the solid is a primitive solid, Convert to general solid is 
displayed on the context menu. 

 If the solid has a history tree, then Remove history is 
displayed on the context menu. 

 If the solid has no history and is not a primitive, then neither 
option is displayed on the context menu. 

Group collects a number of features together into a group. 

 If the features are of different types, the group is given a 
generic name, for example Feature group 1. 

 If the features are of the same type, the group is named after 
that type, for example Hole group 1. 
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Update Replays the features in a solid using the latest version of 
Parasolid. 

 Try using this option on error-supressed features to see if the 
latest version of Parasolid fixes them. 

Rewind to here sets the rewind position immediately above the 
feature you clicked. 

Remove rewind position removes the rewind position. All the greyed-
out rewound features are applied to the solid.  

Attributes displays the Attributes submenu.  

 
Lock when scaling behaves slightly different for each feature.and 
is not available for some features. 

Generally, if this option is selected, the original dimensions of the 
feature are unchanged when the whole solid is uniformly scaled 
from the Edit toolbar. If deselected, the feature is scaled too. 

If you non-uniformly scale the solid or define a dimension of the 
feature using parameters, the feature will not be scaled 
regardless of whether the option is selected or deselected. 

Pre-machined lets you specify whether or not the feature is 
already machined. 

 

Editing a feature using the feature tree 
Double-click the icon of a feature in the tree to display the dialog for 
that feature. When you do this, only the following aredisplayed on 
the edited solid: 

 the feature you are editing. 
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 the solid before that feature was applied. 

The following icons may appear in the tree. 

 - Extruded solid feature 

 - Solid of revolution feature 

 - Block primitive feature 

 - Sphere primitive feature 

 - Cylinder primitive feature 

 - Cone primitive feature 

 - Torus primitive feature 

 - Add feature 

 - Subtract feature 

 - Intersect feature 

 - Cut feature 

 - Boss feature 

 - Hole feature 

 - Hollow feature 

 - Thicken feature 

 - Fillet feature 

 - Chamfer feature 

 - Bulge feature 

 - Wrap feature 

 - Group feature 

 - Pattern feature 

 - Sculpt feature. This feature cannot be edited. 

 Details about editing the different features are included with 
the feature creation infomation. 

 

Selecting a feature 
Use one of the following techniques to identify the feature was used 
to create a particular face. 
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 If a single solid is selected, the edges of the faces are highlighted 
orange (default colour scheme) as you move the cursor over 
them .  

If a face originated from a feature, the name of the feature is 
displayed in the Status bar  and highlighted with a red box in 
the feature tree . 

 
 If you click a feature in the solid feature tree, the faces of this 

feature are highlighted blue (default colour scheme)  and the 
name of the feature is highlighted with a blue box in the feature 
tree . 
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 Use  to select a number of individual features. All selected 
features are highlighted in blue. 

If you click the face of the solid that was created from a feature, 
the selected face will be coloured pink. If the face is part of a 
feature with a single visible face it will be coloured blue (default 
colour scheme). The name of the feature is highlighted with a 
blue box around it in the feature tree. This feature will remain 
highlighted even if the cursor is moved over other faces of the 
solid. 

Selecting one or more features in the tree 
Use one of the following techniques to select features in the tree 

 Use  to select the name of the feature. The feature is added 
or removed from the list of selected features. If you don't hold 
down Ctrl, the previous selection is replaced by the single 
feature. The name of each selected feature has a blue box 
around it and the surfaces that make up each feature are 
highlighted in the solid. 

 In the solid tree, right-click a solid to display the context menu. 
Choose Select Features... to open the Select Features dialog (see 
page 268). 
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Select Features dialog 
Choose Select Features... (Solid tree context menu) to display the 
Select Features dialog. This option will be unavailable if the solid has 
no features. 

 
Type lists the different features that can be highlighted on the 
model. Click items in the list to select/deselect. 

State  lists the state of the features. Click to select/deselect. 

Invert inverts the current selection; features that are selected 
become deselected and features that are deselected become 
selected. 

All selects all items in the list. 
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Apply highlights the features that match the filters you have 
applied. 

 
OK -saves the changes you made and closes the dialog. You can 
only select the items you specified on the dialog. 

Cancel closes the dialog and discards any changes. 
 

Activating and deactivating a solid 
 Double-click the solid to display the solid feature tree. In the 

solid feature tree, each solid has an icon next to it to indicate 
whether it is active or not. 

 indicates the solid is active. 

 indicates the solid is inactive. 

Click the Active solid icon  next to the solid in the tree to make 
it inactive. 

Click the Inactive solid icon  next to the solid in the tree to 
activate the solid. 

 Right-click the solid in the view to display its context menu. 
Select Active to activate the solid and turn off to deactivate the 
solid. 

 A solid can also be activated and deactivated using the Solid 
Edit toolbar. 
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Reordering the features in the tree 
You can redefine the solid by changing the order of the features in 
the tree. 

1 In the solid feature tree, select the icon of the feature. 

2 Drag the selected icon onto the icon of the feature you want it to 
lie below. 

In the tree shown below, we will switch the positions of the cut and 
boss features. 

 

Drag the icon of boss feature  onto the icon of the cut feature .  

 
This reorders the features and redefines the solid. 
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Setting a Rewind Position 
You can set a Rewind Position in the solid tree. 
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The rewind position appears as a horizontal bar on the solid tree . 

This bar can be dragged up and down the solid tree using . A 
dashed line  is displayed to show the potential new position of the 
bar during the drag operation. 

 
The Rewind Position lets you: 

 create a new feature anywhere in the tree (see page 273). If you 
create a new feature, it will appear at the rewind position. This 
means you do not have to create it at the top of the tree and 
then re-order it to where you want it. 

 preserve features that would be automatically removed (for 
example, Direct Modelling operations). Only features that are 
below the rewind position are replaced, They will be replaced by 
a single base feature, without history. 
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 export solids in an earlier state; for example, prior to a part 
revision. 

Features that are rewound appear greyed-out in the solid tree. They 
are unavailable for selecting, or editing. 

 

Creating a feature at a specified place in the tree 
Use Rewind Position to create a new feature anywhere in the tree. 

This example reduces the height of the general solid and creates a 
hole feature on the general solid. 

 

1 Right-click  

2 Click Rewind to here to suppress the features of the solid and 
leave the general solid displayed. 

 

3 Click  (Solid edit toolbar) and select the individual face . 
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4 Move the face by entering -15 in the Z value on the Move toolbar. 

 
5 Click Apply . 

6 Click Dismiss . The solid still has a history tree. 

7 Add a hole feature to the solid. The hole is added to the tree in 
the sub-branch above the general solid feature. 

 
8 Move the cursor over the Rewind bar so that the cursor changes 

to a double-headed arrow. 
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9 Right-click and select Remove rewind position from the context 
menu. 

 
 

Suppressing a feature 
You can suppress a feature to remove it from the solid. 
PowerSHAPE remembers the details of the suppressed feature. 

To suppress a feature: 

1 Double-click the solid to display the solid feature tree, if the tree 
is not already displayed. 

2 Click the Unsuppressed feature icon . 

3 The icon changes to the Suppressed feature icon  to indicate 
that the feature is now suppressed. 

In the example below, we will suppress the cut feature. 
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The feature is removed from the solid. 

 
 

Unsuppressing a feature 
To unsuppress a feature, click the Suppressed feature icon  . The 
icon changes back to the Unsuppressed feature icon  and the 
feature is visible on the solid again. 

 

Deleting a feature 
To permanently delete a feature, select it and then press Delete on 
the keyboard. 

 

Speeding up operations on solids 
When there are a lot of features on a solid, you may find it takes 
longer to update your solid. 

To speed up operating on solids, do one of the following: 

 Remove the history of the features (see page 276). 

 Defer updating the solid (see page 277). 
 

Removing the history of features for a solid 
If you remove the history of features from a solid, it is quicker to 
operate on the solid. 

1 Right-click the icon of the solid in the feature tree to open the 
context menu. 
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2 Select Remove History. 

 
The features are permanently removed from the tree. 

 
 

Deferring updating the solid 
To speed up editing a solid, you can defer updating the solid. This 
allows you to apply several edits to a feature tree of a solid, without 
having to wait for the solid to redefine after each edit. All the edits 
are treated as one command and applied when you exit defer 
update mode. 

1 Right-click the Feature icon  of the solid in the feature tree  

2 Select Defer Update from the context menu. 

The icon next to the Feature icon  in the tree changes to the 
Defer Update icon . 

 
3 Make the required changes to the solid. While you are in defer 

update mode, the following are true: 
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 All edits on the features are available, for example, 
suppressing, re-ordering and using the dialogs to edit 
features. 

 After each edit, the feature tree will update, but the solid will 
not graphically change. 

When you edit some features using their dialogs, their correct 
shape will display. Once you finish editing them, their original 
shape is displayed and they look unedited. 

If you delete a feature, the Deleted feature icon  is placed next to 
the icon of the feature in the tree. 

 
The feature remains visible in the solid and is only removed 
when you exit defer update mode. 

4 Exit defer update mode. The edits will then be applied to the 
solid. 

To exit defer update mode, do one of the following: 

 Click the Defer update icon . 

 Right-click the Feature icon  of the solid in the feature tree 
and select Defer Update from the context menu. 

 Deselect the solid by clicking in free space. 

 Stop editing the solid and begin a different operation, for 
example create a line. 

 Undo is not available while you are in defer update mode. 
Once you exit defer update mode, the Undo command treats 
all the edits in defer update mode as a single command. 

 

Optimising the tree 
Speed up the redefinition of multiple features in a large feature tree 
by optimising the solid feature tree. This groups together multiple 
occurrences of the same features: 

Optimise the tree in one of the following ways: 

 Automatic optimisation uses the Tree Optimisation options on 
Tools > Options > Object > Solids dialog. For example, using the 
default settings, you are asked if you wish to optimise the tree 
after 20 holes are created in the solid. 
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 Use the solid feature tree to optimise the tree (see page 279) by 
creating feature groups. 

 Edit feature groups (see page 280) to make identical changes to 
a large number of features. 

Use Explode (see page 281) to remove the groups that are created 
by optimising the tree. 

 

Creating group features 

 

To optimise the tree: 

1 Right-click Feature  to display the solid context menu. 

2 Select Group Features. 

The holes are put into two different Hole group features and the 
pocket features are put into a Pocket group. Each group feature 
is marked with the . 

 
In the example, all the holes next to each other in the solid tree 
are put in the same group. 
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Using a Group feature 
Each group feature should only contain hole features that do not 
interact with one another. This allows all the features in the group 
to be applied in a single operation. 

 
Using a group lets you: 

 edit the hole features in a group as you normally would. If you 
edit a hole feature and as a result it interacts with other features 
in the group, it is suppressed and an error message is displayed. 

 move hole and group features as you normally would by 
dragging their icons. For example, you can move hole features 
from one group to another. 

 move a group feature inside another group to create a sub-
group. If you can't move a hole feature, it will be left where it is. 

 
If you delete a group feature, the hole features are moved up a 
level in the tree and the group feature icon is removed from the 
tree. 

If you suppress a group feature, all the holes in the group are 
suppressed. 

 

Editing group features 
You can simultaneously modify a group of features of the same type 
in a solid using the solid feature tree. 
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To modify a group of features: 

1 Select a group in the solid feature tree. 

 
2 Right-click the selected group and select Modify from the Feature 

context menu. 

The appropriate dialog for editing multiple features (see page 
247) of the same type is displayed (for example, the  Edit 
SolidFillet dialog). 

 

Exploding a group feature 

 
In the solid feature tree: 

1 Select the group to ungroup. 

2 Right click Feature  to display the solid pop up menu. 

3 Select Explode. 
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The group is removed and the features are moved into the main 
tree.  

 

 If the group was part of a parent group, the features are 
moved into the parent group. 

 

Change a name in the feature tree 
1 Click the name to select it. 

2 Click the name again to make it editable. 

 
3 Enter the new name in the text box. 

 

 You can also edit the name pressing F2 or by right-clicking a 
selected name and selecting Rename from the context menu. 

 

Hiding and viewing features in the tree 
If a solid has features, it will have either a Plus  or Minus  icon to 
its left. 

 - Features are visible in the tree. 

 - Features are hidden in the tree. 

Click the Plus icon  to expand the tree and show the features. The 
icon will change to a Minus icon . 

Click the Minus  icon to collapse the tree and hide the features. 
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 Some features can have branches too. For example, when 
you add a solid with features to the active solid, the new Add 
feature will have branches representing the features from the 
original solid. 

 

Editing the base solid 
Copy and replace the base (general) solid as follows: 

1 Select Modify from the base solid popup in the solid feature tree. 
The Base Feature dialog is displayed. 

 

2 Click  to create a copy of the selected solid used in the 
feature. When you select OK, the entire sub-branch (the solid 
and its history) will be copied. If the sub-branch only contains 
one primitive feature, the new solid will be a primitive solid. 

3 Click Replace Solid to replace the solid with another one using the 
Replace Solid dialog (see page 115). 

4 Click OK to complete the operation. 
 

Using the Solid Doctor 
Use the Solid Doctor to find and fix the faults in a solid. The 
following are classed as faults: 

 holes 

 overlaps 

 self-intersections 

 bad trimming of surfaces 

These faults need to be removed as they can cause further solid 
feature operations to fail. 
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The following model is used to illustrate creating a faultless solid. 

 

1 Click Quick select all surfaces . 

 

2 Click Solid . 

3 Click Create solid from selected surfaces or meshes . 

 
4 Click No to the Make Watertight Wizard.  

 This will eventually be replaced by the Solid doctor. 

5 Click Tools > Model Fixing > Solid Doctor. 
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The Solid Doctor dialog box (see page 288) is displayed. 

 
The first group of faults is selected in the fault tree and displayed 
on the model. 

 
6 Select Gaps (1). 
7 Click Extract surfaces around gap and edit them from the Repair 

Options drop down list 

8 Click Process the selected faults . 
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9 Zoom around the gap in the model window and select the 3 
surfaces shown below. 

 

10 Click Delete . 

11 Click Quick select all surfaces . 

 
12 Click Accept on the Doctor Edit toolbar (see page 293). 

 
13 Click Tiny faulty surfaces (3). 
14 Click Delete surface(s) from the Repair Option drop down list. 

15 Click Process the selected faults . 

16 Click Re-check the solid for faults . 

17 Click on the Gap label of the fault in the model. 

18 Click Extract surfaces around gap and edit them from the Repair 
Option drop down list. 

19 Click Process the selected faults . 

20 Click Accept on the Doctor Edit toolbar (see page 293). 

 
21 Click Gap 1 in the Fault tree. 

22 Click Fill gap with tangential surface from the Repair Option drop 
down list. 

23 Click Process the selected faults . 
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24 Click Re-check the solid for faults . 

The outer edge of the solid is now marked as a hole. 

 
25 Click Ignore intentional large hole from the Repair Option drop 

down list. 

26 Click Process the selected faults . 

27 Click Finish. 
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Solid Doctor dialog box 
Use the dialog box to fix all the faults in a solid by removing holes 
and repairing the trimming of the faulty surfaces. 

 
Fault Tree - This lists the faults in the solid. Faults can be selected in 
the Fault Tree or the model window. If you select a fault in the tree, 
it will be highlighted in the model. You can also select a fault in the 
model to highlight it in the tree.  

 
For example: 
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1 Click on the fault in the Fault tree. 

 
2 Click on the fault annotation in the model. 

 
Fault Information - This describes the selected fault. 

 
The following fault information is provided: 
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 What is wrong: - This shows a description of the fault. 

 What to do: - This gives a suggested repair procedure. 

 Failed repair operations - This lists the fixing operations that 
have failed. 

Zoom  - Click to zoom into the model to enlarge the view of the 
selected fault. Zoom out to view the whole solid. 

Fault Display - Choose how you want to display the faults in the 
model window from the options in the drop down list. 

Display selected faulty areas - This displays the selected fault in 
the model window. 

Display all faulty areas - This displays all the faults in the model 
window. 

Show affected areas - Not currently available. For future 
development. 

Repair Options - Select a repair option from the list of available 
repair operations. For further details see the List of fault options 
(see page 291). The default option is Attempt automatic repair. 
Depending on which repair option you have selected, the Doctor 
Edit toolbar (see page 293) is displayed.  

 

Apply  - Click to apply the repair option to the selected faults. 

Undo  - Click to undo the last repair operation. 
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Re-check - Click to check the solid for faults. 

Advanced - Not currently available. For future development. 

Finish - Click to close the dialog box and check for faults. If faults 
are found the Faulty Solid Query dialog box is displayed. 

 
Continue - Click to open the Solid Doctor dialog box to continue 
fixing faults. 

Finish - Click to accept the changes made by the Solid Doctor. 
 

List of repair options 
This lists the repair options displayed on the Solid Doctor dialog (see 
page 288). The repair options relevant to the selected fault are 
displayed in the Repair Options dropdown list.  

 
Repair option Action 
 Attempt automatic repair Automatically fixes the fault. This 

combines other standard listed options 
to try to repair the solid. 

 Extract surfaces and edit 
them 

 Extract surfaces around gap 
and edit them 

 Extract surfaces around hole 
and edit them 

 Extract surfaces at edge and 
edit them 

Removes surfaces of the fault. Enters 
surface edit mode to fix the surfaces. 

 Delete surfaces Deletes the faulty surface. 

 Delete selected surfaces Deletes highlighted surfaces 

 Fix surface Enters surface edit mode when a 
surface is selected. 

 Add selected surfaces to 
solid 

Adds the selected surfaces and/or 
solids to the main solid to fill the open 
hole. 
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 Fill gap with tangential 
surface 

 Fill gap with non-tangential 
surface 

 Fill hole with tangential 
surface 

 Fill hole with non-tangential 
surface 

Creates a fill-in surface for the selected 
hole in the solid. 

 Fill gap by removing 
boundary 

 Fill hole by removing 
boundary 

Extends the surfaces adjacent to the 
hole to try to fill the hole. 

 Link and heal edge across 
gap 

 Link and heal edge across 
overlap 

Heals the open edge. This may 
increase the solid tolerance. 

 Ignore intentional large hole Marks the selected large hole as 
intentional. 

 Mark problem area and enter 
edit mode 

 Mark hole boundary and 
enter edit mode 

 Mark gap boundary and 
enter edit mode 

 Mark problem areas for later 
repair 

Creates composite curves around the 
faulty surfaces and holes. 

 Global fault with unknown fix  Not currently available. For future 
development.  

 Enter edit mode Enters surface edit mode without 
changing the solid. 

 Fault repaired Displays if the fault has been repaired. 

 Heal edges at vertex Heal edges of the surfaces that meet 
at a point. 

 Replace vertex Extracts, heals and replaces the 
surfaces. 
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Solid Doctor Healing dialog 
Use this dialog to heal or relax a region where a solid operation has 
failed. 

Edge tolerances can be healed (tightened) or relaxed (loosened). If 
a solid operation is failing, try loosening the edge tolerances in that 
area. 

 Healing and relaxing is optional. Normally it is only necessary 
to heal or relax locally if a solid operation fails and the solid 
has no faults. 

 

Use  and  to toggle the threshold that you are using. 

When  is displayed, select one of the options form the drop-
down list to heal a region. 

 

When  is displayed, select one of the options form the drop-
down list to loosen a region. 

 
 

Doctor Edit toolbar 
Use this toolbar with the selected repair option to use the surface 
creation and editing tools to fix the surface before adding it back 
into the solid. 
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 The necessary curve and surface creation and editing tools 
are displayed.  

 

Information  - Click to display the Surface Repair Information dialog 
box, that displays details of the suggested repair operations. 

 
OK - Click to dismiss the dialog box. 

Accept  - Click to accept the surface edit changes. 

 If a surface is selected, Solid Doctor tries to add the surface 
back into the solid. 

Cancel  - Click to cancel any surface edit changes. 
 

Tips on using Solid Doctor 
It is useful to remember the following points when using Solid 
Doctor: 
 When a fixing problems, look at the problem first and ask 

yourself how you would fix that problem using surfaces. Then 
make/repair the surfaces that way and sew them back into the 
solid. 

 Run automatic fixing as the first step. Select the top entry in the 

fault tree and click  It won't fix all the problems, but it will 
usually drastically reduce the number of faults that need fixing 
using other options. 

 Use  often to re-check the solid. 

 Only selected surfaces are sewn into the solid when you leave 
Doctor Edit mode. You will be prompted if you forget to select a 
surface to be used. 
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 Gaps can be overlaps. 

 If there are any tiny gaps between surfaces, consider removing 
the surfaces that are adjacent to the fault. Use one of the hole 
filling options to fix the fault. 

 Use Shift and Ctrl to add and remove surfaces from the selection. 
 

Make Watertight Wizard (version 8 
solids only) 

 Make Watertight is only used with version 8 solids. Post-
version 8 solids use the Solid Doctor. 

This wizard makes a solid or mesh watertight by filling large gaps 
and sealing small gaps. 

1 Click Model Fixing  on the General edits  flyout. 

2 Click  (Model Fixing toolbar) 

3 Use the pages of the wizard to make your solid watertight. 

The Make Watertight Wizard consists of the following pages: 

Set the maximum linking tolerance - This is the first page of the 
Make Watertight Wizard  

Options - There are additional controls on this page. It is 
accessed from the first page of the Make Watertight Wizard. 

Repair holes in solids - This page is the second page of the 
Make Watertight Wizard and gives you additional control when 
repairing holes. 

Review solid state - This is the third page of the Make 
Watertight Wizard. 

Heal existing surface links in the solid - This is the fourth page 
of the Make Watertight Wizard. 
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Wizard result - If the solid becomes watertight, a dialog is 
displayed that shows the number of holes and gaps that 
remain in the solid at a particular tolerance. 

 
 

First page of Make Watertight Wizard - Set maximum 
linking tolerance 

This page sets the maximum tolerance of the sealing operation. 

 
Present solid linking tolerance - This is the latest tolerance to which 
the solid has been linked. 
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Maximum solid linking tolerance - The initial maximum tolerance set 
for the wizard will be the size of the largest small gap. 

Repair Options 
This section indicates the number of large holes, medium holes and 
small gaps in the model. You can either accept the default 
operations or select an option from the appropriate drop-down list. 

Large Holes - Large holes are highlighted blue on the model. A 
large hole is any hole greater than one hundred times the initial 
solid tolerance. 

The options that are available from the Large Holes drop-down 
list are: 

 
Medium Holes - Medium holes are highlighted yellow on the 
model. A medium hole is any hole larger than ten times the 
initial solid tolerance, but less than one hundred times the initial 
solid tolerance. 

The options that are available from the Medium Holes drop-down 
list are: 

 
Small Gaps - Small gaps are highlighted orange on the model. A 
small gap is any gap that is above the initial solid tolerance, but 
less than ten times the initial solid tolerance.  

The options that are available from the Small Gaps drop-down list 
are: 

 
Edges within tolerance - This displays the default instrumention 
colour for edges within tolerance. 

 - Click this button to open the Options dialog (see page 
298) to set the hole classification limits. 

 - Click this button to take you to the Second page of Make 
Watertight Wizard (see page 299) where you can set specific values 
in the options for filling holes. 
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 - If you select this option and the solid is watertight, the 
Fourth page of Make Watertight Wizard (see page 300) is displayed. 
In all other cases, a summary of the solid is displayed on the Third 
page of Make Watertight Wizard (see page 300). 

 

Options dialog box 

 

 - Use the up and down arrows to set the minimum 
hole width for medium holes. 

 - Use the up and down arrows to set the 
maximum hole width for medium holes. 

Delete tiny surfaces smaller than new link tolerance - If OFF, limit the 
maximum linking tolerance to the smallest size. If ON, limit the 
maximum linking tolerance to the largest small gap size. 

Heal small gaps before creating new links - Heal small gaps to the 
present solid tolerance before attempting to link the gap to a larger 
tolerance. 

 - Use the up and down arrows to set the 
maximum permitted size of the gap in the boundary of any filled 
holes. 

Tangentially - If ON, the surface is created tangent continuous to 
adjoining surfaces. 

 - Return to the first page of the Make Watertight Wizard. 

 - Close the Make Watertight Wizard without applying any 
changes. 
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Second page of Make Watertight Wizard - Repair holes 
in solid 

This page of the wizard gives you additional control when repairing 
holes. 

 

Hole state 
The holes in the model are displayed in the drop-down list. 

Selected hole width - Choose the hole to be repaired from the drop-
down list. 

Repair hole by 
Use these options to control how the holes are repaired. 

Healing - If ON, link hole within present tolerance. 

Filling while jumping gaps - If ON, create a fill-in surface for the 
selected hole. If Healing is also ON, the fill-in surface will be created 
after any healing operation. Use the up and down arrows to set the 
maximum size of the gap in the boundary of the selected hole, or 
enter a value in the box.  

Tangentially - If ON, the surface is created tangent continuous to 
adjoining surfaces. 

 - Preview the repair of the selected hole, using the options 
you have selected. 

 - Repair the selected hole using the present repair 
settings, before proceeding to the next largest hole. 
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 - Leave the selected hole in the solid and proceed onto 
the next largest hole. 

 - Leave Advanced options and return to the first page of 
Make Watertight Wizard. 

 

Third page of Make Watertight Wizard - Review solid 
state 

Use this page to review the current state of the solid you are 
attempting to make watertight. The Manual repair operations panel 
indicates the current state of the solid and your previous manual 
repair (wireframe creation) choices. 

 
Create wireframe for all remaining problem areas - Create a wireframe 
for each area of the solid where there is a problem. 

 - Return to the first page of the Make Watertight Wizard. 

 - If the relevant option is ON, create wireframe for the 
selected problem areas and close the Make Watertight Wizard. 

 - Close the Make Watertight Wizard without applying any 
changes. 

 

Fourth page of Make Watertight Wizard - Heal existing 
surface links 

This page displays the number of gaps that are outside the healing 
tolerance. These gaps are highlighted in yellow on the model. 
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Healing tolerance - Enter a value to change the number of gaps 
outside the healing tolerance. The default value is the working 
tolerance. 

Heal Solid? 
No, Leave the solid edges as they are - Do not alter the surfaces to 
reduce the tolerance of the solid edges. 

Yes, Heal the solid edges to the working tolerance - Attempt to reduce 
the gaps between the linked solid edges by surface boundary 
manipulation. 

 - Perform the selected healing operation. If the healing 
process is unable to heal to the specified tolerance, a warning 
message is displayed. 
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When you click OK on the warning dialog, you are returned to the 
wizard so that you can change the Healing tolerance. Selecting Finish 
again will then either display a further warning message (if the 
healing process again failed to heal to the specified tolerance), or 
display the Make Watertight Wizard Result page. 

 

 - Close the Make Watertight Wizard, creating any required 
wireframe. 

 

Solid Cavity/Core Separation 
You can split a solid into core, cavity, sliders and internal features 
(such as holes).  

 
1 Select the solid to separate. 
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2 Click  to display the automatic split line  and the draw 
directions for the part . 

 
3 Use the Solid Core/Cavity Separation wizard (see page 303) to 

split a solid into core, cavity, sliders and internal features (such 
as holes).  

When using Solid Core/Cavity Separation (see page 306): 

 solids are split based on the natural horizons from looking 
down the Z axis of the active workplane. 

 parts are automatically split into core/cavity groups. 

 you can move faces between different groups. 

 any number of split directions can be used to define sliders. 

 you can edit the split line by sketching new wireframe and 
dividing the relevant faces. The new faces can then be 
assigned to the relevant split group. 

 

Solid Core/Cavity Separation wizard 
Use the options on this wizard to: 

 simulate the separation of the core and cavity of a solid using the 
slider . 

 control the draw direction . 

 shade the core and cavity . 
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 create wireframe from the split line 

 

Draw direction 
Use the options in this section to make changes to the draw 
direrction 

 

 Add draw direction 

1 Click a face to be used to define the draw direction.  

2 Click  to display the Select draw direction toolbar. 

3 Use the toolbar to define the draw direction. 

 

 — Select a normal face to be used to define the draw 
direction. 

 — Select a workplane and use one of the principal axes to 
define the draw direction. 

 — Accept the current draw direction. 

 — Cancel the creation of an additional draw direction. 
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 Remove from draw direction — Click this button to remove the 
selected draw direction. Any faces being extracted along this draw 
direction become ambigous. 

 You cannot remove the Core/cavity directions. 

 Modify draw direction — Select a draw direction and click this 
button display the Direction dialog. Use this dialog to modify the 
selected draw direction. 

 You cannot modify the Core/cavity directions. 

Shading 
Use the options in this section to modify the shading of the core and 
cavity. 

 

  Undercut shading — Click  to toggle undercut shading. In 
the Core/Cavity Separation wizard, undercut shading works slightly 
differently from standard undercut shading:. 

The areas highlighted in red are undercut with respect to the 
draw direction they will be extracted along; faces that cannot be 
extraced along either draw direction will be coloured red. 

 Core and cavity transparency — Click this button to toggle the 
transparency of the core/cavity faces. This lets you see internal 
features more clearly in relation to the core and cavity. 

 The transparent faces cannot be selected; only the internal 
features can be selected. 

Colour faces — Use this selection drop-down list to choose the 
colour of the faces to be extracted along the current draw selection. 

Create wireframe from split line — When this option is selected, 
wireframe will be created along the split line.  

Retain face colours — Select this option to use the wizard colours on 
the faces after splitting.  

 — Click this button to re-calcualate the split line and face 
classification. This may be required if you have made a lot of 
changes to the model or the draw direction. 
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 — Click this button to access other PowerSHAPE functionality 
whilst remaining inside the Solid Core/Cavity Separation Wizard. This 
means that you use a range of operations including:  

 creating wireframe. 

 using solid editing and Direct Modelling tools to divide faces. 

Use the buttons on the Split faces toolbar to re-enter the wizard: 

 
— Accept the changes you have made and re-enter the wizard. 

 — Cancel the changes you have made and re-enter the 
wizard. 

Finish — Click this button to split the part and close the dialog. 

Cancel — Click this button to undo all the changes you have made 
and close the dialog.  

 The part is not split and any wireframe you have sketched or 
changes you have made whilst using the Solid Core/Cavity 
Separation dialog. 

 

Example — Separating a solid cavity and core 
Use the Solid Core/Cavity Separation wizard to divide a part into its 
molding pieces.  

1 Select the part. 

2 Select  (Wizards toolbar).  

 
The part is split into the cavity and core sections.  

3 Open the part using one of the following: 
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 draw direction arrows .  

 slider on the dialog . 

 

Any ambigous faces remain in the central region  and . 

 
4 Click  to select Undercut shading; this will indicate faces that 

have insufficient draft when viewed from above or below the 
tool. 
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5 Click  to deselect Undercut shading. 

6 Click  to select Core and cavity transparency. This lets you see 
clearly the faces that are ambigous, that is,they are not assigned 
to the cavity or the core. 

 

 You can assign ambigous faces to a part in translucent 
mode, but you can only assign a face by clicking the draw 
direction arrow.  

If you are not in transluscent mode, you can also assign an 
ambiguous face by clicking on the core or cavity. 

7 Click  to deselect Core and cavity transparency. 
8 Rotate the model so that you can see the individual ambiguous 

faces. 

9 Assign the indicated ambiguous faces  to the core as follows: 

a Select the ambigous face. 

b Click either the face of the core or the draw direction arrow 

10 To assign the ambigous faces , you need to create a new line 
of draw as follows: 
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a Select the ambiguous face. 

 

b Click  to display a default draw direction for the selected 
face. 

 
c Click  (Select draw direction toolbar) to accept the default 

draw direction and assign the selected part to the new draw 
direction. 
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11 Assign the indicated the remaining ambigous faces to the new 
draw direction. 

 
12 Close the part. 

13 Select Create wireframe from split line create wireframe that 
represents the split line. 

14 Click Finish. You now have 

 three solids: the core, the cavity and the side core that you 
created in the new draw direction. 

 wireframe that represents the split line. 
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Morphing 
The following sections contain information on creating morphs. 

Introduction to morphing solids (see page 311). 

Adding a morph feature (see page 312). 

Morphing dialog (see page 313). 

Creating a morph using the point method (see page 314). 

Creating a morph using the curve method (see page 322). 

Creating a morph using the surface method (see page 327). 

Creating a morph using the flexible box method (see page 333). 
 

Introduction to morphing solids 
Morphing allows you to deform a solid into a different shape. 

 
All the features on the objects such as fillets, trimming, walls, ribs 
and bosses remain intact, even though the shape may be totally 
changed. 

Morphing can be used for a number of applications: 

 Adding draft to a model. 

 Compensating for distortion that occurs during the 
manufacturing process, for example, sag and spring-back. 

 Adding design features. 

 Local modification such as closing a gap. 

 Shoe design, wrapping a sole onto a new size. 

 Making artistic and aesthetic changes to a model to allow you to 
improve and rejuvenate existing models. 
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It can be controlled by using points, curves, surfaces or a flexible 
box around the model. For best results, use morphing to make fairly 
minor modifications rather than substantial changes to the shape. 

 The point, curve and surface morphing functionality is subject 
to a patent application. Patent pending: GB2401213 Altering a 
CAD model. 

 

Adding a morph feature 
Ensure you have an active solid displayed or pre-select an inactive 
solid and use one of the following methods to add a morph feature. 

Creating a morph using the Solid Feature toolbar 

1 Click Feature  (Main toolbar) to display the Solid Feature 
toolbar. 

2 Click Create a morph feature  (Solid Feature toolbar). 

3 Use the Morphing dialog (see page 313) to add the morph 
feature. 

Creating a morph using the General Edits toolbar 

1 Click show general edits options  to display the General Edits 
toolbar. 

2 Select Create a morph feature  (General Edits toolbar). 

3 Use the Morphing dialog (see page 313) to add the morph 
feature. 

Creating a morph using the Object menu 
1 Select Morph from the Object > Feature menu. 

2 Use the Morphing dialog  (see page 313)to add the morph 
feature. 
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Morphing dialog 
Use this dialog to morph a solid. 

 
The Morphing dialog contains these tabs: 

Point (see page 313) 

Curve (see page 317) 

Surface (see page 325) 

Flexible Box (see page 329) 
 

Point tab 
Use this tab of the Morphing dialog to define a morph using two 
points. 

 
From — This allows you to select or modify the origin point that 
usually lies on the surface of the model. It is shown as a small blue 
circle. 

To — This allows you to select or modify the distortion point that 
can lie anywhere in space. It will be indicated by a small red circle. 

Move normal to surface — If selected, the position of the distortion 
point (To) can lie only along a line normal to the surface at the 
origin point. To select a the distortion point away from the line 
normal to the surface, deselect this option. If the origin (From) you 
selected lies on the surface of the model, this option is selected 
automatically.  
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Limit using plane — This option is ideal for altering the toe-spring of 
a shoe and similar applications where you want to bend a portion of 
a model. If selected, the bounding spheres are replaced with a 
limiting plane. The orientation of the plane is defined by the 
selected principle axis of the active workplane. You can drag the 
boundaries of the plane to adjust its position. 

The model is bent so that the origin is moved to the distortion point. 
Points that are closer to the limiting plane are moved less and 
points at or beyond the limiting plane are not moved at all. 

 

 — The model is updated dynamically as you make 
changes. Click this button if the model is distorted by a large 
amount to ensure that the model reflects all the changes. 

 — Click OK to create the morph. 
 

Creating a morph using the Point method 
This morphing method uses two points and enables you to make 
bulges in the model or apply simple bending or stretching 
distortions. 
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When the Point tab (see page 313) on the Morphing dialog is 
selected, you select two points to define the morph. The From point 
is the origin and the To point is the distortion point. 

 
When you create the morph, the bulge that is produced by the 
distortion is centred on the origin point and the height and direction 
of the bulge is determined by the distance from the origin point to 
the distortion point. 

 

To create a morph 
1 Select the From point to be used in the morphing process. This 

can be done by clicking on the model or using the Position 
dialog. 

Depending on the selection you made for the From point, one of 
the following will happen: 

 In many cases, when you select the From point, a To point will 
be automatically chosen and an initial bulge displayed.  
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You can modify the points (and therefore the bulge) using one 
of the methods described in the next section. 

 If the selection you made for the From point does not 
automatically generate a bulge, the distortion point and the 
origin are in the same place (indicated by the red circle). 

 
To create the bulge you require you must modify the 
distortion point, origin point, size and shape of the morph 
using the methods below. 

2 Modify the size and shape of the distortion by using one of the 
following methods: 

 Drag the point to be modified. 

 Use the Position dialog to enter the position of the point. The 
point that is indicated by From and To in the dialog is the 
point that will be set. 

 In the Morphing dialog, select either From (to modify the 
origin), or To (to modify the distortion point). Click the model 
to move the point. 

 Use the two spheres to define the extent and shape of the 
bulge. You can change the bulge by using the mouse to drag a 
sphere. The graphics are updated when you release the 
mouse button. 



 

PowerSHAPE 2015 R2 Reference Help Solid modelling • 317  

Altering the size of the outer sphere changes the extent of the 
morph a shown below. 

 
Altering the inner sphere affects the shape of the morph. 
Decreasing the size of the inner sphere means that the morph 
is sharper. Increasing the size of the inner sphere produces a 
more rounded bulge. 

To avoid introducing folds in the solid, the radius of the outer 
sphere should generally be at least twice the distance from 
the origin to the distortion point. 

 If the From point you selected was on the surface of the 
model, the Move normal to surface option will be ON. Whilst 
this option is ON, the distortion point can only lie along  a line 
normal to the surface at that point. Turning the Move normal 
to surface option OFF will allow you to move the distortion 
point anywhere in space. 

 

Curve tab 

 
Curve selected - When you have selected or created an appropriate 
curve, The cross  icon changes to a tick  icon.. 

 - Create a Bezier curve that will be used to define the morph. 

 - Create a B-spline curve that will be used to define the morph. 
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 - Trace a curve that will be used to define the morph. 

Limit extent of morph - Allows you to morph a localised region of 
the model, while keeping the rest of the model unchanged. An 
indication of the region of the model that the morph affects is 
indicated by  a translucent cylinder or a pair of parallel planes. 
These can be dragged to change the region that will be affected 
and hence the shape of the model. The model below shows the 
effect of using this option. 

 The original model . 

 Distortion with Limit extent of morph OFF . 

 Distortion with Limit extent of morph ON . 

 

 - Display additional options on the dialog relating to the 
shape of the distortions created when the morph is limited. 
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Curve both ways - This option affects the extent the morph is 
limited. If ON, the model is curved in two directions relative to 
the curve . If OFF, the distortion will be kept constant along an 
axis controlled by the current principal plane . If no 
workplanes exist in the model, the World workplane is used. 

 

 The principal plane is selected by choosing a button in the 
status bar. If you want to select the YZ principal plane, 

select the X button . 

 - Cycle through a number of different possible shapes 
for the bulge that has been generated by applying limits to a 
distortion. Step through the four possible solutions and select the 
one that is best for your needs. 

 - Display additional options that let you separately 
select the two curves to be used in morphing. In addition, it 
allows you to use a curve or surface to limit the region that is 
affected by the morph. 

 — The model is updated dynamically as you make 
changes. Click this button if the model is distorted by a large 
amount to ensure that the model reflects all the changes. 

 — Click OK to create the morph. 
 

Curve tab, advanced options 
This page allows you to select two curves and then use them to 
define a morph. It also allows you to limit the morph using a decay 
curve of a surface. You should bear the following important points in 
mind when creating the two curves: 

 Both the reference (From) and control (To) curve must have the 
same number of points. 
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 Both the reference (From) and control (To) curve must be open 
or both closed. 

 Keep the reference (From) and control (To) curves simple. 

 If the curves are open, it is recommended that the start and end 
points of the curves coincide. 

 If open curves are also tangential at the start and end, you will 
get smoother results in cases where the model to be morphed 
extends beyond the ends of the curve. 

 Limit curves and surfaces should not cross the reference (From) 
curve. 

You should bear the following important points in mind when 
creating the limit curve or surface. 

 Keep the limit curve or surface simple. 

 As you move over the model, it is important that there is always 
a unique closest point on the curve or surface and that the 
closest point does not jump from one place to another. 
Otherwise, the morphed model may contain kinks. 

In contrast, the model being morphed may be as complicated as 
you like. 

The Advanced options let you separately select the two curves to be 
used in morphing. In addition, it allows you to use a curve or 
surface to limit the region that is affected by the morph. 

 
From - With this option selected, choose the reference curve and 
The cross  icon changes to a tick  icon.. 

To - With this option selected, choose the control curve and The 
cross  icon changes to a tick  icon.. 

 - Create a Bezier curve that will be used to define the morph. 

 - Create a B-spline curve that will be used to define the morph. 
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 - Trace a curve that will be used to define the morph. 

Extent of morph 
Curve both ways - This option affects the extent the morph is 
limited. If ON, the model is curved in two directions relative to 
the curve. If OFF, the distortion will be kept constant along an 
axis controlled by the current principal plane. If no workplanes 
exist in the model, the World workplane is used. 

Limit using - Select one of the options from the drop-down list to 
use a curve or surface to limit the extent of the morph. You can 
choose from the following options: 

 Nothing 

 Distance 

 Curve 

 Surface 

Select Curve/Surface - This option becomes active when you 
select Curve or Surface from the drop-down list. Select this 
option and then select the appropriate limiting curve or surface. 
If the selection is successful, The cross  icon changes to a tick 

 icon.. 

 - Cycle through the four possible solutions and select 
the one that is best for your needs. 
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Points are moved depending on the distance from their 
corresponding point on the From curve and the distance from the 
closest point on the selected limit curve or surface. The closer 
the point is to the limit curve or surface, the less the point 
moves. Beyond the selected curve or surface, the points are not 
moved at all. 

 The Curve and Surface options take longer to evaluate than 
Distance and so should only be used when necessary. 

 

Creating a morph using the Curve method 
This method lets you sketch a curve on or around the model and 
then allows you to deform the curve to change the shape of the 
model. Alternatively, you can select two appropriate curves. 

 
The curve method of creating morphs gives you more control over 
the shape of the resulting bulge than the point method. 

To create a morph 
1 Select the solid to be morphed and click Create a morph feature 

 (Solid Feature toolbar). 

2 Select the Curve tab on the Morphing dialog.  

3 Select or create a curve on or around the model. This curve is 
called the reference curve and can be edited to bend or stretch 
the model. If a suitable curve already exists, it can be selected 
as normal. Otherwise, create a suitable curve using the curve 
buttons on the dialog 
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When sketching the curve, the Sketch curve dialog is displayed.  

 
Select Finish on the Sketch curve dialog to complete the curve 
and start dynamic morphing. 

The example below shows a simple block. A reference curve has 
been created along one edge of the block. 
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4 Click on a point and use the curve handles to change the shape 
of the curve. The distortion is applied so that the points on the 
original curve are moved to the corresponding point on the 
edited curve and the model is distorted in a similar way. The 
graphics will update when the curve handles are released. The 
original model is displayed in wireframe and the distorted model 
in shaded graphics. 

 

 When selecting or creating the reference curve, you should 
bear the following in mind: 

 Curves with fewer points are easier to edit and will generally 
give the best distortion results. 

 Points on the curve should be placed so that they will give the 
curve flexibility in areas where you need to control the 
distortion. 

 Discontinuities and sharply curved corners in the curve may 
introduce kinks or ripples into the morphed model. 
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Surface tab 

 
From - With this option selected, choose the surface to distort from 
and The cross  icon changes to a tick  icon.. 

To - With this option selected, choose the surface to distort to and 
The cross  icon changes to a tick  icon.. 

Once valid surfaces have been selected, the morph will be 
automatically previewed. 

Limit extent of morph - Morph a localised region of the model, while 
keeping the rest of the model unchanged. 

 - Display additional options on the dialog relating to the 
way the morphed region is blended with the rest of the model. 
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Normal Offetting - If ON, the surfaces to be morphed are bent to 
follow the To surface. Full details on how selected objects are 
morphed when Normal Offsetting are provided in the Solid 
Modelling manual. 

 - Reverse surface  

 - Swap longitudinals and laterals 

 - When Limit extent of morph is ON, this option allows 
you to cycle through the four available types of blend. Step 
through the available solutions to find the blend that produces 
the best result for you. 

 - Displays additional options on the dialog to modify 
the shape of the morph object. 

 — The model is updated dynamically as you make 
changes. Click this button if the model is distorted by a large 
amount to ensure that the model reflects all the changes. 

 — Click OK to create the morph. 
 

Surface tab, advanced options 
The Advanced options let you to use a curve or surface to limit the 
region that is affected by the morph. 

 
Limit using - Select one of the options from the drop-down list to 
use a curve or surface to limit the extent of the morph. You can 
choose from the following options: 

 Nothing 

 Distance 

 Curve 

 Surface 
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Select Curve/Surface - This option becomes active when you select 
Curve or Surface from the drop-down list. Select this option and 
then select the appropriate limiting curve or surface. If the selection 
is successful, The cross  icon changes to a tick  icon. 

 - Cycle through the four possible solutions and select 
the one that is best for your needs. 

Points are moved depending on the distance from their 
corresponding point on the From surface and the distance from the 
closest point on the selected limit curve or surface. The closer the 
point is to the limit curve or surface, the less the point moves. 
Beyond the selected curve or surface, the points are not moved at 
all. 

 

Creating a morph using the Surface method 
This uses two surfaces to define the morph. 

 
The two surface method provides more control over the shape of 
the result than the single point methods. It can be used to make 
substantial changes to a model, for example to stretch or bend in a 
controlled manner, or to project one shape onto another. 

You should bear the following important points in mind when 
working with surfaces. 

 Both the surfaces you select must have the same number of 
laterals and longitudinals. 

 The laterals on both selected surfaces must be open or both 
closed. 

 The longitudinals on both surfaces must be open or both 
closed. 

 Keep the surfaces simple. 

 Keep the limit curve or surface simple. 

 Limit curves or surfaces should not cut the surface that you 
have chosen as the From surface. 
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 Avoid discontinuities and sharply curved corners in the 
surfaces, as they may introduce kinks or ripples into the 
morphed model. 

 As you move over the model, it is important that there is 
always a unique closest point on the reference surface, and 
that the closest point does not jump from one place to 
another. Otherwise the morphed model may contain kinks. 

In contrast, the model being morphed may be as complicated as 
you like, without there being any problems. 

To create a morph using the surface method 
1 Select the solid to be morphed and click Create a morph feature 

 (Solid Feature toolbar). 

2 Select the Surface tab. 

3 Select the From surface to be used in the morphing process . 
The  changes to . 

4 Select the To surface to be used . The  changes to . 

Once valid surfaces have been selected, the morph will be 
automatically previewed. The original model will be displayed in 
wireframe and the distorted model will be shown in shaded 
mode. 
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Flexible Box tab 

 
Select faces - If ON, you can select the region of the model that you 
want the morph to affect. The entire model will be selected by 
default, but you can select smaller regions of the model. You can 
select multiple faces on a solid as follows: 

 Hold down Shift and select a surface to add a surface to the 
selection. 

 Hold down Ctrl and select a surface to add/remove a surface 
from the selection. 

Number of slices - The initial number of control slices in the flexible 
box. The flexible box will be distorted by a moving drag handles 
attached to a the control slices through the box.  

 You can create additional control slices at a later date by  
holding down Ctrl and dragging the active control slice. 
Twisting and bending the box may insert new control slices. 

Around workplane - If ON, you can select a workplane that defines 
an axis for bending or twisting the box. If you want to use this 
option, you should create a workplane that has an axis that will be 
used to twist or bend the box. Make sure that the principal plane 
you have selected is correct for the axis of the workplane you would 
like to use.  

You can turn this option OFF at any time and continue free form 
editing of the box.  

Angle - Enter the angle to be used when bending or twisting the 
box. This option is only active when the Around Workplane option is 
selected. 

Once you are happy with the selected region of the model, you can 
select a button to show the flexible box and start editing the model 
dynamically. The initial box will be large enough to surround all the 
surfaces you have selected and will be oriented along either the 
axes of the current active workplane or the axes of the World 
workplane. 
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The following buttons let you change the type of operation you 
perform on the box.  

 - Twist the model interactively. 

 

 - Bend the model interactively. 

 

 - Stretch the model. Two kinds of stretching can be used: 

 Symmetric - Scales each selected slice around its centre . 

 Asymmetric - Stretches the slice only in the direction of the 
arrow . 
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 - Shear. This lets you move control surfaces about in 3D. To 
make this easier, the handles in the plane of the control surface will 
only move the slice in that plane. The handles that are normal to 
the control surface will move the surface normal to itself. 

 
You can swap between the different drag handles at any time and 
make as many different edits to the box as you like before applying 
the morph. 

 - Display the Position dialog. 

 - Open the Scale Morph dialog. Use this dialog to scale the 
morph: 

 
1 Enter values to scale the morph in U and V direction, where U 

and V are the axis tangent to the edges of the morphing 
bounding box 

2 Select Scale uniformly to scale the morph by the same amount 
in all directions. Deselect to scale by different amounts in 
each axis. 

 — The model is updated dynamically as you make 
changes. Click this button if the model is distorted by a large 
amount to ensure that the model reflects all the changes. 

 — Click OK to create the morph. 
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Creating a morph using the flexible box method 
Flexible box morphing allows you to distort all or part of a solid 
model by manipulating a flexible box. The flexible box can also be 
used to bend or twist a model around an axis defined by the 
workplane. 

When the Flexible Box page on the Morphing dialog is displayed, you 
select the faces of the solid that you want to distort. 

 
The distortion buttons on the dialog let you edit the model 
dynamically by manipulating the drag handles on a box. As you 
move the drag handles, you distort the box. You can select different 
slices within the bounding box and morph the section using a 
combination of twist, bend, stretch and shear until you achieve the 
desired result. 

The following example shows the change of shape that can be 
achieved by using the drag handles to manipulate the model. 

 

 
For full details on all the options on this dialog, see Morphing dialog 
- Flexible box (see page 329) 
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To create a morph, 
1 Select the solid to be morphed and click Create a morph feature 

 (Solid Feature toolbar). 

2 Select the Flexible box tab on the Morphing dialog. 

3 With Select Faces ON, select the faces of the solid that you want 
to distort. When you make your initial selection, all the faces of 
the solid are selected. You can modify this selection by clicking 
on the faces you would like to select. Use standard surface 
selection techniques to add and remove surfaces from the 
selection. 

The flexible box that is derived from your selection will be big 
enough to contain all the faces that you selected and will be 
aligned to the current workplane. 

4 Enter the number of controlling slices in the Number of slices box. 
The number of slices is set to 3 by default. 

5 Bending or twisting around a known axis. If you want to bend or 
twist your model around a known axis (defined by a workplane), 
select the Around Workplane option. The flexible box will appear.  

(a) Select  the workplane and make sure that the principal 
plane you have selected is correct for the axis of the 
workplane you would like to use. 

(b) Enter the angle of twist or bend in the Angle box.  

(c) Use the buttons on the dialog to select the type of 
distortion. 

6 Distorting the box using the drag handles. If you want to distort 
the box using the drag handles, select one of the buttons on the 
dialog. The flexible box instrumentation appears. Use the 
controls to create the required distortion 

There are a number of things to notice at this point: 

 One slice through the box is drawn in yellow. This is the Active 
slice. 

 The drag handles that will allow you to distort the box are 
drawn on the active slice.   

 Other slices in the box are hidden. The hidden slices are 
represented as blue sections of the outline of the box.   

 Slices that represent the faces of the box are drawn as the 
small 'L' shaped sections on the faces of the box.   

 You can change the active slice by clicking on this 
instrumentation. 
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 You can select more than one slice by holding down the Shift 
key and clicking on the instrumentation. The slices must all be 
in the same direction across the box. The last slice you click 
on will become the active slice. 

 You can add new slices into the box by holding down the Ctrl 
key and dragging the active slice along the edge of the box 

 If you previously selected Around workplane, you can turn this 
OFF and continue free form editing of the block. 

The numbers on the diagram below, correspond to the following 
features of the flexible box: 

 - Active slice. 

 - Drag handles for distorting the box. These are drawn on 
the active slice only. 

 - Hidden slice. 

 - For selection of slices at the edge of the box. 

 
7 Select OK to save the changes you have made 
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